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10. INRIFESTAT Pl Integrator Framework ARSIk 7 2HIEE RS MK (gMSA), MARERET PI
Integrator for Business Analytics BT B #l LR ZEE M Windows PowerShell B Active Directory 13k ; ES
%] Z2 4= Active Directory PowerShell 3R,

11. MBEIHIEELRE I SEHIA PIAF Server TETE— T ELZ 4 Pl Integrator 1.x K15, MRS IFAIAE 1.x 38
BIFRE 2.x, XIFHEIFERE Pl Integrator 1.x R FE R IESE 2.x KHIFHLE X,

12. MNBRRFELIE LRI Pl Integrator for Business Analytics ZBITEA T B EiIREBE L RFHFINEERE, 55
FiZE A ERSBY THREZER,

Pl Integrator #}&

TENATIE LI FRIERE Pl Integrator for Business Analytics IR AR, TEERT Pl Integrator for
Business Analytics B Z I & E . 1 Pl Integrator SS{5I&R$E R E B B4 PI AF Server #1 SQL Server =45,
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AV=VA"
B Eiw
E°- E:w
E'- Bw

Pl AF Flintegrator for  S0L Server
Business Analytics

anfer &gk

Pl Integrator for Business Analytics

£ Pl Integrator for Business Analytics

FH 5V R A LLET XS [El— PI AF Server R % 4™ Pl Integrator for Business Analytics 3545, 301 TR, M FENZR

HRISEHI, FFER— PIAF 2UEE A3 PIAF EHITR,

BE:w

I“@"< BE:w
BE:w

Pl Integracor for S0L Server
Business Analytics

2 #&, £ PlIntegrator for Business Analytics 25 "] LL¥E A B — SQL Server, M TR, REENXHIE,
5 HAthSEp X ZHERIA saL iR, BSTEIXLE SQL Server #IER B E A Pl Integrator for Business

Analytics 3K 5l 1 32 — A S R R SEHIF E R
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B0{E[ % 4E Pl Integrator for Business Analytics
- @ -
2l 5 e
—EBeolW —

Pl AF Pl Integrator for AL Server
Business Analytics

SEE: sqL Server BRI LR IETE 5 1E1A] Pl Integrator for Business Analytics SEFI¥ 2 N BT A L,
TieEAER, — 1T A LE#BREERE— Pl Integrator 3241,

Bt E% 2: %% Pl Integrator for Business Analytics

MY ER 2 i B &4 Pl Integrator for Business Analytics, $83E Pl AF Server 1 Microsoft SQL Server,
TE &% Pl Integrator for Business Analytics Z 8l :

o MARBREMER 1: A% L% Pl Integrator for Business Analytics I RIRT A LR EH,

3¥E . 7E Pl Integrator Framework _E #3932 #94E{A] Pl Integrator = BB N AN AREE LB M
BEHE,

1. B FZE|JFEZRE Pl Integrator for Business Analytics BT E #l.,
2. MEFITTFME FTEREFRRABY Pl Integrator for Business Analytics RiET B4,
3. ARBEHETHITREXH, ARRTLUERRSMEITLLETRERS.
BEERATRITXHEDOITH,
4. BEREEFHZNEEFLTHEE,
HGAE A Pl Integrator for Business Analytics REFZR & O MEENITH, H il REMMMEMER, &
EMSHLREETERBIEBRREPEFEENER,
5. BEHAE,
6. MRBUIUTEH LERTRRE AVEVA &, BERUTER, BN, BHRET—HRK,
a. EBRIANIRSFFE O, $57E Pl Data Archive BRZ535F0 PI AF Server (R[i%), RAREEHT—%,
b. HREBF'BOH, 187 AVEVA = RMREME, B LUEZEIAE, Al LIEEHMAE,
3¥E Pl Integrator for Business Analytics ZZE7E %PIHOME64%.,
c BEHET—H,
7. TEXAREE Pl Integrator for Business Analytics B O, 2EEHT—%,
REREFHFRIE EO
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10.

11.

12.

13.

14,

15.

16.

BN{a[ &2 % Pl Integrator for Business Analytics

EEFEREOS, ERELURKFSEEAF KRS, MBEREAS KRS, BHEEFEIT Pl Integrator
Framework. Pl Integrator Sync #1 Pl Integrator TAE4 217 s AR S5 H Windows BRSFtk P AP 4 (218
i5) FZW,

EE IR Windows lRE Tk Z2EIEERSZ K, (gMSA), MIEE LI T X AIEF 4 usernameS F 28

=18,

BHET—H,

“AF fRS5 252 HE B O BERNT I .

FE7E Pl Integrator for Business Analytics 5 F F 7 & M B & L AN E th T 0 HE #I PI AF Server,
£ AF RSB FE S, WA Pl AF Server & FRELGLE (1P thdlh) ,

EE IR, BHEEBETZRE Plintegrator for Business Analytics B9 F ik F° B B&TEI| PI AF Server £
HEER AF FAFRIR,

BEHET—%,
sql Server & O3TFF,

}8ZE Pl Integrator for Business Analytics 577 ff T B ST EUE . 451 #0HEF0 Pl Integrator for Business
Analytics B & B Microsoft SQL Server,

INREAMNZEIASES], MMIEEENL (RELETEESR) . MEERAMEHL RG], WEEENS
(BRSELPREE L) #13E4H, 5180 : mySQLserverBA1\PIViewInstance,

& 7 an{al {3 FA 8 %€ B9 Microsoft SQL Server $#EEXT Pl Integrator for Business Analytics ¥ 1T & 2R 1E , &
BTo%Eme—:

e Windows SRR E (EXIA)
Windows ARS5 ik P Fi P FREIE 21 Microsoft SQL Server RIEHE
ARCMREFEAARERSIKST (gMSA) SELIMKF, N AFUEH Windows FARIE,
e SQL Server B HIE
AR AHEEMSH saL Server B2 RWIE, 8132 — & [THTF Pl Integrator Framework AR HI& %,
& i sQL Server BHAKAE LU A sQL Server B3 IE IEHE E 45 E #I Microsoft SQL Server #IE
AN Microsoft sQL Server EHF A E 1 B X REIE A Microsoft SQL Server FAF B &%,
BET—%,
‘Y A F0 TS IEBEE"E QT F.
ARAROSFERPARAGRETTANKOSHETRIERO,

R kim0 FAF7E Web 31 58 28 % HEE Pl Integrator for Business Analytics,

RIFLE, i 80 EFRREH http TMUAERER . B TFAXSHF https (INBE R £ M), FitkinO 80 AIfEE
AR,

R R EABKIAIRA 443, N Pl Integrator for Business Analytics &% URL BfA] LIZB& iR O 5,

MT iR —EJRIERR TLS WEH:

o (MEF)EBMANMMAN TS IEH, ERFAUEPHFETERIED, LIEAFR—KEHIELMAN
MR, FESARIYFIRE Pl Integrator for Business Analytics BT E#HL LAJIEH,
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17.

18.

19.

20.

21.

BN{a[ &2 % Pl Integrator for Business Analytics

o RESBHAMMWBZERILES, LIRENKINRE, REBZRIES,

FEEMBEERXMNET, BLMERBITENERMAR RSB —FTEHZEEHR, I TH#
RELLIEBHIMZS, EBATNEREFIHITEY LBAHEZE, BSREIREXE Certificate

error returned when navigating to a Pl Vision or Pl Web API web site using a self-signed certificate (Z3{&
FABEZRUEBSHE| Pl Vision B Pl Web API Web i s B IR [E]IF B 45 1R ) HAIER A X,
BEHET—
AR MBEHE, ERKRZHOSITFERBEER,
TE“Plintegrator TELIET m"BEOHF, EEMAFHERERENIELETRE AREET—
PI B FRBIEE OTH,
FEETMIELETY RMEETNM CPUTI RAM, EXFTERBMEZER, BSHARGEXK,
PIUEFARIESREKRBIAP UEBEIREFH. TER MEHERAPIUE Eﬁﬂ’]ﬂ”?ﬁul%‘m—r?&
2iERf,
o (F) REIREHHEDIRE, AIRNREHAAEFER P E BRHME, InREEHAITTR, FHI
— P REEZMHIEK, JIELNUBHRE, FHTE %PIHOME%\dat B FhE L —1F HHFI R X6
¥ o fa] LU AR Itk 33 4 S 1R Bl BT LA BR 2T #5 Bl Microsoft SQL Server B ARAY PI #LE . A X aNfal 54

FA P {1 E B ¥RBIAL B 5EFE I Microsoft SQL Server BIBA, &S RF pI ¥ & H AR 2| Microsoft
sQL Server B #r,

o MEARBIRPHIAER WEFEET-—FHERER. RHHEEXAHERXEE.
o MEHERNEBEEESFHIIR, 1E$ZJ115'F&%#FO
BHBAERIEURRRE, BHT—F
EZRENARFEOTH.
BHRE,
"EHREEOFHTHFUR RRERE,
REERZEHHIARETREQ. 2HXxHA.

FIME - RiIERE

SERK Pl Integrator for Business Analytics IR ZE 2 5, BRI ERS EEIETT,

1.
2.
3.

—_y—

ZFEIFEE Pl Integrator for Business Analytics BI1TE# L,
FTFRRSS .
ISF PI Integrator for Business Analytics iS5 251 H IE 755517,
BN EEFINUTRS:

¢ Pl Integrator Framework

e Pl Integrator Sync
¢ Pl Integrator Worker Node 1

* Pl Integrator Worker Node n(Z 1 Bl T/ELET S#EX NAARS) o
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SEE K% Pl Integrator Sync # Pl Integrator TE&L 2T MRS Y, “BIEERE RN “FB)”, PI
Integrator Framework [REESEFEEEZENERX LIRS MEZTEFHERIRS, BEXMAMEA PI
Integrator iRZ5 3 /23 Pl Integrator Framework ARS5 . EAF B E3) HthRST, IHFESSHEIEINMT
HNo

4. FTFF Web 535,

5. %A Pl Integrator for Business Analytics B4 URL,

Itk URL #5 1M PI Integrator for Business Analytics B EHL#0%5#k O . URL 79 https://<hostname>:<port number>
B}, https://<fqdn>:<port number>, E & FQDN AT LR ERE L,

BB TEIE prod.onet.com FE 7 lab5 BIEHN _EZRE T Pl Integrator for Business Analytics, FF{FEEE 1
FEAWmO 7777, WA LB A LLFEE—IL:

e https://lab5.prod.onet.com:7777

e https://1ab5:7777

HERRE

AERD N B INMAIFE F5 & R & Pl Integrator for Business Analytics,
LR E Pl Integrator for Business Analytics Z Bil, FALRH BB X 1: 4 % %4 Pl Integrator for Business Analytics

PRI A R E N,
SEE {E{AFE Pl Integrator Framework E#J32H4 Pl Integrator 7= fmER LM LI IR STRITTEHL L, Hl180, PI

(o]

Integrator for Business Analytics ¥ PI Integrator for SAP HANA NEEREER — A 1T EAHL L, Pl Integrator for
Business Analytics IR PN EFIth REEREER —B1TEN L,
BE R A R Pl Integrator for Business Analytics:

1. BFZEFELRLE Pl Integrator for Business Analytics BT E 41,

2. MEFTFMiIE TEZRFTARABY Pl Integrator for Business Analytics RZE T B,

3. ARBEEFHTREXY, ARETUEERRFMHEITLLEITRER S,
BREERTRITXHEDOITH,

4. EEREBRFUIENBEFRLTHE.

FXHIRIMEEEME . IREVGERS, 5:E R“Welcome to the Pl Integrator for Business Analytics 2020
Setup”B& M,

5. BEHEUH,
6. TEXX K silent.ini BR & 304,

7. RBECE X, £ [COMMAND LINE] BBy #1 Pl Integrator A {THIEELL TS, IBREKINE 7=/
ALLUSERS=1 REBOOT=Suppress REINSTALLMODE=dmus SENDTELEMETRY=0",

S8 EE:pu
SERVICEACCOUNT BIAERT, LEIREN NT SERVICE\<PI

Integrator Service Name>, X 545 FA iz Ak P2 e &
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Pl Integrator for Business Analytics
BN{a[ &2 % Pl Integrator for Business Analytics

Pl Integrator, & A LIHETE — 1~E 1T Pl Integrator
Framework fRZ589 Windows AR K,

SERVICEPASSWORD BR&S K PR 2558,
AR CNMREFERAATEERS K, (gMSA) SE L
ik, WZ2BR LS5,

AFSERVER 771# Pl Integrator BR & {5 £ /Y PI AF Server,

SQLSERVER Pl Integrator FASE7 A& 18 B T &UE /Y sQL Server,
INRIGEE A A S, BB EZ =,

USERPORT Pl Integrator FASRIEHEEI Web 3| 5T 2A98H O

SQLHOSTNAME £E saL Server Mt HEHME T, MBRFERA
SEf), MIEEEE & 2 kP,

SENDTELEMETRY (a[&) INRRFERNEKIAE 1, WHBRERESM
Pl System & R 1T, IREHN 0 AL RH %1t
%o

INSTANCEELEMENTNAME (RIi%) FAF1R7E Pl Integrator SEI4FE(SE B A PI

AF ST, AT — ol B, tnRKIgE, MEKIA
{E A Instancel, 1E Pl AF Server R RIBER & $RIEFE N
BET—0 AEH,

CERTIFICATE_SELECTED

(Al3%) IR EA B E SGEH, MIRH 1, inRKIE
E, NEAREREFCZHBERIES,

CERTIFICATE_THUMBPRINT

(RI3%) Pl Integrator 545 F 84 B & SUIE 5 B 48 B
A, N8 {F ASEESAE, N CERTIFICATE_SELECTED #
TIRE RN 1,

SQLUSERACCOUNT

(AI3%) IR EE A saL HARIE, NiZE P
Integrator FH3E510] SQL Server SE45I#4 saL Kk,
FAE MR ERFEA gMsA tk P EERIK F, WA EE
#/ saL BAWIE, BE2KIESH,

SQLUSERPASSWORD

(AIiE)saL tk R 21,

FE MR EMEA gMSA 1K SUEIUK P, WA gE
#/ saL BARiE, BE2RRLLS .

. UEEA BRI G SIRTITITLLT a5 : Setup.exe -f silent.ini

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 26



'AV EVA\TM Pl Integrator for Business Analytics

BN{a[ &2 % Pl Integrator for Business Analytics

REZEHES

ZEESE Pl Integrator for Business Analytics f&, SfiiZl Pl Integrator Framework fR55 URL. BEXEZER, HS
%] FF 38435 A PI Integrator for Business Analytics,

HETE, EEFFHE{ERE Pl Integrator for Business Analytics Z BT SE LU TS :

o A0 PIAF Server FIEHRBE, & IFM DA R PI System $4E . S M A0 PIAF Server FNEUEE,
o FAMEEHAEMNBMAF ., BSRFNFEE S HIFR,
o ERAMBIENEMEERES. BSREELM BT,

* Plintegrator 7 &1%F Pl Integrator # B {FE FARREUE MR, SIEM B EF B IR ARt AF iy
B E A SEEF SRR R . BAE Pl Integrator for Business Analytics Windows [RFZ kP & &

HLUTR:
* Pl Integrator for Business Analytics T2 15 [RIRIFTE Pl AF Server B AF server 4% Bl i) “Is2 B 1 “BREX 3K
B IR

o XHEAA] PIAF BB E R EEMIFX R Gk, RKA. EiRE) 92BN FSREEIE "X R, Pl Integrator
for Business Analytics T/E 17 R EA1F REX A $HiE

o X{ Pl Data Archive F“HUiEEZRL" T PIPoint F&AIEEUN R

 XI Pl Data Archive F#RiE R FIFTHE Pl #Ric AR T £ R RER IR, Pl Integrator for Business
Analytics EE IR EAF BER M EE
AR RS EZEEE Pl Data Archive BXUBR, [ Pl Integrator Framework ARZ5E $£7E Pl Data
Archive REWEN PI FR1C R EE S| R Pl AF B RIE,

A0 Pl AF Server F13UERE

A LR ERMEE T AIE L E 5 ARIEIRER PIAF Server IR,

BEFEEMR E AREBRTEHE,

AEE UET, BE AF BIEELET,

FELL TR R INET AF RS 25507214 AF RSS2 FEX 5 A PI AF Server B4 FRELALE (1P #idlh) .
BN PI AF Server IR 2BIAIRO (5457), BEHOFERPIEEEEAMKO,

B &5 00 AF ARSS 25

A A .

ANINFEE R AR IR
HSATX, THURF SRR, B RN SR RURER S A AN &7 BHFMLE NS RR

RIS TR, X Lk B R RN HI 75 B P2 X Pl Integrator for Business Analytics FB P 5 (U1) B9iF RIABR, LA R iF
B FECE M B A B ARAIR,
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10.

11.
12.

13.

BN{a[ &2 % Pl Integrator for Business Analytics

BEFEEMR E REBEEEE,
AEE T E BTRAFERF,
“FA P B AR TE 4T 7 o
BHEAMEHRR,
NN FARFRIRXY FEHEREEN$T FF
PATUTEREZ—:
o EHEMNREMFERAATSMIMAMBITHETOE,
o MIIRFERE—IFMHINA, RERTHE.
5| RE=EREFEE Pl Integrator for Business Analytics BR & R Pl AF Server XEXBIFTAE F12FR12,
EMFERPARKFEAZFHIRA,

Identity Description

BHFAFRMBISHHRR, $5F Windows Active Directory A F iR INEIZ & 2512,
FE RN A P FIA I EHE AT domain\user (B\A ) FER M ABFIAF 4.

%M domain\user X, B &, MAILELELFESIHMARFHLA,

BEEE,

I 5 A S H4-+EPTEZRY Active Directory A 511K,

MIIFRFIERRAFT, REETHE,

AP IR ARG,
BHAMBARURSMRRER T HER A B RRINR.

MRMEM BRI RELIIRS, NELRZBR RERASHIRIRERETIHRIZERHNR,
TERMEAERNEER, EEERSBFRET HRNRE R+ ESHRE.
BREREERTFRMERIERS,

B T R B AR LA &3 ¥R 1R 1% P 15 [RE AT E A T B RO AR
FERMRE R EE S, REERSBFIRE T HRNRAONEF 2 EHE.
NEE RERERERIIRS,

BEFGAFERETI—MIR(INFFAER, BSRUENE ) :
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o EH
s FhEE
14, BHEER §ERELIZFATE AF BAFRIRIT“Pl Integrator for Business Analytics ‘& E8” 7T i f4  [8] X
fRo
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F4R Pl Integrator for Business Analytics

4 Pl Integrator for Business Analytics

BT LLMEL T BRAFH4X ZE Pl Integrator for Business Analytics 2020 R2 SP2

e 2020 R2SP1
rhE A4
XFF 2020 R2 SP1 Z HIBIRRA, A5 FH R E Pl Integrator for Business Analytics 2020 R2 SP1,

o JCiEEHEM Plintegrator for Business Analytics 2020 R2 Patch 2 B BhRAF K F Pl Integrator for
Business Analytics 2020 R2 SP2,

X F 2020 Z BIRIRRA, AT I FH R E Pl Integrator for Business Analytics 2020,

o JiETEHEM Plintegrator for Business Analytics 2018 R2 SP2 K BB B R A F+ 4% E Pl Integrator for Business
Analytics 2020 R2 SP1 B E S kR A,

X F 2018 R2 Z RIBURRA, M FEFRE Pl Integrator for Business Analytics 2018 R2,

o HMNREBHLKFNERN P EIRAR] Pl Integrator for Business Analytics 2018 R2, FF B Pl Integrator for Business
Analytics £t X4 PI AF Server 2014 BB BRRASE 1T, MABSEFHKE PI AF 2015 SLESIRA, AEBHE,
N, BLF Pl Integrator for Business Analytics AP F A= B3R PIAF B RHRIR, MEFMER, 1B
SR AP EE,

o NEIEIERLEEIR— PIAF Server B Pl Integrator B9 1 2018 hii A Z BT 1.x 245, N AFFFTF A SR
BIFHLRE] 2020 HEZIRA (2.x). MERRZHARFELF], MAZIFFTEEFIEHRE 2.x, BBLEHR
&, &0 1x MBARE X E K o

o MR ATFFHREI PI Integrator for Business Analytics 2018 R2 B F° i F° X4 PlintegratorDB.
PlintegratorLogs #0 PlintegratorStats #EE B & db_accessadmin #IEEA B K R B, WiZHAF ik ik

WIS PlintegratorStats 203EFEE A SELECT. UPDATE 1 ALTER X [B, 2N R k@ A tk P12 HRTEM
R, AR RBTFIBFHEUEE.

HRAERTIE
FHR AL :
o FAIAIETERI Windows AR5 1K = LL Domain\User #& (35T Pl Integrator for Business Analytics, J1 R Z RS

kP ERRAF 42T (UPN) # X (account@domain.com), B2 FRIFEM , EFEE LT services.msc B
BIARSS K P2 F3h 1k & 7 Domain\User 8=, AR B HEFA R,

o TA{RFEE LR Pl Integrator for Business Analytics 1T E#H L EZ K EE A NE,
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o MAREBAFHREMMABL MK EFZEFR Pl Integrator FIEFER SQL Server £ EF sysadmin BB, iX

FFFH R Pl Integrator BI/F % SQL $IEFE 2 LA ],
o MEBXRMAZAFKFIZFTEENRE, MEEH sysadmin XNEMAF GBENRIEEESER) WAFI
& sQL #ABE . iEEFH Pl Integrator for Business Analytics Z Bil, SEF4k saL HUEE,

o RESQLEIBEER, HFMIFFHR Pl Integrator for Business Analytics I 1K, /E8 sQL Server £
BIZ 4 . FHR Pl Integrator for Business Analytics BIFAF BB LI TR :

1. PlintegratorDB, PlintegratorStats #[I PlintegratorLogs #{#EEE Y db_accessadmin $UEE A & B 52 /&
2. X} PlintegratorStats & E A SELECT X R

FECFHERBE, BRI EIETERE PIAF Server B, SQL Server,

s MEAELREHRFETNAEFELRZTEMIZE, F EIEH Pl Integrator for Business Analytics ZEEFE#

FRE

RIBEERED, BLEFRZHI, BHEE Pl Integrator for Business Analytics Fi PRI BB B 1T 545
MATIBRIE AXELZER BSRNAETEMRATERIE,

Pl Integrator for Business Analytics EE AT H4T XX 44 . BN R F R FF 18 8HE AT B IEFE T T E 1T RITE F Rt
3BT, A4 PlIntegrator for Business Analytics R{F LB HORIX LR, AARBEIFFBARATRITXE . AR
— B/, EREFHFEIHEIKE XL/FLMEIT,

NREEE, AIUFHEILERELETITHEL, BEARTERE, BEEEHBEIIX LA,

1.
2.

M AVEVA Z 71 P 59 “7= 55" TTE T #X Pl Integrator for Business Analytics Z&E T B @,
ARETAMITRENXH, ARRHUEBRRAGMETUERIRERS,

B ESR AT X B DT,

EEREREFNRENEEFRTHE,

“IRM{E A Pl Integrator for Business Analytics R2EFEF" 88 OREENTIF, Hh5|H R EREM A& N ER,
ZEASFAREBEIERLERRRAEFEFEERYIEMBRAE,

BEHARE.

“IRIMLEE P| Integrator for Business Analytics” & O FEENFTFF

BEHET—D,

“BRERBORITH,

FETE ST 1T Pl Integrator for Business Analytics AR5 #4 Windows AR S5tk P RO ZEH

BHT—D,

‘i O] TLS IEPEE E O T,

AR AmOSFETRAFSSLETANGOSHFEERIERO,

Pl Integrator for Business Analytics Fil /7 5% E1 455 F It i O 5 Pl Integrator Framework RS54 4 ARIE

R B A O 443, MIA Pl Integrator for Business Analytics ¥ %€ URL B R LIZB& tkim O 5
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9. MTR—EJRIERE TLS UEH:

o (HF)UEPMENMMAER TS IEP, RS AEPFHFETRRIER, LER—KERIEBMEH
Mk, HES AEIYEIZRE Pl Integrator for Business Analytics BJ1TE#Hl _ERIIEP,

s RENBETARMBERIULESR, XZHREE.

FAECINBERXNED, BoMERITTENERMAF RSB —STXEHESHEHR. A TEHZB
LREPHIALES, ERLAERFIHITTEN LBAWHZIE, BFSRENIREXE Certificate error
returned when navigating to a Pl Vision or P| Web API web site using a self-signed certificate (A{EF B X4
IEB SR EI Pl Vision BX PI Web API Web i s B R [E]E $5481R) hRIARR A E,

10. 7£“Plintegrator THELET A"EOD, B HTAHFRBREREMNTIERET AHNE RARETFT—F,
ERRENRAEFREOITH,
TR BN IHELRET RBFEHIE CPU T RAM,
AR MBEHE, FRKRZHOSITFERBEER,

11. B5&H T4,
NREEHEAHE, N FHAEUNE EOTH. BN, BEDREK 13,

12. BHBIBRED.

HETRATFNAFEEEHFEFETIVNIENREEIREZD ., MRBMAEINER, NI FESSIHZHR
KA LUK %PIHOME%\dat B X H & 15 R EERE

IMEHIER, MFER—FHRIRHER . BEHEXAHFIRINEE,

LEBT, AT

o RRBIRFRTOIREZMD.

 7E PISystem Explorer R F B 0l Z 7, BERIXT T/, BT TIRME:

o FERIET Plintegrator for Business Analytics BJiTE #l £, $KZ| %PIHOME64\Integrators\BA\
CAST.UL.WindowsService.exe.config 3{ {4,

o ITFFECESCHE, 2T InstancePath BHIE,

o £ PISystem Explorer 1, 1% InstancePath JTHRIETRHITR,

o HRLIMFIXEFZTR ETUERTR.

e AEETUEARRHFERSHEIXHE.

s EFR“AESIAMNRNAEREFHE L, IETEMNXHMAE,
o BEHMAE,

o HEETRGBERN (FHE),

13. “PUEFARISRERBAPIUNEEREFH. RERE, FMAFEA P B BRI E T BRI
2®IiERf,

o (M) RSEIREEMTIEE, AIRNREHAAEER P NEBFHRE, NEAERIITRK, FHA
— M ELMIEK, FIHERNENE, FH7E %PIHOME%\dat B F o4 B — 15 H 151 R X485
¥, fm] LASE AR b 1345 SRR Bl AT LA PR 2522 Bl Microsoft SQL Server B ¥REY PI LB, A X A{al 4545
FA P YL B ARBO WL B SE#8 ZI| Microsoft SQL Server B BA, ES R P LE B #RiF 2 Z Microsoft
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sQL Server B #x,
o MEAFPBIBPHIAHER, WFER—FHRAER REHEXAHERNEE,
o MEAWHMEXTESHIK, BEFFIETUREE,
BHEAAEEEUSERE BHT—F,
HERRENRAEFREOITH,
14, BHRE,
BHRGEOITHUERTEHRE,
15. RETHZEHHNRETREQ. £EHXA,
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WREXRMBR

W TiRE XM BN AR A LR, SEEIEMEEXH BT AT MRS R,

;X% : B Pl Integrator for Business Analytics 2020 R2 SPZ &, P NEBEREHEFER. NFFHERA P LR B FRr

DB EFLE Microsoft SQL Server BAR{E RN EX, i

2555 P LB B AREFE E| Microsoft SQL Server B R,

1. INREEL Pl system HIFRMETH -1 B, FERESIAEFFRMRHAREB R N FAREEME

w EME TSR,

o Oracle 8EE - BES 1% E Oracle 2EEX Eﬁ‘

o Azure SQL #iBFEE Azure TR sQL B #5 - 5
FRo

e Amazon Redshift - ZE &%
ODBC Kz - B %

e SAP HANA ODBC - fr &3
2 HEZE SAP® HANA® ODBC & % B Fo

2. 3% % BFRFIEZ] Pl Integrator for Business Analytics, &

3. BEEXRMBR, BESREHBERMEXTE,
e figi® Amazon Kinesis #(3E 7t B #5
e BZi&E Amazon Redshift B #5
o EZi& Amazon S3 B 4%
o FEZ& Apache Hive B#x
o FEZ& Apache Kafka B#r
e FEZ& Azure Data Lake Storage Gen 1 B#x
o ECE Azure BHFILBE R
e FEZE Azure loT Il B#R
o FEZE Azure SQL #IEFE B R
o EZE Azure T saL it B4R
e EZi&E Google BigQuery B %
» EZi& Google Cloud Storage B #x
e FEZ& Google Cloud Pub/Sub B#R
e BZE Hadoop # R XRS5 (HDFS) B#x
e FEZE Microsoft SQL Server B #x
o FZE Oracle B4R
« EC{E SAP® HANA® ODBC &K #i B4R
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B Azure SQL #iEFESL, Azure TR SQL it B

Amazon Redshift
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o BEEXAXHBER
4. RFRAPBRRMERINR, BSHEET R BRRUR,

wINAE A B AR

AEBNBINFEIRINA A B AR,
TR O AR B AR R RARTE.

1. BHEREER E AEBRGEE,
2. BHBRRTFR,
“R A BFrECE” U E RERNETHF
3. BHFmAEmER.
HER M ERNIEEREENTH
4. ERGERFRAARMBINAT. 2HERKBEFMIIRPIEFEMHEE,
B EHHE B,

i

BoiE Amazon Kinesis 24E 7 B 5

SER T RSB, LIECE Amazon Kinesis 248 7R B PR F RIL R 2B 7] LB A El Amazon Kinesis 23Ei7 o

o HA{RTE Pl Integrator for Business Analytics B #rECE F 5 A B AWS 17 [7) 4R 3&E A F 3 Amazon Kinesis 1
EHEBERER LI TRA AWS B : ListStreams. DescribeStream. PutRecord/PutRecords 14

o FEECE Z AT BIEE Amazon Kinesis R B R, BXFHAER, BESRHIN A E R,

1. #EETE, B ERETR, AEERHBRIIKRDERE B,
FENMRELGEETER BRET—F,
2. SETRAMAFTENER, REZTHERRSER TR,

S b

AWS THRIZE4A ID Bt Zih R 24 & & F AR R SR Rt 1T
S1REIE,

AWS F## 15 18 240 5 aAws 15 R Z 40 1D” 45 & 3 RIS SR XY $idE
TEHRRIE,

Kinesis #UE R BRI B AR Amazon Kinesis 2B R BIE 1

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 35



'AV EVA\TM Pl Integrator for Business Analytics

PLEC:

2X1A : us-east-1
X
af-south-1
ap-east-1
ap-northeast-1
ap-northeast-2
ap-northeast-3
ap-south-1
ap-south-2
ap-southeast-1
ap-southeast-2
ap-southeast-3
ap-southeast-4
ca-central-1
ca-west-1
cn-north-1
cn-northwest-1
eu-central-1
eu-central-2
eu-north-1
eu-south-1
eu-south-2
eu-west-1
eu-west-2
eu-west-3
il-central-1
me-central-1
me-south-1
sa-east-1
us-east-1

us-east-2

BB R B

B T

thig MBEFHIRPRQAEHERE, F2REHA
FERPFEHHA,

BIFZE KX 2B N E XK Amazon XIS,
FTREEE/R EFXNEUTZXEREMNER
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us-west-1

us-west-2

P FrRIH X

EEEHEFimETEENMEXE:
AWS GovCloud (£EZR &)

AWS GovCloud (EE T ER)

£ [E 1SOB R SR8 2

EE 150 FRERFE ST FE LM

E[E 150 FEERELZ HL % M

T AWS Kith X i3

BEFEENX

(RI1%) AT BUR RSB K BRIAR
“Parquet”, E{thi£IA JSON F0 JSON Indent,

E4%

(FIE) HEEMEMRER, BIANN T, HithikIn
A gzip 1 Snappy.

RVFEE

(k) ik 2fE, ZEHAER.

3. BHERIRTE.
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BHREFER.
#2F AP 15 1R Amazon Kinesis B4E R BARHIRR. EXEZER, BSRIET 15 BIRERUR,

FELREEXXFRESIRPARIIHAXE, HRNFRIFHRE (FRIEZREZRE) . &
FRAR AT, AVEVA N il B2 R RIG RS, FRERIESEF R,

A

ZEEFEE Amazon Redshift ODBC 3N 25

CILMIERZET Pl Integrator for Business Analytics BT & #Hl LR EFEE Amazon Redshift ODBC X152
. A F BeBC® Amazon Redshift B ¥R,

1. 7E Install and Configure the Amazon Redshift ODBC Driver on Microsoft Windows Operating Systems (¥£
Microsoft Windows {24{F & %t £ R FMEZE Amazon Redshift ODBC IFNFEF) TWmE, RIFEH saL B i
TERNAEFHREEMTRREXH:

* 64-bit — Amazon Redshift (x64)
2. B LIZREE Amazon Redshift ODBC IXZ1FEF .
RBHBARERER.

w

EZi® Amazon Redshift B #5

SER TS ER, LIECE Amazon Redshift B ¥R F I UE R 2 % 8] LLE A Bl Amazon Redshift #E & .

o FA{RTE Pl Integrator for Business Analytics & i B ¥rBC & & 51 A RO Z0 R BE FA 7 XY Amazon Redshift 21 FE
Z=/HBE B LI TR :SELECT, CREATE, DROP. UPDATE, INSERT #1 DELETE,

o REEHFEIE Amazon Redshift ODBC RzhiEF . EX B ZER, BSRETEFHAEIE Amazon Redshift ODBC
IR,

o SE83 Amazon Redshift B#r, RAEBHITERE. AXBEZIER, BSRANAAER,

1. E“EETE, £5ERETR, REELXHABRIIERDEZEBFR,

IR MRELAETER BRET—F,
2. SETRIMAGTNER. REZRERARSERETIRY,

B b

ODBC EZhiEF (A]3%) B4 2 Amazon #¥ 55/ ODBC BN 2R, B
1A Amazon Redshift (x64),

HEAW $iE R X 2M Amazon BEET &,

BEREFIRD (AE) EBRSHE S BHERIEFEERNKD, BAIA
7 5439,
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RE XM BR
SH EE:pUY
HEHEELH HIEB AP ERERE,
HIEERF % RATEEIBENBIEERF 4,
Password AT EEIFSNBIEERS 2MESB,

3. BHERIRETE.

4., BHREFERWR,
5. ¥R 158 Amazon Redshift BFrBINR, EXEBZER, BHSHEFT1HE BIRHNE,

BZiE Amazon S3 B xR

SER TR B, LIECE Amazon S3 BARFRIFIEEE A LIE AEI Amazon S3 #iEE .

o FA{RTE Pl Integrator for Business Analytics B #RBCE F 51 A B AWS T 8 2 4R E AT X Amazon S3 BFRE
B LU RAI AWS A F :s3:ListBucket. s3:PutObject. s3:GetObject. s3:DeleteObject F
s3:GetBucketLocation,

o HNRIRE(EF Amazon Athena #UEEE, NIFHLRTE Pl Integrator for Business Analytics B ¥rEZ & P i A
#9 AWS R B 4RE A T X SR E B A LU TR AWS A :Athena - RIRFIE A, AP LB &
BRIMNE AR XA,

R% %2 R1E iR BREM
Athena * (R E#E%E) ERIEREFE=-T/F |%

4A
Glue * (AT A1) A RE x

o Athena-EEIMEA, AFAHNERSEMMEABXMUAENR, RERFMEA, AFRAERE
BREAE A XA ENR,
o Glue-EWMMEA, AF X MERSEWMANEAHEXMAAENIR,
AR EE AT Amazon Athena B E, ZEUEEXL AN S Amazon S3 B TR —XiE, REXEER
Parquet BIEFFERE I F ZHFE A Amazon Athena #IEEE
o 5Bl Amazon S3 BiR, REBEHITERE. AXFHAER, BHSHEANAM B,

SRR TP E, LUELE Amazon $3 BFRH B IEZE A LLE A E| Amazon S3 7E &,

1. AEEE, fHBARERR, REERSBRIIRFEREBIR,
FEMEELEETER BRET—F,
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2. SETRIMANMTNER. REZRERARSERETIRY,

S ik
BIEFMEEK AT E#ESEN XK, BRIA N “Parquet”, &
th 3% I A : JISON. JSON Indent F0 Text,
E4 HEEMERER, BIAN T, HMEDE gzip

#0 Snappy.
AR AR —FERIZE LIRS EIFHIMERE,

AWS T [RIZE 4R ID

B MBI RER S EERTERNFEBET
SHWIE,

AWS %15 R %4 5 “Amazon 5 R1Z4R ID” & & F AR R 126
W4T BRI,

AIEFRE WRZE, 54 PR MBI STk,

FERORET SRITPHBIBEFERNTE, AERT, ANl
B () PRFE,

Hhig TEIIE T 55 i T8 E Mt 8 X 5 ; o0

RETHIRFRDLEMERE, FEHERATF
B FIhm A,

BiFZAE R 2B N A A Amazon R, M
TRRFEAM, BN S LUTZ2XFREMER
PLEC:

2KIA :us-east-2

X

af-south-1

ap-east-1

ap-northeast-1

ap-northeast-2

ap-northeast-3

ap-south-1

ap-south-2

ap-southeast-1

ap-southeast-2

ap-southeast-3

ap-southeast-4
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REXRMER
ca-central-1
ca-west-1
cn-north-1

cn-northwest-1
eu-central-1
eu-central-2
eu-north-1
eu-south-1
eu-south-2
eu-west-1
eu-west-2
eu-west-3
il-central-1
me-central-1
me-south-1
sa-east-1
us-east-1
us-east-2
us-west-1

us-west-2

P FEHIHX

EEEHEFImEITEENHEXE:
AWS GovCloud (EEZREB)

AWS GovCloud (£EFEER)

£ [E I1SOB ZR &R H = {5

EE 150 RERFE S FE L M

EE 150 FEEREZ HL % M

X AWS K [X 15,

TokRE

DREBEITHFR BRAERT, A—1T #1720
#ET. ATHREHFTHFAIEEREN. BIA
RESNHENE BRI EHRHTFH,

FHERAT

iR £ B E e 53 R,

XHFKERE

(AM%E) E L ATRFML (/) IEELE S3 A
LUNE, BARBLIIE S3 hFEETHEEE B
Fro BXTES3 HEIBEBEREHMNELZER,
HZ R Object Key and Metadata (N R BT
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BB KB
7).

S ¥ B E, ZESEN.

BATTH/NER (BT3) SCHF PR AT R 2. BRIA: 100,000 17,
HSALUTER,

BRICHER N (KB) (BT3) BASCH A/ (F 1) . BRIA:10,000 KB,
HSALUTER,

BKEH A (B) (FI3) TR 1B 2 AT E H SR AR B

(LA R B AT) . BR1N:86,400 F) (1K) . BFES A LL
TR,

Amazon Athena £ EE

(Ai%) #3EFRE A BY Amazon Athena $UiE EERI &
/18

FEAREEXZFRETIRPABIHHRE, HINTZEFHRE (FRIEZREZXE) . &
WRAZME, AVEVA O Bl 2RI R R 5, AR IR mMRE,

AR BEZANNESHZ— BRRITHR/NRYE. ZFAXBGK/NHSEKEHFRE, NREHREE, WA

EIFIHA RAEIR— X, KERS OB,

=N SHEMARNEH BRrA BIANEHHEFINIT, BANE - SRFMA R X482, ERH
XHHBERALL -1 BRAERRSHRITHAIMIEERME,

3. BRERIREE.
4. BHEREER.

5. TR IAE Amazon S3 BArHINR, X B LZIER, BSHIEF1H R BHRAINE,

B2i& Apache Hive B#F

SER T RSB, LIECE Apache Hive BARFH MR 5 Hive 4B ERIIERE,
583 Apache Hive B¥r, AEBHITERE. AXELZER, BHSHEFMNAME R,

AR BINFAEFRTPRAGR. EFRHPEEMFNERZE, RUAMEEMERRS, 2hikd, RiE

BHEEBEET—1MFEK,

1. A EETE, B BERATR, AEERMBRINKRPEEBR,

FE: MREZLGET B BRET -5,

2. SETRIMAMBNER. REZRERRSERETIRY,

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 42



AV=VA"

Pl Integrator for Business Analytics

WREXRMBR

.

3

HDFS URL

B @ d WebHDFS (& 83 Apache Knox W X B¢
HttpFS 48] HDFS B4 URL,

w5l

HDFS — http://host:50070/webhdfs/v1

HttpFS — http://host:14000/webhdfs/v1

Apache Knox — https://host:8443/gateway/default/
webhdfs/v1

IS UF TLS/SSL ik

IR IETE{E R TLS/SSLAEH, Mkt §i%4E,

RAF4

BH¥5 HOFSs EEMAF 4. ZBEFRMEZRE
HDFS B R,

(Ali&) ATFRIEAF 53 80%E i HitpFS &R,
IR T 253, NE A Hadoop HTTP F13 %K
iF, ANER k5 AZEHS, N Pl Integrator for Business
Analytics {§ FA Hadoop 8] 8 & {71811,

B3

BEHIFE X E F, LHEXN TS MEBNFEHKE
X B %, 1I5E B ZAEMER A : /rootfolder/
folderl/folder2,

Hive £#14

iBAT Thrift BT ENBIEN L, LLRFFATLLZE B
£ . NERHh b B 1P Hhdik . BRIAME N HDFS URL H1RY
W4,

Hive %0

(A1) BRI EE Thrift RO,

Hive AF 4

(AIi%) FAFE$E HCatalog IFAF 4 o

Hive B X

1 Apache Hive REERME R . BRTIFM G
R A (TEXTFILE) R FE L THEER (ORC)
*gito

SEE :ORC E3R{# A Apache Hive 0.11 B{HE &k
X,

Hive #E

HEFE H P8I R AY Apache Hive 2IEERI A F5,

3. B IEREZ Apache Hive,

Pl Integrator for Business Analytics 3% £ El| Apache Hive, B HIEEFH F R HNREBERFIBIEE
B3 Hive Table Format #0 Hive Database FEX

4. BHKIF Apache Hive REE LI IE Apache Hive lREEREEE A Hive $IBE,
AE: MRIEEBIIE A Hive 8UEE, 55 HApache Hive 1ZE1Z T,

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 43



'AV EVA\TM Pl Integrator for Business Analytics

WREXRMBR

5. BHREEN.

Apache Hive iR ER~

ZE il Apache Hive 0 Pl Integrator for Business Analyticsth B8 4F, HMSER LU TES:

13 HDFS A,
B3 HCcat B,

BEAF B FXHR TR,
£ F SASL,

UTESRNAE T sl sl Lk 4E55,

1.

8% HDFS RF,

a. TERZ WebHDFS #I75 | LBl HDFS AP,

b. 1F HDFS FAFRMEIEA A,

R HOFS AP AT LURINEMERIA 2D, BERA T AEERA, XNATELLHIR TR HDFS 4,
Bl HCcat AR,

() IR HCat ER — T m L, B4 BRI Heat AR,

a. &% HCat T M EBIE HCat AP,

b. fFik HCat FAF #NEI HDFS 4,

B/ B FIHE TR,

HEUTERED, BHERFEFHBREREER, LUE HDFS AFAIUEANS,
a. £ HDFS LOIE—1TAFBEx.

. B REAT A& E®N HDFS A,

c. fFitE FFERAREHRN HDFS,

d. MBEXRESE (hEt 2 HOFs AF) BFERENE.

e. MEFXFEMARTIESNIR,

2 SASL,

7EE.: Pl Integrator for Business Analytics X 2 #{# Fi NOSASL B4 K UEBD & # Apache Hive B #5, E T fi#
X% F Apache Hive B RIEEINIE ZIE R, S5 Setting Up HiveServer2 (IR & HiveServer2) ,

O

B2i& Apache Kafka B #x

SR TS B, LIELE Apache Kafka B AR FH R U IR EE 8] LLE A Zl| Apache Kafka 23EE

o BB Apache Kafka B#R, REBHITRE. AXEZER, BSRFMNAMET,
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o (W[IE)WIE OpenSSL BREREAERTE T Pl Integrator for Business Analytics BITTEHL L, (X H&{EA TLS

EEER| Apache Kafka B F EERITUL S TR,

1. AEEE, £HBARERFR, REERSBRIIRFEREBIR,

FE:MEELARTER BRET—F,

2. BETRIBAMBNER. REZRERARSEREIIRYE,

SH

EE:pu

Kafka {CEE

Kafka KEHES HIRIIR. LR EH- im0, EH:
IO TE .

Codec

5%:%\%%&2@?%@0 gﬁuﬂ‘] ”36”0 ;ﬁ;‘:&ﬁ:@i@% .
gzip. Snappy.

& FH TLS/SSL

YEE Kafka REBRHER TLS/SSLUEMIE R 1) o

TLS/SSL EHZ I UF

{FE AR TLS/SSL EH L B IUEE A (Apache
Kafka J&14 ssl.endpoint.identification.algorithm) ,
HTTPS B “E” (XX H B RIE) . BRINEN

None (),

& IR P RIS R R (pem XX , NAEE
TLS/SSL F B REA SASL HLHINFE, B %R
Apache Kafka B &, 3RHX Pl Integrator for
Business Analytics B OpenTLS & F IHiE$

B IHREAXESEERE (key XXH) . XTEE
FA TLS/SSL 3 BLR{#E A SASL HLHIRT B E,

TLS/SSL UE 2547 S RO ZE TS , AN FE(E A TLS/SSL
F B R{EH SASL HLEINEE,

CA tRIUFH

ATFEZEFIHIER LZE M CA RIEPATER
&, RNTFE(HEF TLS/SSL BT EE,

SASL HL#

AR SASL L, BRIN A", XFLMHH K
UEHLHI : GSSAPI (th FF 9 Kerberos) . PLAIN, SCRAM-
SHA-256 ¥ SCRAM-SHA-512, Fx{Ei% 219
PLAIN, SCRAM-SHA-256 Bf; SCRAM-SHA-512 5 TLS/
SSLINFZLEEFEA, LMESHRRKILEREERITTE
FIB &M%,

Br&

BT sASL B {38 iERY Katka AF &, FHEF
GSSAP| B3,
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RELXMER
Z5 BT sASL B3 % F Y Kafka 2558, EHF GSSAPI

SHRWIE,

3. BEHRIF Kafka &REHE .
4. BHREER.

o RF AP AA Apache Kafka BFREIRIR, AXELZER, BSRIE T U71A BR8INIER,

o HNRIREEF TLS EHEE| Apache Kafka f$I8, M AT Windows IE P F5IR A OpenSSL IEH, tNRIRTE
BIRX L At FEE B, 158K % Apache Kafka B ,

®E Azure Data Lake M iERIIR =

B2 & Azure Data Lake Storage Gen 1 B¥r 2 B, #&8FEIR{E Azure Data Lake I, EATIFMT AR

e 3REY Azure Active Directory FJEF ID
o EZE Web RIFAFER LU IR Web API

EFF 4815 A Azure Data Lake Storage Gen 2, i5Z R LLF Microsoft fAfi : Azure Data Lake Storage Gen2 & T,
B3 Azure Data Lake SFERY, FKREUTIER:

o FHF ID — #R1iR Active Directory BJ ID

o E i ID — FRIR Azure Data Lake M FBFEFHI ID

o EFmEH — BT HITEPRIEPI Integrator for Business Analytics
e 1T ID — #RIR Azure Data Lake Storage Gen 1 4 ID

AR BUSEXEE S IR R LUEEES %, BLE Microsoft Azure Data Lake Storage B ¥REY
EEXLEIE R, Pl Integrator for Business Analytics {# F b 15 B K% %% Azure Data Lake Storage Gen 2,

JREX Azure Active Directory BJFEF ID

AR AEMAERUREHE, D, ETHEMERAE, 5SS H Microsoft X1,

1. T Microsoft Azure [ 17 |, BFiZik 7 LUEEEI Azure Data Lake ARSS .
2. EFEFRAT I Web R 2R # Azure Active Directory,
3. BEEM.
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Home > emoninoosisoft {default directory) - Properties

emoninoosisoft (default directory) - Properties

Azure Active Directory

i=| Custom domain names - Name
Default Directory
2 Mobility (MDM and MAM)
Country or regicn

Password reset United States

1 Company branding Lacation
United States datacenters
¥ User settings

Notification language
Properties English ~
B Notifications settings Global admin can manage Azure Subscriptions and Management Groups
o
SECURITY
Directory 1D
Conditional access 73856c71-7490-401b-2976-f91dcd42c490 E

AR EENFPMILMEEEN, RREAREEEREFARE, SHMERREMATHEMAAE,
P ID 2EF 1D FERPME,
4., FHFRFEEHBIXARIE

A& Azure Data Lake Storage Gen 1 B#r

SER a5 BR LABZ & Azure Data Lake Storage Gen 1 B #%,

o S5ERK Azure Data Lake A BRIREFH W EEE BIFFTENER. BXEZIER, FS MR E Azure Data
Lake R ZRYIR R

o % BI% Azure Data Lake Storage Gen 1 B#x, REBEHITERE.. AXEZER, BHSH AL M B,

o NIFEIEHEE| Azure Data Lake Storage Gen 2 B F 1% F LU T &KX PR : 7€ Azure Active Directory H1, {&
RAE P InZEAEMFTNREF RN RS EAINERAER RN, EF#EkS S, NN AREF
15 B X BR 4> B Storage Blob #iEFR A& A,

1. BB AL, 2HEREDFR, RAEEKf BHR 55K Bi%EF Azure Data Lake Storage Gen 1,
2. {FRALTSHECE Azure Data Lake Storage Gen 1 B #x:

S8 fik
#HFID Azure Active B &tk P BIFR IR,
MR ID 13d Azure Data Lake Storage Gen 2 X Pl Integrator

for Business Analytics N FATEFH# 1T 57 RUEHY
Azure Data Lake Storage Gen 2 R A2 RIVRIR &5 o
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REXM B
e ik
B imEH FF& AAD R FAFERF XY Pl Integrator for
Business Analytics # 1T &3 K IE B4R,
Azure Storage 1l 7 & #R FATFX Azure IR HAT B AR Azure Tk 4
o
HiEFEEX FREBIERM SRR, BRIA N “Parquet”,

. BHEBGEUE LIS IR EIER B LT Pl Integrator for Business Analytics %%l Azure Data Lake

Storage Gen 1,

R BRI IERLTN, Azure Container 513 % H I Data Lake 313K,

. HEFRETINSH:
S8 fah

Azure &5

BT EMEEIRR Azure Data Lake Storage Gen 2 &
o

ADLS H*

Azure Data Lake Storage Gen 2 F EAHURMIGE .,

Bfit i Bt 18] 2%

RTE G, 2R E R AT E A e R 2 M AN 3T
et BREMUERNNSEE - X, —
BBERRITH/NRYURE, HEFEXHELH
KEFERMMKFESIS. MRRIEE, WEXHH
hE AL GUID 73, FES T RHELHARR
FFEAEMMEIE M, EERIRKITHE/NR
HRH . 2RE N FLR ST RUGETRY GUID R 51,

BIEIRE

wE2E, FNATFRMEIRATF L,

FER PR

FBF7£ Azure Data Lake Storage Gen 2 X {42 @
BB EMNFRF. AR RIRFLERE,

RATH/NRE

X ER AT R # . EAIA 100,000 ITARVFER
0 - 10,000,000,

& kA R

BURAE R (AR R B AL . BKIAE 900 (s) S2F
StF :0-86,400(1 X) (AJ %)

RRAmAAN

BIRERRDBRK/N(LIFET REA) , BIAE:
4,194,304 (4 MB) St :0-1,073,741,824 (1
GB) LHERTHEUEA K/, MAZEAXHE KRN,
(AIi%E)
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BEX MBI
S8 Fii ik
R ARKN BUBEHINRKF T8, EAIA{E 4,194,304 (4 MB)
RYFSER :0-1,073,741,824 (1 GB) L ER T H#1E
AR/, MAZBENEKRIN, (AT1E)
R KERRE BUR MR KEIR R, BIAE 6, £FER:0-
100, (AIE)

5. BEHWIUF ADL REH, LIRIE Pl Integrator for Business Analytics 5= & REJF 23E S A E$8 E BY Azure Data

Lake Storage Gen 1 fif &,

AR R Azure BB THIIIRDEBELZ B, BHAR ADLS Directory PRI R E M S 1REERN

Azure BasHHICED,

6. RHRFER,

7. RFAFF#%F Azure Data Lake Storage Gen 1 BFrEUIARINR, HEXEZER, BSRIZF 1A HIRHIN

iRo

1£ ADLS Gen 2 ®affthnast a2

EREZR, BTANEHRI—TEBURF. BETHMBX L H g, ME6ERE A RZE 32

BHEA—ITEHEXHE, X5 GUID IEEITLE, £ GUID &,
SUHER, TER—EAMEHTRIEH X,

EMABAN B, REEBHEXRTHR/N

£ ADLS Gen 2 BEEE U@, SNRFEF M0t EZE, WAMHBERFEE—1TXE4. TULF—1 5

HL GUID, RILABCERTEI 2L, X B BNIATT R/ X REN
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Publish Target Configuration

Foarland

T 2 Publsh Taigal =) Panaes Pabbsk Tagin Dala Laiow Soregs Ger KTQP Ergne RTAP Engne securfty scossa

Wtily ADLE 2 Wiiter [

BLiE Azure B0 BFR

SR TRTE, LUEE Azure B4 30 BIRFNRE Azure BHFILHIEE,

Bl% Azure EH-10>, Pl Integrator for Business Analytics Bl EFRIR Azure FHhILEZTHE) KK, FrE
B PR Z Send,

1. #A“EETHE, 25 BRENR, ARELEMBRIIERDEERE B,
AEMREZLEET BN BRET—4,
2. WE Awure BEHFPLERFFR, EEFTHERIXMTRIR:

Endpoint=sb://<NamespaceName>.servicebus.windows.net/;SharedAccesskeyName=<KeyName>;SharedAccessKey=<

AR MEEBEFHERESHTOLAE, MIESHFLRRFEL(ERFEEFEBECHW
ConnectionString, Pl Integrator "3 %)

3. FRALUTSHEE Azure EHF0:

S8 sk
Bii i IR & IR R DRSS A X R B D
EEF B FH Endpoint B,

AE HRRENEFRL "sby// FFL, L
" servicebus.windows.net" £ BAE N A,

HEGFZHE EXHZVPREZEAEEER, LUEEIEHPD, X
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%
s

EE:pUY

EEHPDEETFTHEGH
SharedAccesskeyName {8,

St
§.
X
By
&

EHPOLHEEASHEBER, 5”,\5175@5‘?‘%}%

£ ESFEALERIIEHPD, X2BHFD
HEHEF FF & Y SharedAccessKey TEQ

SEIREE 1R FHIERAINEHEDOREK, XE2EHPI0E
& FF P # EntityPath (B,

FrF s

X EURH TRB N FTAMNFERFE, A UTF-8, &
{hi£INAH ASCIl, UTF-7. UTF-32 F Unicode,

THEMEREE Z R T AL Microsoft Azure | ] PSRN B I EIX LS5,

SAS Policy: SendOnly

N eventhub Shared access policies

£ Search (Ceri+/) & acd

P Search to filter items.

SendOnly

AR ALUEARESRIENRMEGFOMINE Azure £Z1H R REE, SETRTLUN L AIEFHRFZIEE
RS BEE I MR LT, REARBEXRARTR, SHthARATHEMMLE,

4. BERITEHPOMVRESRIIEFHFDLDETER,
5. BHRERR,
6. MAFET Azure BHFOBRMIBRINE, EXEZER

BEiE Azure loT il B ¥R

R, & HET 15 BRrRR,

SR TSR, LIBLE Azure loT Hul BFRFHMIKE Azure loT L BIERE,
BI%E Azure loT B0y, BIEEELHRIR Pl Integrator for Business Analytics 548 FABY Azure loT Bl

NRIEET

;ﬁlﬁ.l %H%o

TFik% ID BIE—1EE AFE Pl Integrator for Business Analytics S RR &, NIFTEMNRIE

R 2 EMFRITEE”, BN Pl Integrator for Business Analytics AN E B3 81218 %, NFFENHRIENE
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RERf B
= EMKREAN",
R X HE A R AR B — SRR S A R UE LI,
1. A“EE'TE, SEAMETR, ARERMBRIIKRFER BT,
AR MRELERTER, BBET—H,
2. B loT FIDERFRE, ERFABEEXMTR:
HostName=<Host Name>;SharedAccessKeyName=<Key Name>;SharedAccessKey=<SAS Key>
3. FRUTSHECE Azure loT il :
SH ek
EHE FHIRR I oT PILBENE , K2 loT il
EETFT RS HostName B,
HEZ R ZHE BEHRZIFRIFBALEER, LUEEE 10T Fily, X
7= loT HUlMEHEF £ 8 B Y SharedAccessKeyName
&,
HEZGEEH loT FILMEFRASHIMEZN, 5 HEFHREHR

ZNEEEALUEEER 1oT by, X2 loT Huly
HEHEFFF &Y SharedAccessKey .

F w5 FEUER ITRBINFTAMNERSE, A UTF-8, H
fhiEINA ASCIl, UTF-7. UTF-32 ¥ Unicode,

8% ID (AT3%) 10T I Z X 0T Edge R EHIIRE 1D, X2 H
B4R IR B BB Fho loT Edge REFEEFIRE ID,
Xt loT RZENZRHET, MNRKIBELMT, BHE
TEBIE— 10T 8%,

AR NMRBERREFRETIRE ID, MXNAED oT fFILERAIE—I B, EEFFEMZEZ D
HEEBEMED 10T R BTN EM—, Y2 BEAERMEEFFEMIZE DA, ATRER
HILE SR,

LUTRBEER IR T Microsoft Azure Portal BRI 2 GLE AT LUK E] loT FIDKEETF RS, BIEE,
Pl Integrator for Business Analytics &K B loT £ Z 15 B R MEEFFF & (MIERZ R B HERE
FRE) AU TUEIEE M RREFEZEFTHEMNERE, B, RIESFEFRTIRE D, ERXKOE
REFTENREAISEEEFF 9 Pl Integrator for Business Analytics B Frig ik B RIEHIEEFEF R, TR
BRACEZETFRE,
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esources, services, and docs

Microsoft Azure T,

- Shared access policies

Create a resource ;X‘ d i - Shared access policies
Al services
«

% FAVORITES + o
B8l Dashboard X Overview
1 Al resources B Activity log R o Hub uses permiss
§ Resource groups ™ ntro
& App Services @ Tags
% Function Apps Events PoucY
& 0L databases Settings iothubowner
& Azure Cosmos DB Shared access policies service

4 Load balancers B Operations monitoring

registryRead
B storage accounts

registryReadWiite
Virtual networks

@ Azure Active Directory
© o ——

@ advisor & Locks

W security Center 3 Automation script

it access to each loT hub endpoint. Permissions limit the ace

registryReadWrite X

5510 an loT hub based on functionality.

Permissions

[] Registry write @

PERMISSIONS

registry write, service connect, device cont
service connect
device connect
registry read ary key @

registry write Secondary key @

LT REEE IR T Microsoft 10T Portal FEIHSNIERI LLA loT FlMZ R FRENZFR ID SHLUKRE

A LE R LR E SR RIERE,

jdoe-iothub - loT Devices
T Hub

Ovenvie
J ‘You can use this tool to view, create, update, and delete devices on your loT Hub.
B Activity log
2 Access control (IAM) Query @
SELECT * FROM devices
SETTINGS WHERE

optional (e.g. tagslocation="US)
Shared access policies

&' Pricing and scale

Operations monitering
I 1P Eitter

A Certificates

1= Properties

8 oo 7] Pinigator e

£l Automation script

B 0T Devices

& 10T Edge (preview

Add Device

Authentication Type
[Smmeere -

Auto Generate Keys @

Conne

| Enadle | Disable

FE-HENFMEMESEYT RRAUREEREFRTR, SRMARRLTHEMLE.

4. BHBIE loT PiMREHRRIE oT FILDREEH K.

WNERHETE T’ ID, M PI Integrator for Business Analytics =R EKIZIR &, MR RIEETIREZ D, NE

BIE— M RFHAERIESTAERRIZIRE,
5. BEHREFERER

6. MAFET Azure loT FILBHRMTHRINER, EXELZER, BHSHRIETHE BRHNE,

®’E Azure SQL #3EFEBL Azure T SQL ;t B#5

SERRUTESERLIZE Azure SQL BHEEEEL Azure T HH saL i B4R,
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1. 7£ Azure P REHIEEHTHUTES:
a. £ Azure RIRERH XEEMN, 12 F LI T Pl Integrator for Business Analytics FIARSS 28 @IIX LE H iR &
EIER IR

EIAER T, Azure B XIERPELE SV SRR FRFE R 1718 Azure SQL $04EEEFD Azure T F sQL it EUIEEERRS
2o Eitk, RLMBATRIRF RS 2R R U7 B AXRR

1R FE R Pl Integrator for Business Analytics BT & #H1 £ S E| Microsoft Azure [ 17, Ui ID £
FRIR T 1204 R 3R B AR S5 2R MO 2 P i, S AR TTEHLAY 1P btk BB IER X FEL

a. J1ETE Pl Integrator for Business Analytics X 1 B AR ECE 5 A B sQL AP E DR F7E Azure SQL #

BEEEL Azure TH sQL R LI TR (IZF P S ERE EI7E Azure SQL B EEER Azure THH SQL
) : CONNECT. SELECT. CREATE TABLE. ALTER. INSERT. DELETE,

2. &% BFRFHNE Pl Integrator for Business Analytics, 155 #7504 i B #7o,
3. EREXRM B, BHNEMBERRE T T REMNREE:

o ECE Azure SQL #4EE B 5

o BER&E Azure TR SQL it B ¥
4. BFRAPHERMBERHINR, FSREF R BRI NUER,

ERE Azure SQL #iEE B 7

dt

BT E R, LIECE Azure T A saL it BARrF MR 5 Azure SQL T A sQL ;M BIESRE,

BI% Azure T sQL ith,
o ¥F Azure TR sQL AN BFR, B X F L

R, BSRHmAEm BT,

ol

1. E“BE'TE, £HBERFRET R, AR, T ERIIERDIEE Azure SQL BHERE.
AR NMREBLEETEN BMET—F,
2. FRALTSHEE Azure TA SQL B #R:

S8 3

FHA FEE Azure SQL BUIREERIARSS 2RO TR 1B XN
server_name.database.windows.net,

saL SR KIEAF 4 FAFEHE Azure T A sQL MBI &,

saL SR I FATFHE$£E) Azure T F SQL it A D,

b, sk 210 TEFBETAI Pl Integrator Framework RS ZH 15 X fig

YESERLATEY B . BRIAE N 30 7,

FERAE AN (Al E RS T A IS EY RSN
SQL Server, EAAE Al HHESEEEFTHEFIFE
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MultiSubnetFailover &R . AXLEMHHNEZ
E8., 1S H Microsoft Wik,

BIEEE FATTERY Azure T H saL R E IR F5.

st 5 7R BIHR RO TR A X B SOL 224,

3. B dConnect,

4. MEUIREESRPIERHIEE,

. BEREEY.

6. MAFERT Azure TA sQLMBARFTERNR, EXELER, BFSRIETIHR BIRHNE,

]

BiiE Azure TFH SQL ;i B#r

SERR TP ER, LIECE Azure T A saL it BARrF MR 5 Azure SQL T A sQL ;M HIESRE,

o 6% Azure TR SQL ith,
o JF Azure TR sQL AN BiR. HEXFMER, BSHFN AT EHR,

3 EE :Microsoft IR Azure SQL 2B (T H saL ith) = @B . B E 2024 £&Z, 7 Aure 1M
ik, 1t ARSSEY Microsoft HEIF=ME M A “T R saL ",

1. BB TE, $HBERET R, ARELXMBRIERFIEREBR,
AR NMREBLEETEN BMET—F,
2. FRALTSHEE Azure TA sQL B #R:

ZH8 ek

FH4 & Azure SQL BIEFERIARS SR A 7R BN
server_name.database.windows.net,

saL SAKUEFAF £ FRATEEET Azure TH SQLMMAF A

saL R KIEFB BT EHEER Azure TH sQL TS

KA £ Pl Integrator Framework ARS5HERT AT, J94F43E
RFE BFrm a2 ECROET A, INRFEREZE, MIBKIA
BER30#,

= At (RI3%) 3 1 3132 5 5 AT PR IR P Ui B S 1

sQL Server, EAE AT HMHRTEEEFHEDFE
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BEX MBI
S8 it
MultiSubnetFailover EERBMH . BXILEMHNES
E8., S H Microsoft Wik,
BB FATTERY Azure T H sQL it R E IR F5,
37 B EHSIERIRIE BRI sQL 2244,

3. B icConnect,
4. MBIREESIRPIEFRHIERE,
5. BHRERR,

FAFRT Aure TH sQL M BARHITE R, AXELZER, BSAET 1A BIRINE,

A& Google BigQuery B #r

SERT

mE B, LIBLE Google BigQuery B#RFH R IEZ AR A LIS A Z Google BigQuery %,

e 7E Google Cloud ¥ H|& 81 IAM T, 71 GCP iRk F IRt FU B M T 5 & IE R :

EE A X Google IAM ABMINRHEZIER, S https://cloud.google.com/iam/docs/

understanding-roles 0 https://cloud.google.com/iam/docs/creating-custom-roles,

bigquery.datasets.create
bigquery.datasets.get
bigquery.datasets.update
bigquery.tables.create
bigquery.tables.list
bigquery.tables.delete
bigquery.tables.get
bigquery.tables.update
bigquery.tables.updateData

bigquery.jobs.create

&, ATLLR GeP BRE K P 2 B2 & 3E R AB R BY roles/bigquery.dataOwner 1 roles/bigquery.jobUser
Af,

o %£81# Google BigQuery B¥r, AEBHITERE. AXFHAER, SR N ATER,

1. AEETE, $HEMRETR, REERSBRIIRFEREBIR,

AR NMRBLEET BN BMET—F,
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REKRMBR
2. BETRIFBATMENER. REZRERARSEEGRE,
£ fat
GCP AR5k 7= 254 3 44 B E GCP RS MK EHEEY ISON XX,
BigQuery B8 ID 1584 BigQuery IB A AR B Im T A (GCP) FRAIHE
—1ID
BigQuery HiiEsE AFARKAMERIREABME R RATEE

BHHEEREHETES, REUNEBRTHIEE #
BT HER A BigQuery,

EETEAKRD (FTik) L E AR L& H1TH BRIAE 500 B
FEHIR,

3. BHRIF GCP BigQuery BEAZE,

4, BHBHFEX,

5. #&FHF 178 Google BigQuery BARHIXR, BXE ZIER, S HIZ T 15 A B RAINE,
7E%.:Google BigQuery K| EMEMIERESZ AR EFHEH 900 S HRNEBTLEIEHR, I T £ Pl Integrator
Sync IRSF ML IRTNHAE 1T (FFEEE AE BigQuery FIM B RSB ZX RS, BINFE
%PIHOMEG64%\Integrators\BA\CAST.Ul.WindowsService.exe.config F145 AFMonitorUpdateFrequency 1R &
A 120 7250, 80T AR : <add key="AFMonitorDataUpdateFrequency" value="120"/>,

S RORT R 24 (120 D BECE S 90 A ¥PRRHI) B T IR — 1~ BB KAIBTEL, ik Google BigQuery BEB R
HREMESR, MR EFHESRX, F AFMonitorUpdateFrequency 1R & 7 5 1Z R il 48 F 69 A 8] (90 4
), AR ENETIRS, MREMHRETEFR, GRENAEFEINBIUTHER:

UnifiedAppConfig:AFMonitorDataUpdateFrequency: Successfully parsed.
AFMonitorDataUpdateFrequency value from 'finalAppConfigFilePath'.
Using AFMonitorDataUpdateFrequency) value, '120'(minutes).

MREREHEESZEHXFEHBTIEH, TiC2BELET U DM EHEIE 2%
AFMonitorUpdateFrequency & IEFAEC & F[E X T B Pl Integrator Sync fRF il %, REASBIIUTHEIRER

UpdateData operation halted due to PublishTarget restriction (*-90min maximum EndTime).
This PublishTarget, GcpBigQueryWriter, does not support deleting/updating data rows that
have been modified within the last 90 minutes.

Result: No data has been changed on the PublishTarget.

B2i& Google Cloud Storage B¥r

SER TR T IR, LIECE Google Cloud Storage B ¥R F R E K25 vl LLE A Z| Google Cloud Storage fF{# 1@,

AR E X Google IAM ABMNERMELZIER, HSH https://cloud.google.com/iam/docs/understanding-
roles FM1 https://cloud.google.com/iam/docs/creating-custom-roles,

o 7E Google Cloud ¥#EH|& 8 IAM T, 71 GCP ARSS Mk F 1244 Google Cloud Storage T B #9141 4X R . & IE4X
RE:
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e storage.buckets.get

e storage.buckets.list

e storage.objects.create

e storage.objects.get

e storage.objects.delete
o ZE, AILLA GCP RSk = 73 B @ FE SR KPR roles/storage.admin B,
o MNREE T BigQuery, GCP ARSIk HFE T HIEASNAIIR -

e bigquery.datasets.create

e bigquery.datasets.get

e bigquery.tables.create

e bigquery.tables.list

e bigquery.tables.delete

o Z#E, SNREE T BigQuery, ATLLA GCP RStk P 1Bl RIERIE PR A roles/bigquery.dataOwner 8
a,

o 5Bl% Google Cloud Storage B#R, AARBHITERE. X FHER, BESHEFNAME R,

1. #EETE, B ERETR, AEEXHBRIIRDERE BT,
FEMRELGEETER BRET D,

2. BETRFAAMBNER. REERERRSEE IR,
S8 i
HiFEF X AT i #0308, BRIA : Parquet, HAthik

14 JSON. JSON Indent ¥ Text, AN E{FE A
BigQuery, BBZ N2 HF Text £,

FE=4%8 HEBEMERER, BN T, HMETA gzip
Snappye

GCP AR 55K = 240 30 Eﬁ@%ﬁfﬁﬁ$ﬁ (GCP) ARS5 MK F= S HE A4 JSON XX

BigQuery I H ID (AIk) &/ BigQuery T B 7£ GCP FREgME— ID,

BERE (Fig) R 2 5, 58 MR EISXHFFK

FRRE (i) A F BT PRI BIR T ERROF . BRIAE

AT, AHRA () 2RFE.

(rpe) LSS (A1) ATF A REIBTHFET. AERT, B—
MRTHREIET. BFEEHTNTEETE
KR, ZRAR B S N RN E B 324 ERMY
?ﬁ'o
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REXRMER
FREBAT 1S 83E £ £ BIHI Google Cloud Storage TR,
R ERF (AJi%) Google Cloud Storage XK &%, BRI N
IEEFHEEMIRIRE,
REFZEE EBRzE, ZEEER. RN FARTFEE
RATH/NERH (AII%E) X PR R AT R E EKIA 100,000 1T
BRARICHK/ (KB) (AIi%) R KX K/ (FF1) . BKIA 10,000 KB
EEHNE (F) (RIi%) 7 Y B E B AT 2 B 5B 3 3R B ) ax K B[R]
(U NG, BKIA 86,400 7 (1K)
BigQuery #iE5E (AI3%) AT AR FniEH R RO E &7 8] R A TR
BRH#Z . BIEELESHETED, REANETHIE
&, BIEFHER A BigQuery,

3. BERIF Ger T AR,
4., BHRAFEEWR,
5. ¥#FFFiA8 Google Cloud Storage BARrHIN IR, X B ZER, BSRIE T 177 HIrrIRAUE,

B2i& Google Cloud Pub/Sub B#r

SR TP IR, LIESE Google Cloud Pub/Sub B FH KU & E A A LLE A El Google Cloud Pub/Sub &,

EE A X Google AM ABFINBMEZIER, BS A https://cloud.google.com/iam/docs/understanding-
roles #M1 https://cloud.google.com/iam/docs/creating-custom-roles,

e £ Google Cloud =& IAM T, 1 GCP fRS5 1k F 24t Pub/Sub 10 B B4 BRI AX R . Xt 1Z I B AR IEAX
BE:

* pubsub.topics.list
e pubsub.topics.publish
* pubsub.topics.get

e pubsub.topics.create
o HiE, AL GCP RSk F IR BIERIEINPRAY roles/pubsub.editor B,
o % Bl% Google Cloud Pub/Sub B¥r, REBHITEHE., AXELZER, BHSHFNAZMER,

1. AEEE, fHBARERFR, REERSBRIIRFEREBR,
FE:MEELARTER BRET—F,
2. BETRIBAMTNER. REZRERRSERE IR,
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RE XM B
S8 Fifik
GCP AR5tk 7~ 25 4A 3T BE GCP RStk P EHEAY JSON X4
A ID GCP ###& = Pub/Sub T B BIME— ID
FRRE X AR TRB AT AR E, BN UTF8, &
{hi&INA : ASCIl, UTF-7. UTF-32 1 Unicode,
E4 (FIE) HERERMESRER, BN X, HiEmE
gzip #0 Snappy.

3. BERIIRES,
4, BHREFERHR,
5. 2% AF AR Google Cloud Pub/Sub BARrEUIR ., HEXEZER, BSREFEF 1R HIrHIE,

Boi& Hadoop /AR S (HDFS) BHAR

SER TS FRUAEZE Hadoop 7 XXM RE B IR, FHWIE HOFS 15 E RET HATIHERIRE.
S 032 Hadoop DA XHRE BT, RAEBRITRE. EXELER, BSRAMN AT E T,

1. A THE, 25 BERENR, ARELEMBRIRDEREB R,
AR MRBLEERTER BRET—F,
2. BZE Hadoop R RAXEREBFRHLUTSE:

U Haih
HDFS URL B @ WebHDFS 2(#& 1833 Apache Knox W X B¢
HttpFS 158 HDFS B4 URL,
A5

HDFS — http://host:50070/webhdfs/v1
HttpFS — http://host:14000/webhdfs/v1
Apache Knox — https://host:8443/gateway/default/

webhdfs/v1l

B UF TLS/SSL UEH AR IEFE{E R TLS/SSLUE#, Mkt §1£4E, 20
RIFEFERABZRIER, NERRLE §%4E,

BF4& FHF5 HOFS EEMBAF 4., ZAFWRERZRE
HDFS BUAX R,

Z45 (AIE) B FRIEAF SRR, TEED

Apache Knox BiEIEE| HitpFS(MMBERATERE
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REXM B
e ik
%) B A iR T %5, W{ER Hadoop
HTTP B2 5E, INR K5 AZEFS, N Pl Integrator
for Business Analytics {# Fi Hadoop 8] 8 & {73111 ,
H=x BIRHIEXHME R, REXNESMEIFERT
X B %o
Pt bt 1) 24 RTE T, 1R & 70 B iE] A B [E) B B n 21 32
HEt, BERATNENESBESOIE—NFH X, I
RBRETE, NEFEMMEIIE X,
=2k R ZE, S MRRMEIXHETFL,

3. B EHISUF HDFS EH LIS IE HDFS {EE ol LUEEFH B A HDFS,

AR MBIEMIIE A HDFS, S R1%E Hadoop 0 =302 %% (HDFS) FIIR T,

4. BHREER.

5. #2F AR Hadoop A A XU REBRHINIR. EXELZER, BSAE TR BIRINE,

®E Hadoop B A X RS (HDFS) B9 R

Z it HDFS #0 PI Integrator for Business Analytics B4R 4E, BT TIES:

o I3 HDFS AP,
o BIEAFBERFEFTNE,

UTS|NA T anfel 5epk L ESS

1. ®IE HDFS AF,
a. TE&R%E WebHDFS B977 s £ 813 HDFS AF,
b. % HDFS AP RMEIFENA,

EE: HDFS AP RILUAMENMERIE 2h  BR AT AHEHREA, XANAELHIFFEHN HDFS 4,

2. BIEEFFEFINR,
a. £ HDFS LelE—1TB %,
b. FFit B FHIFTEEERN HDFS A,
c. fFitBRATERMAEBA HDFS,

d. MBXAAEE (hHZ HDOFS AR IRFIREMR,

e. MEFEMARFTEENR,
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SR TS B, LIERE Microsoft SQL Server BFrFEMR &5 sQL $iEEERE,
5£ 813 Microsoft SQL Server B#5, REBHITERE. AXFMER, BSRAN A E IR,

FEE FAIRSEAT Pl Integrator Framework AR EIARSS MK 7~ (2k saL A/, MR IEEFEA saL S48 iE) XY

Microsoft SQL Server EHF LI TR :

RS 2R EK A - EHE saL. BEFEAIEKIEE

HIEESR R - EE, SIER

AT B 2248, E13E dbo ZE45 — SELECT. ALTER. INSERT. DELETE

1. AEEE, £HBERERR, REERMBRIIRFEREBIR,

FEMEELGEETER BRET—F,

2. B2 Microsoft SQL Server BFRHILL TS

g

EE:pul

EHA

i&1T sQL Server BT EHLAYE L4 FOEHI

(Hostname\Instance),

saL SR RBiEAF 4

AT ERER saL Server BAF & (IRFE{FE A saL

Server AW UEATIEE . INREHAAIE Windows
ERi&R%, B84 {F A Pl Integrator for Business

Analytics IR K, )

saL SRS

BAFEHEZ saL Server FIZERE ({XFEfE A saL

Server BHA AT R TE . SN R FEFAAIZE Windows
ERE L, A2 E A PlIntegrator for Business

Analytics IR K, )

Rt

7E Pl Integrator Framework AR5 BRI EI, N IF54E
KA E| B IR BRI R, EIAE R 30 7

RS Ak

(AL EHRD X Fa a] A4S ET R £/
sQL Server, FAEATARTEREFHEDFE
MultiSubnetFailover & B, B X ILEMHMESZ
E8., ESH Microsoft Wik,

BEE

FATFER sQL Server IEFEHIE A,

24

B BRI R X B saL 224,

3. BEHERURIEERETERD saL BURE,
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WREXRMBR

4, BEHERFERHR.
5. ¥R A8 Microsoft SQL Server B#rFINRE, X EZIER, BESHIZ F 15 BFRAIRE,

®i& Oracle #iEE X BIR

SER LTI F2 LLRE Oracle 3EFE & %1 B #%,

1. &% Oracle Database Access Components, H X B Z{ER, 1S H % % Oracle Database Access
Component,

2. @ Pl Integrator for Business Analytics iR IN& #1 B #8, S R #0047 B ¥r,

3. BRiE Oracle BIEERMBER. AXELER, BSHEE Oracle BT,

4. JNIBFE Pl Integrator for Business Analytics & % B ¥rBCE B i A B Oracle AP EAMZF LLT Oracle X R :
o ZREYPR — CREATE SESSION, CREATE TABLE, DELETE TABLE
o RZEBEMNR - tIERFTFHHEBEH

5. BFAFHERABERMINR, HSEET R BRNUER,

)
i

Oracle Database Access Component

AR XZAES R, 1M Oracle BIEE X AN AR F EZE Oracle Database Access Component (ODAC),
SESERIE S IR, AR F HEYH Oracle BUEFERMA X BIRFHITEE.

1. FERZE Pl Integrator for Business Analytics 81t E #l £ %%t Oracle Database Access Component ¥,
AR FERSZERT RIFREMN ODAC MBI,

2. M \ODAC_install_directory\Network\Admin\Sample 53k Z|| tnsnames.ora 3 {4,

3. Y®%E tnsnames.ora X3 Oracle BIEERM— 1% B,
BEMTAIR:

Net_Service_Name =

(DESCRIPTION=
(ADDRESS=(PROTOCOL=protocol _name) (HOST=0Oracle_database_host_name) (PORT=port)
(CONNECT_DATA=

(SERVER=service_handler_type)

(SERVICE_NAME=(TNS_listener_service_name)

Net_Service_Name 5& SERVICE_NAME B934 . HECE Oracle X% B¥rAT, 1&AI LU Data Source 1%
BN Net_Service_Name, # & tnsnames.ora XM E ZIER, 157 Oracle X#4,

5 tnsnames.ora 304753 Fl| \ODAC_install_directory\Network\Admin B 3% T,
% ODAC BR-BILL B AN INE PATH SMEZREH,

B3 TNS_ADMIN REH R B F 45 HHE M tnsnames.ora X ATAL I B RALE
BREF Oracle HIEERMARMEIR. EXELSER, FERAMEME ﬁio

N o u &
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RE LB
Ed& Oracle B¥r

SERE TS B, LIECE Oracle BFRF MRS Oracle B ERIIERE,

o &% Oracle Database Access Component,
HS R L% Oracle Database Access Component,

o Bl Oracle B#f. HXESER, FSRFMNAE BT,
1. AEEE, £HBARERR, REERHBRIIRFEEBIR,

AECMREBZRERT B BRET—4,
2. E2E Oracle BFRHILI TS 3k

S8 fah

IR TR 5! Oracle #1#EE#Y Oracle Net Services %
h,EEMRFERA

FE BESIRZEE Oracle Database Access
Component, T f2A0{aI$§5E Oracle Net Services %

/18
BF& FATF 5 oracle BiRFEEZEMAF 4,
Z4 FF 5 Oracle $EFEEENZR,

3. BEERURIERAESERIIBIERE,
4. BHAFER,
5. &FAFIE Oracle BFRHIMNIR AXESER, BHSHE TR BEIRHNE,

FiE SAP® HANA® ODBC k&% B#r

4 SAP HANA fR%5-25F0 SAP HANA Database Client,
B3 SAP HANA ODBC B#F, RAEBXNHERTRE. AXEZER, BSRANAHEIR,
A SAP HANA ODBC B#RIEIUE LA TR :

o BXIAER T, 7€ SAP HANA f, JFT A B S A SAP HANA #3ER ODBC 14 BRI R , 4R 8] LIFE SAP HANA
R4S E AP 2 A opBC LRI R KR HI A B, (B2, EHRIETE Pl Integrator for Business Analytics &
n BFRECE P4 AR SAP HANA B EH LI TG E AR :

o ZEEXY SYS.SCHEMAS, SYS.TABLES #1 SYS.TABLE_COLUMNS EH & EZB MR,
s FENNEEHESUERMNAEZEFLUTNER:

e ALTER

o CREATE ANY
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BEX MBI

e DELETE

e DROP

e EXECUTE

e INSERT

e SELECT

o UPDATE

1. ERALITS#EE SAP HANA ODBC B #R:

BH T30

T4 SAP HANA RS 259 E 414 L 1P #hdlt

i 1 FAF 5 SAP HANA SEfEEM O S,

HF4 T 5 SAP HANA EHIEEMAF 4.

=g T 5 SAP HANA SRR ZHER

HBUERE (AIE) B EHIFHZNEHEE, XTMEEE
EABIERE.

{8 A TLS/SSL 0 £ TLS/SSL iEHE R SAP HANA RS 25
FEE M TE SAP HANA iE P 774 X AL
+,

2. BERBARLUERAESIR,
3. MIIRFEREEARNARE,
AR MRIRANE, KRR—PBEISHHE,
4. BEEZLRIFEESRTIF ODBC 5 SAP HANA HIIEH,
5. BEREFER.

R RF5A SAP HANA BAREIRR, AXELZER, BSRET U5 F BR8INR,

B XA X4 B PR

EFER TS IR LR E XA B R,
FRIBRXAX GBI, ARBHITERE, AXFHAER BSRFMATER.

1. FEETE, $HERFREN R, ARELXMBRNERFIERBER,
AR NMREBLEETEN BMET—Z,
2. BEXAXEGEBERHULUTSE:
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WREXRMBR
SH 1::pU
B3 AT eEXAXHE .
B Bt 11 2% REFR, R E R AT E A e [ B AN 3

et BREAUENEHS - XM, 10
RRIEE, WHESMMBIE X4,

BIERE EEZE, 5L RMEI XA T L,

FERO R o3 R S R R EM T/ BRIARHIRF
X, ZIEBRFRA DR, BHFTEREZHA
A \to

R AEERERERHIANFH, SlIHTR,
MREERAURENDIRI, BoBEFHAR
A AFIXH 2 BT BB

XHT B4 B S RISUET B4, BRAR txt,

;¥ B Pl Integrator for Business Analytics 2020
R2 SP2 #2, XA B+rry BB NIRRT .csv
txto N TFIEFHRE| 2020 R2 SP2 Z HIELE T AR
FERAMEBR 2 BRAFHENMEEMN B IR
B

MEERTMEEMER, FETEBEEXRN
csv B txt, MILIRTREFMT B2 SABETRA,

3. BEHREER.
4. BYRAPBRAXAXEBRENR. BEXELER, FSRET R BRHUR,

127151 B FRRIX R

UTHRNAT EE R RS RTHAE R AERM B IRRUR,

B HEEER E AEBRETHEE,

S HBERETFR,

B HRMmBRIIKRFEIBIR,

ERTFRAFHRIEE RS BRRR, 585 BRBRBERRIRNSHRRA,
EERSMIAFRTHEE.

BHEAFER,

o v A W N
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WREXRMBR

15 Pl R ® B #riEF2E| Microsoft SQL Server B #5

B Pl Integrator for Business Analytics 2020 R2 SP2 #2, PI B B/ E#F A, FraE A P MB BRI ENR
E#EFHELRAA, EEENEBFRET R LM AABRSIERSD, TZEHEHRE PIABER. FTRSERNE
T anfelEE A P LB & %0 B SR LB E S B Microsoft SQL Server K1 BFR1E N &K,

AR NMREFABEERNENEAME P EBFR, BIUIUE R RS BRE S EBIBR, XM saL Server
B PlintegratorDB SQL $41% FE 1 rO L B SR FN T HUE K ;X & 2R M BT E Microsoft SQL Server B REXE
HAE ol LU PR iZ M B B, B 1T IR E,

INRRELE Microsoft SQL Server X1 B 5, IS MECE Microsoft SQL Server H#x,
AEMUETEERER P BRAMEFHUAE, REEHRAE, AR EHZUE,
AEBRFIENEHUETEGTRIE S FNNEBESEAMEMERE.

K rmE SMEIRAHRE,

B HBERREIR RAREREDR 1 P OIEM Microsoft SQL Server B #x,

R EMETERMNAAE, N IERE TRITEMEDR, WIEERLTITHRMME,
BERAMURARE,

N o u s~ w N e
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EEES

BHEESS

RE]LUTE Pl Integrator R4 L MATIF S EEES, HIANGRIRFE A/ A EFIVR £ f ik

% F Pl Integrators fRS54A

LTI Pl Integrator Z2f5, REIFBIEE Pl Integrators ARSFZH A Windows 48, 357 FI T3S 1T Pl Integrator
Framework AR 55 # Windows AR 55tk F= 2k BE £l ik 7= 45 R 0 E kb 46 =, PI Integrators ARS54H & A Windows RS
K = 58 A ik 7 53 B2 4T Pl Integrator Framework fRSFF B RIENR . Eitt, AEIWIEFF Windows RS
i P 2% RS LK PR INEI R EE Pl Integrator BT EHL LRI EE R A,

F2B& Pl AF Server FN&NiEE

] LIRS BRALE ch A A B Pl AF Server,

1. BEFEER E AEBEEER,

2. HEETIEY, BE AFRIEFELETR,

3. M AF RS2 5IKR PIEFEZFEBRA PI AF Server,
FE: ETERS R LMEIRER S RTE AF RS 3RFIRED M AF BIREESIR G,

4. BB AF IRS 25 LIMT] FARRSS 33 F0 4R BE A 51 3R SR AS BRIE TE I PI AF Server R EHUERE,
Itk PI AF Server B HINTE AF IRSF2RFIZR P,

YmEE R B AR

LUTESNAT R ER S BIREES X

TR AEEEENTMEEN, SEERSERIERAMIZBEFMAEAR., T—5, EAEHRITHHILT
OB FGRAL A E R E T — REEE IR B AR E,

1. iﬁﬁ%‘*&iﬁE, REBRGEHE,
2. AEETE, 24 BRI,
"R BARECE EMEENTH .
3. MEfmBRIIRPIERRMER.
“BARECE ERBEENT I .
IR BMREMNEAMERHEH—N—AEESH
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EEES
4. REBVEE BRPHSH.
BERERMERERLUTHREESHIRHA:
e fti® Amazon Kinesis #(3E 7t B #5
o FEZi& Amazon Redshift B #%
o BZE Amazon S3 B#R
o FEZ& Apache Hive B#x
o FEZ& Apache Kafka B#x
e FEZ& Azure Data Lake Storage Gen 1 B#x
o ECE Azure BHFIHBE R
e L& Azure loT Hly B ¥R
o BCIE Azure SQL #iEFE B #r
o BLE Azure TF sQL it B R
o BEZE& Google BigQuery B #r
e EZi& Google Cloud Storage B #x
e BEZ& Google Cloud Pub/Sub B #x
e BEZ& Hadoop X XK 4 (HDFS) B #R
e BZiE Microsoft SQL Server B #&
e fCi& Oracle B#F
o EBEXAXHBIR
5. BERFER.
¥R % B R
1. BEREEMR E REBRLEHE,
2. aEETE, BHERETRF,
“RI BB E” W EkEENT .
3. MEABRIIKRTPERZEBRM KA B R,
4. BEBBRERMBR.
5. HBIAFTEM AR BRABHIAERMBHRIIRF,
NINZEEM R
;¥%E: Pl Integrator for Business Analytics = hRig 4t L I RE,
BERR A HF Confluent 2245 ER . (N3 HF Avro 244,
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1. BEHEREER E REBEEEE,

2. BEEMEMEBNEIRET R,

3. EARMEMIEMRERD, A TMERAMLFF URL,
URL A7 LA http:// X https:// A BIER,

4. BEHFMEMEME.

MBS P IHEA MR PR E RN EMTUT SRS RATE MR EX,

FHEMRMBIZE MR

BHEEER E AEBRETHEE,

B HERMEMR N R R,
HRMEMER B PEREIEMER,

FE RN EHEME S, B oAR M,
AT EOH, JTEME, EEXGFEGITH.

i oW

EEES

AR N Avro BB,

EMAMERAE FTRAENEERD ENEHEREEATR EEP,

EEM
fENGIRR, A LT LT T IURME

s FAMSHAH
o HIERME

o MUEFMARS
o MULEHRIRAS

SR8 AU E A R AR

fea] LUVE IR B AN B A 15 18] AR -

o AILIEENERMEBERSBIRA,
o AILIEHZMIRIREINR,

EX—REELSIMAENBLRANRHER, BSREES M UEETRR,

1. BHEREER E AEBRETEE,
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EEES

2. BHABERTFR,
3. Bl EIRE, ARE—1THE,

FARMEREE TAETGRNBIRE, B0 ORRATRNREBELUER, EXELER, FEH
ME T RAR

IR NMEFEEAZTEMRE, NEFEREIEHRNES BRI,

Views Details
Name Run Staius Type Run Mode Start Time End Time Last Run Time = View Name
@ Bailer View "Libish Assal Onee 3 . W22 7:38 PM Boiler View
O Compressor Pubished Assel Once *8h . /AI22 7:30 PM View Accass @
L Adiiswator Owner
L Pt inuegrator Servh

+ Add
Data Access @
4 Administrators & Engineers

A Pl Integrator Service L Assit Analytics

Import ard Export

Delete

Remove Selected View

4. PATTINMEERME:
a. BEHEMERFEIFIK I MIIRPRITIER LUBER S RIRRINR,
b. BHARMIZBIRTIRUNEIEE S HIRRTGRNR.
c. EE—IEMAFEEHBE UBRSAIANIEETRRR,

EEZ MBI TRINR

BRI L —REFE ST AR FEEMNRMFAIRA,

IR TFRERINME T UEPBRENIFR, —RIEMN— PN IEFBEREHIRA,

EABERT, FmBAERHSHIMAKEIRTFIAEENR,

BISNERE ETMNEELSERASMNIRR. MEREZNESEtNE -4kt FREsET 5SHE MmN
B —#FaF AR, M2 EREEINRERMNR, f20, @AE ABC 7B T TRRMFMBIMRFRZHH
RIRBIR T I ERIRIE IR BEE A ABC S HMME —EEHE S, FRAMANESE RIS AR
W, XMIERT, S8 ABC I TRRMH MM ARBHEINENRIRE, BNRIENR, FiAH B T2
SRR S BRI EIAMA A ENR.

MR -ATREFELLET BEEEFITOIRAZT RMEMELEHFSREERTFLET R, P
Integrator Framework IR5> S EHERBRIMITELRET R, ERRE, T2ACLEERMIFLRET RER
AT R LEHTEHEAGELMSE. B, FELEEREIFELRET ABTEHEIE, MREXSHE
A5 BER 4, RILAF S EHT T EEX LA,
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EEES

. BEHREEMR E AEBRELERE,

1
2. BEMEETFR,
3. BREEEFEAMNEMEMZS,

Views Details
Name Run Status Type Run Mode Start Time End Time Last Run Time View Name
@ Boller View Publishec Assat Once at . 9/8/22 7:38 PM Multiple Views Selected
@A Publ 8 |

View Access ©

Data Access @
Multiple Views Selected

Import and Export

Delete

Remove Selected Views

4. FEREHRPRIRE T 2 & [ AE I B R i &3 48R,
FEMEFEEMAREMRE, WEFEREEHRRSHIRR,
5. FEARMBEHBIMRAEA P, BREERMSBIMAF R THEE.

AR NMEFENAERFEUZLMRE, WERXERBELRNR, #rI EEELINE"MIES
RHRIR,

R NEEZ S ALk 2R

HEERERLE, FERAMBIADPIZE Web Sockets, ZMUTEIERKR/NEH 64K HIFRFIl, EATF A HE
RN REBRAEEH THENESANSEMNEN ZEZMERNEES, £ ENOR TEmS, &
A L AMEEER E FIFEMEABM TN RS J/EAESH . XGEAT Microsoft Edge il ¥ 25,
HEEFENELRED, AEKEFAAEFCUENE, AEENHAEFRIEENREEREEENS
B REBRERSEIETREGE D, £A Pl Integrator for Business Analytics AJfEIX LR 15 2 [ 85 E, I+

HEM—1REHRSFHFA S AT EMRE D, A5 S HAE, thal LUFRE#ES H 20 EERE X4
&,

LUTEBRREMNE-—ITRETSHAEFFELSAZEZIRE,

1. iﬁ..ts*TZiﬁ\E, AEBRELEHE,
2. AEE'TEF, BHUABRTFR,
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EEES

“XN B T EFE R ERHY Pl Integrator for Business Analytics 55l s B B 1 B A 51 R .
3. ERESHMNUNBEHEESHAMEMNAE,

XHESHEITHRE R, BN UERGSHBERZIE R F, 5110 My Asset View.json, %1l
BaSHE—1 84 7 exportViews.json B34,

S HEOXEBHRN T LUMEZNRE (AMEEHRAESATINRE) FRIMBAEE,

EEZNRZE L, M Plintegrator for Business Analytics B R A RRFH R TEE,

ZEE TEP, REAEETF,

BHSAUA,

E4TH'EOS, ERESHOXEFEEITH,

“SAMBE'TMTEHIKERZUAE, MRESA—IMESHMUEXH, NSRIXEHIEHRE,

HTFEEFSRTR SANUNESELSINBEAFRIU, NRAEBAFHEA N TE, MEAFRSCRIEFL

ABEEHER BXETHS A ARITUTREMEEZ—SAZUE:

e 7£ C:\ProgramFiles\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config 1 & &
ViewnameAllowedSpecialCharacters FE, LB S ENHGRTHN, RAREHEIEMBRS . EEF
SAUE, LERTATRIE,

. ?ﬁ’r"?ﬂ%ﬁiiﬂﬁﬂﬂ“ﬂ&u%ﬂ ﬁﬂ%%ﬁuE‘.ﬁﬁBﬁﬁE, BB AEF UGB R
ER ATAREMELSRIENS A MFRAER, FSRUEZIFRIL,

© N o v &

Import Views
View Name AF Server AF Database Start Time End Time Publish Target Matches Autostart
E'r\*.-'erage Building || CAKPIAF v | & Facilities-16 v | & "Jh e Apache Kafl v | & 223
O fDaiI',' Temperature | OAKPIAF v | & [Facilities 16 * | & f’—Sh * Apache Kafl » | & 223
Weekly TemperatL| OAKPIAF v | & Facilities-16 v | & ':n - Apache Kafl v | & 223

PI Integrator for Business Analytics Jff%ii\fﬁ?ﬁﬁﬁ FEFE—1REDCIEINEA PIAF Server FIEIEEE
MBTEKENZRSFH/ABIEE, XEFRGEZE,
AR EEESAERZP uliﬁﬁﬁh\aﬁul ANEEFA EFEHMEH BERUMSNSARE,
9. JE#F PI AF Server, PI AF #EEEFI & 1 B 47
“ILER"HFERE N EHIEE Pl AF Server FIEHEE AR KB ETIHE,
10. (AM%E) B H BB, “FrIaet R F1“E AT FE LB gUX &1E,
11. (&) 2 EEIEITESATREETFirKHUE,
AR EBEEEIERIMREAITHAE,
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EEES

EAZLIMNEREB/NMEE, FATRE, EAVFILENFFIRET, st ANZRAER MMSE
BHR MREESAZSIMNE, BUEFHRERMITL

12. BEESANAEF LTS AFTEMAAE,

NESMMEREINRAKE. SATRE, MRERAT R, ENFILEFIRET FEATES
SRAYERERR, MMSERERS . BUETFHREXLEAEBEEIR,

13. HEMERRELFIVEE, EXSHERLT, ZRENBED,

@% H u_.\lﬂi

ERILM BB TEM B SRR RPEEERANEABREIER,
ERAILHRLU T ARTIR BE

o {FAFFIAN AR R E FER e E R ESEE
o FERABBHIIRERE—TIE
« HERRRXE(RH, ER.EE. H51%)

ERLUFE R BE & HI BT MR TR EI X+,

BcE Bi&EE

BEEEENLT —AZF BT RERTNNAEES Y, EXFREBSRH . FEFARMBHESK
B

IL.\/E..;ﬁ *"Jf]gég:

o Default(BAIA) : BEREREENHATHAERE
e Namespace (fifZ2H]) : HEILREEN A TIEEM 4 ZEE
* VIEW(?EI-.) E:ulﬂiﬁﬂﬁﬁ_ﬁﬁ?ﬁfﬁu,

AR RINBNEREBRSEEZENE 'lﬂ*ﬁj(i*#.l“ BEALYTH E’rﬁli%ﬁ:uﬁ?@%%ﬁﬁu
BRELT K, MMEWRRSEEEEHF SAXKESHEZEE,

yuﬁ'ﬁlﬁ%Elu/E., HE”%IE"ﬁEE"]EIMﬁIH‘FEE}G‘FﬂFEI,L\IE% jgi

1. BHENERTHBSEEEERY.

2. SMEIEEEE,

3. BEAMAEER.
o EHEBIEE NameSpace XM B ESEE, BEH A NameSpace LINFHZERE
o HEOUE View KEMAFEE, HM THIIIRDERAFHRE,

INFHEME R TUE R B &R~ P IR B ESEE
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EEES
1 Ji*% EIL:\/E:E FﬁquE’]Em»)E..o
2. EEBIBRBEETEE,
o flﬁﬂﬂ“l@;‘ﬁ;ﬁ(#%)alb\/ﬂ@o
ZRTER EFRAUTSHEERTER:
¥ R
g&ﬂ” 1§l§\s % _tj?.’f'a .BEO EﬁiAé&%Uﬂ‘j //1%[2‘\"0
=2 P B EXTEFEHER
RE LERMENFARENTEHER
IRER: 1B RTE ZEMRER
B ERMEFENMARENZTEHEE, FIR
BFRR% 10 MER BRIAMER B,
HERKE BRA&IE B, KT 100, BRIAME N TR H,
KB 1L F R E K

BREHAUEN, BEMSITRERREEFFREUTRIEE:

o BEHIBEIFMTE PlintegratorLogs SQL $IEEH,
FE: MREERTRRIERE, EZHTRA GMT B,
o ZITHURTFEMETE PlintegratorStats SQL #IFE P,

ME7E B R A0 HERS, X iERE G ARS8 LT £ 22, AL Pl Integrator for Business Analytics & 7 £A M &
BHEMS TSR, EFIRETE %PIHOME64%\Integrators\BA\CAST.UL.WindowsService.exe.config 3 {4 H &g
[

REXHPEE T EHEMERS, AFIREBEIERME TS RARE:

e <maintenanceTasks> &85>, FATFHAEM BRic FAI8TE . B M ES :logRetentionPolicies

statRetentionPolicies,

e <logRetentionPolicies> ¥l <statsRetentionPolicies> &84y, FiTHiE ZMIRAVIC R

BE&RE

EXERGRERBU—MRER BSHEELEERER
N FAFEFEC & XER maintenanceTasks 643 B4 logRetentionPolicies £ 55 R TE & H 510 XA BR AT ] , ZRIA
BRT, BEIERE 24 /DIRIBR— &, R L 7 s 1THIBR,
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TRNABTHESSH.
logRetentionPolicies {E55 3

Pl Integrator for Business Analytics
EEES

ZH e 61:pU EIAE
taskName FIERRBESHEH,EY |add
T E taskName="logRetentionPolicies"
runfrequency logRetentionPolicies {E553iT4THIM | runfrequency="24hours"
., {5 P BB 5 5E B 8] 4L
runFrequency ¥ timeOfDay £ [g]
RIEE RS R E,
timeOfDay iB1T logRetentionPolicies {E55 /Y | timeOfDay="7:00"
BY 8], 52 R PI B (B 45 XE A [B) 2
3L, runFrequency #0 timeOfDay
[BIRRE & SERE S RIS E ,
A &R E RS

logRetentionPolicies &} 73 B SR B& R FE & (a1 B i B B B2 % EMIBR R Bt R & ARIE R,

IR R IR MIBR, MERHRE BEILR,

A LMRIE T HEEH S HIBR B &I H:

o IERMRERK
o ER¥E
o FTAIBRKHIER/D

AR EMEERA T A LR EFILR, REMISRKHENR 100,000 THED, BFIEEKHMRAK/NMA

1000 MB BB /N,

EE ST RIRIRBRAECBBR R EMILRE, ZREESTRIEERT B R /IMEELUGR/DEK,

logRetentionPolicies K& S #

- S Mt Bk

uniquePolicyName RERHI R Fh o uniquePolicyName="LogsPolicy1"

maximumTableRecordAge BEIEEZHWEXREZNE, LA | maximumTableRecordAge="2mont
BN ELIETE. 5 hs

maximumTableRowCount 1
maximumTableSizeOnDisk BEL & {#

A, L E Zm kR8I B Fid %,

maximumTableRowCount

HEHENERITH. &

maximumTableRowCount="100000
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EEES

g tpul

=RIAE

maximumTableRecordAge #1
maximumTableSizeOnDisk B & {#

A, U EZR kR8I B FiL %,

n

maximumTableSizeOnDisk

FTEBEIEFRMERERAR/D, LIk
FT(MB) NRLIIEE. 5
maximumTableRecordAge ¥
maximumTableRowCount BE & {#

A, UHAEZEM R B EiER,

maximumTableSizeOnDisk="1000"

SITEERRBERE

SIHERRERBES

BNMBEMSITHE R HEN BRI PlintegratorStats SQL HIEEF , KA N UHE D,

B FAFEFER & SUHB maintenanceTasks 43 1 B4 statRetentionPolicies {£55 R E & S it i FAIMIBRAETE . T
RINABT statRetentionPolicies IEZ S,

statRetentionPolicies {5554

g

g tpul

2RIAE

taskName

RRSIHE RRBESHAT.
B EHULE,

taskName="statRetentionPolicies"

runFrequency

51T statRetentionPolicies {E55HY

S, {5 A Pl B [A] 45 7E B () &2
3L, runFrequency ¥ timeOfDay
BURE & TITESHIETE,

runFrequency="24hours"

timeOfDay

3L 1T statRetentionPolicies {5/

B[], 35 A PI B [E) 45 RE B () 82
3L, runFrequency ¥ timeOfDay +&

RIRE & BITES RN E L,

timeOfDay="7:00"

BNERT B @4/t MIBRE T2 R,

SitE RRBEER

statRetentionPolicies B 73 B SR B& R TE & o] B I BR 45 it i % e itiE

BR BRI RIR R T L 89 e 8] 8 B

R, FERHBMERE T ERBRIICK BE, AERHEERAE ERMEITHERMS, GusfFEl
MEHBBRIC R, BFAE. FHABRMITLRERAREZ ML,
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EEES

R M REERMA MR EARABTRUEERBRRERS, Bt 3 TEXERREE RIS E

=, Pl Integrator for Business Analytics {ER 1% 31X L4 B B S3E T 4% Har LUR |l

REm BSR4, B 30 #PRYEIFR.

Y, B8 30 D RAMEMKERTAREMRMREANE,

FE: R —XRHUBEMNSITHERESTRIRE, EEZAREBE,

EUAE BRI TATR:

e StatsPolicyl — FE X BIRBEERTLL 1 3] 5 4N E R AR

e StatsPolicy? — T X HIRBGERAF L 5 28U LRI 1 /DRI E R I E
e StatsPolicy3 — 7 X HIZRB&E AT LL 1 /et A L BO3IER & 9L

A LR RNAKES, Al L2 KRB IEE BT EMRRRI . REGHER R EEM A RN
B (B B R, ANRREEEAaFE B, U LLZEREERAHHAEMSITHERRTRARE.
XNF K, ERAILURETIEEA SHIFRINEAICR:

s BRAEXRTHRENK
o RPMIZEEH
o REIJE K/

TENET statRetentionPolicies FEAES 3, FFIH T H b — R StatsPolicyl FIZRIAE,

statRetentionPolicies KRB S

B S StatsPolicyl FIERIAE
uniquePolicyName ERREIZ TR, BTN AME— | uniquePolicyName="StatsPolicy1"

MRFESITRARKRE, BEEX
HRTEITHREIRER.

filterMinimumRunFrequency

UEERIMENTR, &5
filterMaximumRunFrequency EC &
5, LAHATE It SR RE A& R a9
o

filterMinimumRunFrequency="1sec
ond"

filterMaximumRunFrequency

NEEMMEMLR, 5
filterMinimumRunFrequency B2 &
R, LUFATE L RAE AT SE A aIA
o

filterMaximumRunFrequency="5mi
nutes"

maximumTableRecordAge

REntERAMIEZME, 5
maximumTableRowCount 1
maximumTableSizeOnDisk Be & {&

A, LEE Zm FRaiE %,

maximumTableRecordAge="24hrs"

maximumTableRowCount

KRPRBIFKITH METH

maximumTableRowCount="100000

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.

Page 78



'AV EVA\TM Pl Integrator for Business Analytics

EEES

S SR StatsPolicyl FIEKIAE

1

Bt E, FEmRERSE R
xEMIER. 5
maximumTableRecordAge #1
maximumTableSizeOnDisk B & {#

A, e EZERFRAIIE R,

maximumTableSizeOnDisk REIRRK/, LIJKFT (MB) 3 | maximumTableSizeOnDisk="200"
Bz, M BRR B R A RARID
o &

maximumTableRecordAgemaximu
mTableRecordAge #1
maximumTableRowCount B2 & {#

A, LEEZER FRe9IE R,

TENET StatsPolicyl K EERIAE, StatsPolicyl FESEATLL 1 L EIFK 5 Y HHELZAMNAR, XF
BOUE, RERAN 24 /MHHSITESR, MERPHITHREF 100,000, &2 XK/NTFET 200 MB, F
RAEX=AEKHRICZIEM R, X FRAEERERE, HEBRAZNBERZAMIER,

TR SUTRSIRIBREIBBAE IR EMIERE, ZRMEESEIEENT B /MR LG /NE KN,

ﬂrjliﬁﬂﬂuw

“ERTE LT AN FRE T LS E5REREXMNER, MATHANG L RAE U R LR ERXL
LT b

B TR AR BARSNENE DS HA Pl tag (BUEIRIER)  AME—HIER BRE— 1T EHZANUE G
R IREE Pl tag.

BEARMBRES T RISCRE T — AT LR A M — W R RREE

5130, {iR1% Pl Integrator for Business Analytics B2 & A =1 #LHE : ProcLabl. TestPrd # Fieldoutput, ProcLabl {#
FH 20 DR (15 N ME— SR, 5 N IEME— S TR) . TestPrd (R NME— I H 7, Fieldoutput £ 22
TR (2 /I\I]E WHR 20 N EME—HIEHR) . RMBEERNEHRIRERTZAUEDENNE/R
AR Es, HERTHELT:

o GHIEMM—RERET 19 MR,
s MRBMHERERATAMERNAT, TARLEHEATTRIERFHMEKRE,

1@ hnw] R 7R

MERERHIBERRUREENER, ATUAREZRKEEFSHIRAR, XA AMNRRXEHRITHNE
Z(ER, iE&I OSlsoft BRF KR,
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EEES

ik 8 R

MEMBRIE bk § W RN —EHEMNH —aH R LR THAE, T “HOUR TEEBRENIE
FHAESI BT EHITEMITFRIBRHIFT IS — R R E, BREX—RRBEE, £BRIM RN E 6T,
W—HRHRASMERE  ENS B LERER Pltag PRIEIER 7 XEIKRE .

REPIRS = B3R & HiHH7 . 7E Pl Integrator for Business Analytics NFAESI EFRITERIRE, EEE 24
INFPBIT—RIERS . Bitt, TEFEFIAEMREMEARRE, RAIFEEENRESEXREIIRE — X,

B Windows RStk

7] LA B 1T Pl Integrator for Business Analytics BIARSS K 7, #& 0T LIFERE Window ARSIk . AIEE RS
ik 7 (gMSA) Bk Windows EE MK . SN R E B R E| gMSA Bk = SR EE #AK =, BRAM gMSA ik /= 5 &R #l ik 7 B 2k
B|H Ak, HEELUTILR:

o MEEMEF salL FAWIER Windows ARSTIK BB gMSA Bk 7 S EEBLIK =, gMSA 1K P 2R Atk
F s A Windows SRR UEFTFEE Pl Integrator for Business Analytics B9fF 3 SQL Server ¥ 1T & 155
iE, EXREERE N FEMA saL FA KL,

o HNRZEM gMSA K7 S E K 7 EEER BI HAthdK 7, SEHRE gMsA 1k P SEELLIK S, MFEERK SIS,
BEENBIRMENEFTRARRE.
WiFSRMAF KPS SUE T ERRS K SATENAFKF 2EEFUTR:

o I Plintegrator for Business Analytics B Microsoft Windows Server B ith & I8 53 iR
o FXET Plintegrator for Business Analytics B2 & $0iE BB PI AF Server RIS IR 5 AR

;& : PIAF Server B9PRRLF %PIHOME6G4%\Integrators\BA\CAST.UL.WindowsService.exe 3 {4-#
<appSettings> &5 Hh, B{KE LN InstancePath,

BERMAFKS ST BERRSKSXATEMNAFKSEEFTEZEERUTRIR:

e SQL Server LA ALTER ANY LOGIN #X[E

e PlintegratorDB. PlintegratorLogs # PlintegratorStats 2{3EEE Y db_owner BUEFE A B L R RE
FE X ME RN —— S RIS EEFEA saL SARIEF E AEER saL ik XA A E B XL
5} HIRBR .
MBRERFRE sQL HITFEEMLENR, N EHF sysadmin BRI 28 %551T Go.Bat X, iZX
{441 F %PIHOMEG64%\Integrators\BA\SQL,
MREEAEMERA saL BRKRIEHF B AR sQL K/, MAFETITIX L,

o F7# Windows ARSI P A # 1R T 1E N IRF B R/ BR, FHETER LA Pl Integrator for Business
Analytics BT B #l LS54T Pl Integrator Framework fRS5 . B4 &1 [ B R A A 7 ol LUF LR 2 BL 44 AR
S, PITIL D BT E MR RIGTT EVIRERENHERAMN AR F.
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EEES

#1 Windows RS K PR FEE R RMELE X, FERAFRSIKS ER, EXE T Plintegrator for
Business Analytics B4 Microsoft Windows Server 8|32 E2 & 324,

TESERILIRERE, RERITUTER,

4.

INREMEF saL FHKIER Windows ARSTIK 7 BN gMSA Ik SR UMK, gMSA ik /= SRR UK
F a8 A Windows SR UEXSEE Pl Integrator for Business Analytics B3 SQL Server # 1T & {7 %
iE, EXEEERE N ERA saL FARWIE,

INSREM gMSA 1tk 7 2R Lk - Bk B H Atk =, S E gMsA ik SRS, MERE KT /E,
REENETRMEFRETRAERE,

M %PIHOMEG64%\Integrators\BA H 3k LIEHE A & {735 1T ChangelntegratorServiceAccount.exe X {4
R IR R TIREF IR M BIE 1T Pl Integrator Framework ARS Bk F BZ543

AR B ASTIR B Y AEAT Plintegrator Framework ARSS BIAR S Tk - B Z 18 F RE R RS 1K P
IR MK 9 gMSA Bk PSR ELIK P, MR 2D H BOL LD IR,

BIF IR T TR EF IR LSBT Pl Integrator for Business Analytics ARS8 ETARSS Bk 7 B9 AR S5 bk 7 #0125
B,

BRI RA T ESFHK S RERRARINE] Pl AF #1 sQL Server,

FECINEHFARS SR gMsA 1K, MIRHARSS 1K B2 FFH B TR ED . ERIK P THRS K
BIHED,

% Enter RHIZXAT R,

ANSRZEM gMSA i P2 B BRI P SN EAtL MK 7, SRR EN gMSA IR R BUIK P, BIRFENEHEAN
RTHBREFRARE.

B X Pl Integrator im O

EA DX Pl Integrator ¥ A B, & 3% F Pl Integrator for Business Analytics Web M2 FHERIAF A EEEHA
A#rim O 8 URL, B8t B B S5 4T B4R faT 9 B ER 4 RO SE o

1.
2.

7£ Microsoft ¥ HIE MRS, B EFEFFITHEE",

5| R DA E T Pl Integrator for Business Analytics, XFETEEPHER,
“P| Integrator for Business Analytics 2020 & 3£” &5 O BEEN$T FF,

BHER AERET—5,

FE&EFEBR'EBOD, % ASE1T Pl Integrator Framework ARS B9 Windows fRSStk PRI F 2 &R, £
HTF—%,

FEURAFMSSLIEPERE EOHR, MAR—MRAS, REEERIEmRmO RIS A& Ak,
BHT—H,
A NRAEFERERAUE BEOP, PHRE,
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EEES

RESTRE, ZNARFERHmO,

B SSLiFPEE

1. 7E Microsoft ¥ HIEmARF, X IR EFEFFITIEE",

2. FEHIFRDAEEE PIIntegrator for Business Analytics, AF 8 H 52 M ER,
“P| Integrator for Business Analytics &4 8 OKEENFTIF,

3. BT ARREET—F.

4, FEFER'BOB, I ASEIT Pl Integrator Framework RS B Windows fRE 1k PRI F 2 MZ08, £
HF—

5. AR SSLIERHEE"EHH, MTbERIERE—1 SSLIEH:
s RELUBTAERMBERIULES - EANKARE, EFBLRKILES,

EE NBEEBXANED, B MERITENERMEAFTRSEE—FREHEEHR, R TH
RELLIEBHIMZS, EBATNERFHITEY LBAHZE, SR EIREXE Certificate

error returned when navigating to a Pl Vision or P| Web APl web site using a self-signed certificate (Zj{&
FRABEZLIEBSHME P Vision BX PI Web API Web i s B R [E]1E $451R) hBRR A X,
o (MEFE)IEPMAEMNMMA R SSLIUEH — £F § AL I 82 HEFIEH LUERE N IEH AR AN
RENEBFHFES AFIRE Pl Integrator for Business Analytics BT & #l,
6. BEHT—
7. B NAREFBRARREA BEOR RERE,
REFTAHE, ZNAEFERHR SSLIEH,
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FREFpHERE

A FFRIEHE R A

Int16

Pl Integrator for Business Analytics £ LA F &R T A3 Int16 $ER T

o {# Parquet 88X 5 A FI| AWS S3 B Azure Data Lake Gen 2 BFRRIBIR T E4E RN Intle BUEL .
o RAMEME(ITAL B ARAY Avro FEMEBUE A EE(E R Intle BB R,

XFIESR T, Plintegrator for Business Analytics & B3I {% Int16 B IR A Integer FHIEALEY,
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FF iR,

Analytlcs

Pl Integrator for Business Analytics
FF45{% FH Pl Integrator for Business Analytics

Pl Integrator for Business

1. FTFF Web 3% 25,

2. %A Pl Integrator for Business Analytics S FHF2 B4 URL,
Lt URL 5[] Pl Integrator for Business Analytics FIE#LF0%5H O . URL A https://hostname:port number B,
FQDN:port number, £ FQDN NE2REMIE A . INRFEHAIHO 443, £ URL B /] LLZ Btk O

5, MR A prod.onet.com BIERH lab5 L&REE T Pl Integrator for Business Analytics, F{FHEE N
FAIwmA 7777, )”\'Jﬁ.rlélﬁ]\u-ltﬁfé—lﬁ:https//lab5.prod.onet.com:7777\ https://lab5:7777,

FE MR ETRHEERL Pl integrator for Business Analytics BY#ETE TN RO, B SMEIRET PI
Integrator for Business Analytics BT E 4, T %PIHOME64%\Integrators\BA\
CAST.UL.SelfHost.exe.config 3044 3% El| "SelfHostPort" S8 HI{E , &5 1&#Y Pl Integrator for Business

Analytics R E

T8 5 Bk R LIFREX URL,

M ARRFTH,

B R B RE TE.

3. BExEERR E LIFTFF Pl Integrator for Business Analytics 38,
LIT B FEEN4TFF
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Advanced Edition

™ My Views

Manage your data views

% Create Asset View

Build a data view starting with
your asset hierarchy

"4 Create Event View

Build a data view starting with
your event frame hierarchy

% Create Streaming View

Build a streaming view with a
custom output shape

/ Administration

Manage servers, users, and
targets

BRI LM ARRFHEEMEITFF LR R FMITLU T84

Pl Integrator for Business Analytics
FF4R{%E R Pl Integrator for Business Analytics

o SHME“BRMAAETE - AXRUAR THEHNESZER, BSR HHIE THE,
o BIRAFUE - AXUBEFARMNESER FSREESUE,
c SIREHUE - AXUEEHUEMNESER FERESAIE,

o BIEFREHMUE —AXEREHIBENEZER,
Business Analytics = kR i2 L Lt ThEE

B0 EREHUE, Pl Integrator for

 SMEEE'NE - AXAMNZTERTHESHESZER FSREEES,
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“H M A" T E

E:4: 0F Rl

¥ A Pl Integrator for Business Analytics B URL 2 f5, MR ITH, SR EHWUER" N E, MiZITEa Ll
BMmERSUE. FHARMRERNIE, ﬁﬁﬁﬂthﬁﬁﬁﬁ@REMaIMW§'Fﬁ%ﬁ%
BEEMRENATHEXAE LR INEERZTEMER,

+ Create Asset View =+ Create Event View +C.'Dﬂl!5\r!a1l1gvir\‘0 & Modity View @ * Remave View @
e | = ) ) D

Hame Run Status Type Run Mode A Start Time T @ Last Run Time
27 {

& Fin Column Apr 15, 20
"8h A I Apr 15,

uilding Temperature Streaming Streaming Out Scheduled Stream
- oyt
EEning 16% Assel

. o Autosize This Column

Building HVAC Streaming Streaming Cut Scheduied Stream Autosize AN Columns Apr 15, 2018 10:27:00 P
Daily Temperature Published Assel Oonce *8h s Apr 15, 201

Floor One Temperature Scheduled Asset o Continuous *-8h Apr 15, 201

Floor Three Published Assel J Once “8h Apr 15,

Floor Three AVAC Scheduled Asset *-8h Columns. Apr 15, 20

Floor Ty e umws ] = = -

1007 Twi Temperature Pubisning34%  JEEECE -8n ApF 15, 201
Weekly Temperature Stopped By Lise: Asset Continuous ~-8h o Apr 15, 201

e . 2

Security View Configuration Statistics
Run Status Publishing 16% Publish Actions Search Shape
m‘? Asset Shape
4 @ vavee
Pl AF Database “ # % cooling
Publish Target SOL Server %
Run Mode Continwous
Run Frequency 1 Minutes
Last Run Time Apr 15,2018 10:27:44 PM

#r sk

1 BB HE NIRRT E U REIIELR S, REtdR
EuﬁﬁgkﬁMWEMMlouﬂuﬂLﬁﬁ&
AR R EMEIAR, REREIZEIAR,

2 ﬁmﬂEﬁFMHML—AaFuH EXEZIE
B, BESRER~IE,

3 ﬁﬁ@]ﬁ%#?ﬂﬁﬂﬁ—’\iﬁ?\mo BEXEZE
R BRI EEHUAE,

4 FARBERERABGEZE— I RERIER, BEXE
ZIER, BSH6IERZBUE, Pl Integrator for
Business Analytics = iR 4L b I EE,

5 EERENNE, FMRPIEFZAEF 2 TER
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“H A T

#r ik
e,
6 EMERENNE, FMERAPIEZRZNEF 2 EHER

B I PRALE S = MR B RO B 2 FR 5 R P RS BR
ZAERT FIE BBRAEREE 7 XEY
SR MOVF AT UESE VR AR B9 RT A B HH T

EXEZER BSRAME LR,

7 BHfgrE LR, B, 2. IEEBEENS
THEREMRAI LT H X AL EMIFMAEE M
o

8 MNFEENOAE, #hit, BE. *&t. MEEEM
SIHEREMRIZH T EZMBE XMW TR IFHAIE
IS

o HLRIEEAMBRERE R, IZIEM K& CET
R TRER, GNFTFA/ PIAF 2IEE. A
B B RSEITR B LA R AR RO IR, IR iZ A A
LEIEELEM, BLBITRSERERHE, &
AILLUEEREIE R,

o BEERFEMBAIER, Eal LIFEIFIAM
sERmptiEl, R LIEHEE, LEREREMH™
BEMER(INEEEIR)MER,
AEATHEVPAREER BETHERFINE
% 100,000 17, MAZE B ER K8 R FFIE Rt
B AL RATE, MRFEEBIEER, ATLUM
SQL #IEETR RIZAE.

o REMEREANBEIHRZUE; NEFEHH
PR, & el A SR iA B RE A .

e MEEEMAMRTHR, AFNERFHTE
MEE. RTFaRNBEELURERITIEIEZM
FHER,

e ZIHERETREUBEMNAITER. AEXES
ER, BSREESITEE,

9 BREREIREH, BRREEE = FeHix

BIFRTH R %, EtFE S, ATLUFERSIK/D, X35
R SRR ATHES, AR BRR PRSI,
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“H A T

sk

10

ELEARTHIEERITHERRER P
Integrator for Business Analytics AT i XA ZEF4E
RHBMBE, L HZBRATLITIHFERIIR, £
T RIRINE MG S, ERAEHR/BCHERAZRE
XAMITHER . REX/REFATEH MRS
ZREMHVER . REXFHREEREBERHINE
R BREFETHE—R RAERERERY, &8
BRRISMERS R PHRTEER,

Suppress Alerts Aggregation: Off Clear a
A critical error has occurred, see the 3
event log for further details.

92225, 151224 PM Details

[ |

11

BHE LANERERR H LIEE Pl Integrator for
Business Analytics ¥ PI AF Server BIRRA, FEHE
EMREFIRE,
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Bn{al{sE A Pl Integrator for Business Analytics

an{al{E A Pl Integrator for Business
Analytics

Pl Integrator for Business Analytics {2t T — " E 2 S FH# Web AP R, T EMRERIFCE R ~UWE. £
EEHURMRREARUE,; LRESXUNE. EFUBRNRFIAE,

Pl Integrator for Business Analytics fil &

ME LA Pl System HIFEE Lk, NAA SFHER AFNE . SHABNAEHNE, &
EERANAETAEHENEBREEHECHERRFIER. THNE T I0EH AR AR AT
AR R,
o AP PEARIE A A QIR S B RIE A 2 E TR LR,
B, BREBHHF—AKERHURREH, REREARNESH AXEELR. CAUET
DAKEHE. BN BEE ORI TRERE— A IE , XA U Bx — AR
SREALBERE,
. BHMEBRESHERAAKIEH B TEBHERTREHER,

;£%&.: Pl Integrator for Business Analytics fGR [E] X IR A ER (BEF B RN FFRILERTE) , EXE
RIIT S HIESEUE,

F# LU 6), BRIREEEFRIVARAKEHEE, S U - EHAEAULRENFE
BE, FRERSH EREREREFNNEEHERIEFEEMRL,

o AR EIRYE H KA QKR I B T UL T S A (8 AL BUR LU AT TR 4R .
#e FEATRA, RIREEERE SFTEETNRE—/NHETRREEHAE DR EFLLE
B-1EaRE, ESEEMSIDARAAERHHNREHAE, FRALBTFEINGE-—ITMEFXERA
TR BB, 0 HE RO AT AR Y

HoEgfiIk?

B ERARIRIITHE, R Pl System FERHIEN—MRNX, BRERETINEZNEEXER
E"J1§l§\i

o TAEMLEHRE
s BFEAENEFHARSA

PRI T —MIiFRDhEE, U RTRNEEZ B X RUREBRERTRINEEARE, HT Plintegrator
for Business Analytics, ERAILUIE LR R, FRURENZHHNX R, XEAZRIKH—E D BRI UENE
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NEGHIER ., BRI RS BETLUT BRK, LERNERTR—ERHE~REHEREK
PUEL,

BRI N — N EMEE

s BEMREERTARTMNAES . BHEMEEXSR,

o MEBMMAFRNIEAXMER, HRRITHFPHONEESTHER B AEUARBEXER, e
AELEME-EXNERXE TR,

s EHMRESEHABRPNEMHER. FHEREN. SIAMNTRULSIANTRENX.

WEk - an{ 55 FE Pl Integrator for Business Analytics

Ak e 1% B8 T A0A] {5 A PI Integrator for Business Analytics 71 Bl TE & gl R R L& U,

EE MBI E—REM Pl Integrator for Business Analytics, A% OSIsoft B IR 5% T iR an{a I 2 E =
B RAeHEERENREEHIE,

1. EFRE ST Pl System EHE,
BESMFEFEARTUE. SHUBRERRERNE, MRFESITIRR= AR, BRIER™
B, MEFEREHEESITHIE, BESHUE. MREESMRASTAIOEKE, FEFTEX
ERITRAARMURITEN TR EM— L4, BoIERERAR,
o HRFEUE - MOIE— R TFIE, FII0, EHENEP, f<csid="25741">“PLE"</cs>BE &
o a] LATSE M PIAF 8RN 5 GRS IRB L BEL R TR
o EHUE-EMOUIBE—NEEMBEHRKTFE, Fl0, XEENEHEEURZEHIERSIRAM—
Pk, ARFRRFNTRESE AEHHIERHBES ET X, <csid="25741">“LE"</cs>E &
JHERER S IR BRI R ™= BHEMEBHESE.
o REMUME - MBIE—NREEMNRRIFIR, Hlin, EFLEANEF, fE<csid="25741">“LHE"</cs>H
AR AT ST M PIAF $UEEH R SRR IRE R TR,
2. MHIES,
MEPFERESMNFE. ZFETIFEI T EEREURSNEERMET 100 MMEFK, AL, EAIEESR
BIFR A TREARIE . TR A B M T LB SR LR BURRSEEH, XA EHLA] LUR TE B iR MNP LE B AN %K
FELURMH ET XX, LIRANAHERR— AT LUEE IR W E R A BL B BIE L,
3. ((NBRFRRRMME) 15 E AT REE SR LB anfal it & H S,
4. RAEBUIRE.
EALERTZREVNARIBERLNBIBERLEVNMENE R, BRILHITUTIRME:
o EWEIES/BIEFEMERAK
o RINEIES/BUETF R
o RhNEE 5 /6 (8 F B
o HEIIFFEFPFMITE
o WIBHE, LR A E BRI IR
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o EBEHIEMRREAXCLE. BERBEHE)
FE:JERATRSNE4NE, FEREATRERAE,
5. FEIERAEKAE IR,
BiEa L — MR, LAl LRI RIR .
6. TEIRRITAY Bl TEHEFHIE,

AXENFANSRER, BSRTRAS:

. BIREFWE
. BIBREHTE
. BIRFEANE

USESE I oahs

M E 2 FREAE ST Pl Integrator B2 /ME8/ S AXFIE, RFFERAFTE Unicode FMIEPRAMILFR, EXR
W EAREEERF T, EFEET Plintegrator BEFEMIEME AR Z2M, BRIEAFZRBHHE AT,

MEAFBMANAERMEY, XAEFLULBRHETR, FER—FHRER, BHZABBHER. &
ER R ER T eI/ Ed/S AN EE,

AP A LRRUT S REZBIA LA F RIS

1. EXHYREEFPITIF C:\Program Files\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config 3 {4,
2. {8tk ViewnameAllowedSpecialCharacters {8 LA & 455 F FF .
pign, MREMBAFPER '@ "K', WEFH "@!".
BT XML BIIER, EERBFH (0 ") FEELFS, 60, & MERK "&amp;",
3. EFEIEMFES.
4, WMAFHIERFTR, BTFIERT ViewnameAllowedSpecialCharacters, & M iZ @33 BHiE

ForceCreateTable

ForceCreateTable THRER F 5 &I €12 5 sqL B ¥R (SQL. Azure SQL. Oracle, AWS Redshift. HANA) 5 Bx i) 3 &b
R, IR Pl Integrator ZEYFE LM B LHRABIIME R, NEF| B KK, ForceCreateTable R 22MAFRT
A5 saL BRXBRINEE X AR,

E{LF C:\ProgramFiles\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config,

LR EE ForceCreateTable THRE, BHIA

<add key="ForceCreateTable" value="false" />

EECBIAE R false, MR A F 1 ForceCreateTable IR E A true, MFEFK AR5 Z M B X M ARIBRES, PI
Integrator I —PMNEH AR,
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2R~

MEFREMTIRATASHEIE, FRIRATAE, MEFEREHEEINRIE BSRUEZ=HIE,
MRESTRAF A FEAFTENERTREBLURITRNITHEM— Lo, FSRLER
RS

1. iﬁﬁiﬁ\g, REBEGERESUE,

2. MAMEA,
AR ETHARFRAAIMEIRMGRNE, MEFARER, FSRUE LB R L

3. INEREMAF KB4 2 N B A Pl iIntegrator for Business Analytics 177 [/ #X R4 PI AF H {34512, N
B HUBEMAE T RFEREERFURERFRNEN S HIRR,

IR RE A ik AN BRET R — 4 PI AF BRFRIR, ZFHIRIREHIZF Pl Integrator for Business
Analytics B RN ER, % &R FRRT B3 2 EEZME.

BRUENEN, BRER— PIAF SRR T IHRRE, EHEFILURES PIAF SHRIRERT
WRMRR, ARFAES, FSRARTAE,

4. BEHAIBUHE,
5. EIRAEFERS, BEAEHRK,
RREALUETMNE—THESAERK, LERIERENMRK,
6. ¥ FAARSS SR FNEE BE R EX S50 ST 2 AT 5 # P AF Server FIEUERE
AR MRFAETNARFENLZLMHRE, GFI—1Z2Y, ATESEZUEERIEIE LR 5
FRiR,
7. MT4AEY PIAF R LIER B/ E R HRIE
8. FR&TIERIN AR B,
R R BRI B
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Select Data > Modify View » Publish

@ Source Assets T Search Shape + Matches
T Asset Shape

Server CAST-INT-CL v
Database Datacenter Demo oo
Q) Assets
G—\_lto drop and place
4 @ Data Centers Q) Colol

4 [ Americas

4 [ Atianta
| » @ Colot —_— |

» D Colo2

» D Colo3

» D Chicago

Attributes | % |

0O select Al

4 ColoNumber

4 Zonel.Capacity

& Zonel.CapacityPercent
& ZonelDCIE

& ZonelPUE

& ZonelPWR

e oo oeCcc0C

& Zonel.RollingCost

4

B ERINE R RAR B,

BERFZE, ‘B ERFTH EPETEETRIEL,
9. EREVETEMIKNPHEL,

ARG U EERITHF . 2 AR,

ERBIREDRERMERE
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Select Data > Modify View > Publish

Ea Source Assets T Search Shape + Matches
Server CASTANT-CL v T_Asset Shape Found 5 Matches
Database Datacenter Demo [ 6 colet 'I\ W @ ol
@ Colot
Assets
@ @ Colot

4 Data Centers
@) Data @ colof
Q\_lto drop and place

4 [ Americas
& Zonel.Capacity @ Colol

4 [ Atlanta

| » @ Colol

» [ Colo2

» @ Colo3

» @ Chicago

P+ S

Attributes ‘

O select Al

4 ColoNumber

‘ & Zonel.Capacity

& ZonelCapacityPercent
& ZonelDCIE
& ZonelPUE
& ZonelPWR

eocoo

# ZonelRollingCost

-

R NRBEMTNRERI A= RBINH 24, 2ETEEEIREXAMIERT. ZTtREB
AMEB BB EME., ZREAE AT MPRIFEE PAFHPEEMX R MRFEFEEENX
BIRLE, AR HERMUAIESE.

FE BRI LFZNERER AR M, LR RER—PTERETR, 5ISBFZE~RMIR
. FRIBRERK, HIRETREIEEFXNRER DS PIAF RRENFEEHEE.

EE T ek a2 S

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 94



'AV EVA\TM Pl Integrator for Business Analytics

Bn{al{sE A Pl Integrator for Business Analytics

Select Data » Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTANT-CL v ToAsset Shape Found 5 Matches
Database Datacenter Demo oo 4 anitz;—ga\ert 7 % @ coo
b i Canacih P » @ Colot
[ Assets ;x » & coor
A @ Data Centers ;% . @ ot
A 8 Americas ; x . @ ot
| 4 e Atlanta .
» @ Colot
» @ Colo2
» [ Colo3
» D Chicago
» Ef) Houston
> @ MNew York

3 @ San Leandro

10. JHERMEAME=FEMAER B E TR ER,
“PLEC B R BRI R 5 E XKL E R TTR,
11. EEFHAZHERE PIAF ERAFAE R HKE, FHATUTIRE:

a. BERFEHMEE ¢ LUTFREITEE X EE,
b. ERRER LT E AE,

C. BIERFTHR S I S R,

L B B RS T 2 B ASAR RO R RO
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@ Source Assets T Search Shape ' Matches
. CASTINTCL . T Asset Shape Found 16 Matches
Database Datacenter Demo (s 4 4 @ ColoTemplate 4 % > @coor
& Zonel.Capacity a » @ Colot
@ Assets
& Zonel.CapacityPercent PR . » @ Colot
4 @ Data Centers @ Zonel PUR * % @ Colof
4 @ Americas & ZonelRollingCost " % > @ Colot
4 [ Atlanta » @ Colo2
» ) Colot » @ Colo2
» & Colo2 » @ Colo2
» [ Colo3 » @ Colo2
4 [ chicago » @ Colo2
» ) Colol » @ Colo3
» ) Colo2 » @ Colo3
» @ Colo3 » @ Coloz
» B Houston » @ Colo3
» B New York » @ Colo2
» @ san Leandro » @ Colod

12. EEREATRBEESEMBLAS LR, FHRITUTRME:

2 BEFBEMEMSZLN ¢ .
b. FERENIEEE W EIED, P AEE £ AIE, RSB EE.

B, BE-—THARRE T —#IRE, [BRREFNFRREHELBEARTR, Bo G A
ALE R PR

Edit Filters

# Attribute Name

Zonel.RollingCost

Attribute Category

Cost v

(+) Add Filter

¥ Opticnal Attribute e

13. BHET-HURMKKIEFE.
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M PI AF 20 4R BESR B AR 10 M ECEZAYET 100 TEURRE R~E XK,
14. BERILER, SR LUAMESHIE. B4 TR EREFTREMREZEAR,
AXEZER BSREREFMEGNERHETE,

3£ & : T Pl Integrator for Business Analytics 4R J3 fi2 4K R #4810 ML EDUE 7R AT 100 17, EUL&ELUF
TIEFIRE N PRI IR, XFPER T, BMEGREEMUERS~ETRED, TELthAESERERH

-
15. ia-:l-l:_"lfo
E Asset View 1

Select Data > Modify View » Publish

Target Configuration Summary

S50L Server ¥ Shape and Matches

* There are 16 Matching Instances
* Run Once
Timeframe and Interval
Run on a Schedule
« Your Start Time is *-Bh

= Your End Time is *
= “Your Time Interval gets an interpolated
measurement Every 1 minute

16. MB#RECESIRF, EE— 1B,

17. BHBT—REEBAE—R, SHEETHRITRET U AR HEEHNEIRE £,
AR AXNARGAENESER BSREIARIE,

18. BEHKRM.

SRt =

1. BEHZIILHTHIIFMAERER.
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® Column Details

Name

Flow Rate
N

Data Content

Value

Column Offset

Data Type
Single

Remove Column

Apply Changes

2. HIRBEFERP, A+ S - SHENTFEMI LBHTBREI REFARE, JHOE—TRRE—1T
HI4R =1 22 ME,
3. ERZERTNAER,

ke eSS

INRFERFHERESTRIE, BOEEHIE, MRFESTRERSTHFIVEE BSRCEZESN
B, MRENTZRAF AR HEE FEFENERTRER AT TR EM— LS4, BESE

BREmUE,
;& PlIntegrator for Business Analytics fGR [B] % BB HIER (BEF B MM FFIRFNLERAITE) , EXELRM
ITHHIEHIEE SR,

1. BEZESEERR E ReBEEToEE4ME,
2. WAMBERTR,
AE ETHAERAMIMBESHGREAT. AXEZER, BSRUNEL B FLH,
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10.

11.

12.

13.
14.

Bn{al{sE A Pl Integrator for Business Analytics

IR RE P ik P DB £ N E A Pl Integrator for Business Analytics 77 [RIAXFR A4 PI AF S FR1R, N
BHRBRNRHEREERFAEBRNEMNFRFR,

AR [E—1 PI AF B2 FR1R$Z2F 1517 Pl Integrator for Business Analytics BIRXER, 1Ltk HAPRIR =4 B3I
NELEZME,

BRUENER, BRER— PIAF FORIRRTIHANR, EHEFILURAES PIAF SRR T
WRNER. EXEZER, BSRARFIE,
S HoIEAA,

HEREHERD, 2HBRHBIK,
AR ERUEEMNBR— MRS AR, UERIFEAREMIIK,
5 FAAR S 23 AN BURE B B SR 2 A SR TR B4 HEZE MY PI AF Server FIEUEE,

AR NMRFETNRABFRUZENRE, WHEA— 1R, AFAUAERERFZAE LAY
R R HARIR,

MEHERERD, FEHERNSENTRIERISHRINHIh,

AR REBEEHERTH Y BFR, FHRFMRENRERERNBAIEHIESE, 4§10, 7T LURR
B, B BHELURRFHBEHERTIE, £ More Options B85, WIRIEFE T All descendants, A4 %
EREANPIAFEREN, MEREERE, BLERERBREHESE,

R EXUEFHBRMET, BER £ UEPRERIKHIETR,

SERREEN  BRLTHASEAE EENETE P AR ERANSIE,
M I A 41t Eb B P R S B SRR o

B X ARAFTARMIER, WS HE S A A R R e,

R RS PIAF EIRATRE BT ARIE, WA TR

2. EEABRWAEGREHEES D 7 B,

b. AREHIERRMERIE,

c. EEBHEREREEEFETRE
BEHET—HUMBHIEFE.

ERHIFF IR BRI R ERIR PRI E DS HAER T AT E,
Pl Integrator for Business Analytics X Z& % A IS4 HEZE,

BEMAELR, ERILAMESHIE. B3, IREERETREMRRAR. AXELER FSHE
ERRFMEHNE P,

;¥%E.: BT Pl Integrator for Business Analytics 1X 3 B 4K 2 B9 AT 10 4 PLEZ IS 7R AT 100 17, ELLERILL
B ERE N R ERE . XMERT, MEEEEMNAEBEFE TARMEEDR, TELthAFEER
EIEdE.

BHET—SURMELE,
MBE#REEESIRF, EFE—1T B4R,
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15. BHEIT—REHUE—R, SEF 2 HRIT BT ERISHEEMMERE L,
16. BEH&f,

AEH AR PHERIRMRT

ERI UM G EHE TEEAEEASEEHAEPHEHESRE,
“EBRHE AE

Select Data > Modify View > Publish Next
"4 Source Events v " Search Shape @) + Matches @)
Server ol DFPIAF . "4 Event Shape @ Found 62 Matches

4 "d CIP_SKID_EPRINSE:1-1 V4 » "8 CIP_SKID_EPRINSE:1-1
4 [ EPRINSE G &

l T ‘ Enter Event name or string match pattern @E 4 CIP Flow Rate (to User) 4

Event Frames Assets @' 4 CIF Flow Rate (to User) High &

Database 0SIPhammaCIP v
» "8 CIP_SKID_EPRINSE:1-1

v

"4 CIP_SKID_EPRINSE:1-1

v

"# CIP_SKID_EPRINSE:1-1

- 4 CIF Flow Rate (fo User) Low & » "H CIP_SKID_EPRINSE:1-1
€ EPRINSE |
4 P CONMNECTING V4 "# CIP_SKID_EPRINSE:1-1
) EPSHUTDOWN
4 CIP_124_SKID @ » "8 CIP_SKID_EPRINSE:1-1
) EPWASH o ) %|#
4 ACID SUPPLY FLOW 4 » "8 CIP_SKID_EPRINSE:1-1

» ) CIP_422_SKID

v

4 ACID SUPPLY TANK LEVEL CON... # " CIP_SKID_EPRINSE:1-1

» ) CIP_432_SKID

v

& CIP Acid Tank Level V4 " CIP_SKID_EPRINSE:1-1

» [ Environmental

X 0 X X X X X X X X X
v

v

Sl nnt . - 4 CIP Caustic Tank Level V4 "8 CIP_SKID_EPRINSE:1-1
noTemnlare

s — -
Attributes | Filter @

O Select All

v

"4 CIP_SKID_EPRINSE:1-1

"4 CIP_SKID_EPRINSE:1-1

x
v

v

"4 CIP_SKID_EPRINSE:1-1

v

"4 CIP_SKID_EPRINSE:1-1

# CIP Flow Rate (to User) o » "4 CIP_SKID_EPRINSE:1-1
4 CIP Flow Rate (to User) High Li] » M4 CIP_SKID_EPRINSE:1-1
4 CIP Flow Rate (to User) Low Li] » P CIP_SKID_EPRINSE:1-1
& CIP Flow Rate (to User) Parameter [i] » "d CIP_SKID_EPRINSE:1-1
& CIP Supply Pressure Li] 3

"H CIP_SKID_EPRINSE:1-1 -

-

TRAMETHTEMESNERS LR AL T I Z2EHARGRK.
#r sk

1 85 PI AF BUREEFTE MRS 22 A0SR EE .

2 BREHERETRUEREHESR, RHRSIE
BRLUERTER,

3 BELREHERIR FRAZEHERZ M
RFFH,

4 BRENER, EALUEXEEESFHARMEER
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EHRINES, BRAIUEXERNE4HERRER
%, URSIATREEENM,

BHEESERERTLUANBIE SR IREENELE,

R BEEMELN O AR ERE
SR B

ol ATREEIEBCHEMMERTRK. B
ATEEEAERETRMXTRMNBEEN T RITLE
1815,

PLECES A& AT LATRUSE M PIAF BUIRE R EREIM ., 5#
FRPRPE R NEHEEN NMTERESE R,

MEEHRIRE, ATLBATLAT#84E:

o TAILMREFERNIEHENEMHER, EEHERRREMTHE IR REE —MEHESRE,

INTRFTR, BN, FHMKT RR
K" E &

EAE— 1N FEHIER, HEHEREMNBHERERERTSHI

EHBR: - EHERTR BEE -1 FEHER

M Search Shape

HHd Event Shape

4 W4 ~p SKID_EPRINSE:1-1

o BITEHIESRS

E7)EPRINSE
4 Fd CONNECTING

D CIP_124_SKID

S R
%X
& R
% & x

BE—1T5IRATER. B5IATHEMNFHER ERIERINFELHIR.
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o B EMER'BERPHEHIESR, BINA BT ERTEREREG FHEMBEERIIEHIIR,

o TREHENRD REHEHIERLETR, RAREGTXESMRKE, VBRI B BRHAEETRE
PIAF B REMBPIGIE,

1E PIAF B REH¥FIHEI— 1P tH
" Source Events W

Server DFPIAF .

Database 0SIPharmaCIP

¥
-

Y | Enter Event name or string match pattemn

Event Frames Assets

» "8 CIP_SKID_EFPRINSE:1-1
4 "4 CIP_SKID_EPRINSE:1-1
» " CONNECTING
» " DOWNLOADING
» "H STARTING
» " RUNNING
» "H UPLOADING
» "8 COMPLETE
£ EPRINSE Q
» SJCIP_124_SKID j"-dj

» M CIP_SKID_EPRINSE:1-1

» PH CIP_SKID_EPRINSE:1-1

s "BHBERERTEERZNEG. SEAMEHIERIISHREK,

s NEREEE FTHEABINENEHEEZNATRBIERI SHERKR HD, MBEFEANTHRIERT
EHBRTAUIFRRE, R FERT BIBREX AN IELZ R, Pl Integrator for Business Analytics
SFZNRNXREREE PIAF BEREMPHUEMNEHZBAERKPERX—XR, BIREENR
NEERPEHITIN R EZERX R FRE, TREFFERNRAMENIT KD,

BIHMEN R
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M Search Shape
" Event Shape
4 4
£7) EPRINSE
FH CONNECTING

@n

Auto drop and place
&0 CIP_124_SKID

Pl Integrator for Business Analytics
Bn{al{sE A Pl Integrator for Business Analytics

u

& x
% & x

F x

EE  INBRAEE Pl Integrator for Business Analytics, B] M{EF B3I EFFIAR,

s MEF[ENEHER. iRREUERIFHMRKFUEE -1 ME, EETERTISERNR

BMEARR. ARHFRITR,

IR BEETFSBEILEERENRIEREE PIAF BREMTEEMALE,

HERRH PR R
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M4 Search Shape

" Event Shape

4 P CIP_SKID_EPRINSE:1-1 & %
£7) EPRINSE % &S x
4 " CONNECTING F x
@@3 124 SKID _ % x

Drop as child

 ACID SUPPLY FLOW

fo] B LA 2 o] {55 PR 6 12 08 =

REHERT, ERIEBHEMKNERROERK, BNBEHER. FEHERMSIATREAREG, W
UT REEEPRR,
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M4 Search Shape

*H Event Shape

4 "4 CIP_SKID_EPRINSE:1-1
4 [ EPRINSE %
& CIF Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 P CONNECTING
4 FACIP_124_SKID %
& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL

& CIP Acid Tank Level

B 0% % % % % % %R N R
X X X X X X X X xXx x X

& CIP Caustic Tank Level

HEEHRRT, R RRinEERINEEHELSI AMTRINTE, € LB RG G, FEERM PIAF R
REMBHI CIP_124_SKID THRZ LR TR MREEXRBRTHRA I AXTRMEER TR, L HHERE
B/, TR ER(BELUTERER) .,

“BERRE R
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*H Search Shape

*H Event Shape

4 " CIP_SKID_EPRINSE:1-1
4 I EPRINSE %
& CIP Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 " CONNECTING
4 [CIP_124_SKID %,
& ACID SUPPLY FLOW @
& ACID SUPPLY TANK LEVEL CONTROL

& CIP Acid Tank Level

B 0% % % % % % % R R R
X X %X X X X X X X X X

& CIP Caustic Tank Level

BHERASERE, BETE-AIER BT RRER, BETR HEHURERRNERTH
MEMEBHEN B IK B, L REIF, CP_124_SKID TTREE M EHHE & Fl 2| E =K &
B UTEREBEX LHITT A,

MBI R KRR
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M Search Shape
HH Event Shape
4 " CIP_SKID_EPRINSE:1-1
4 FIEPRINSE
& CIF Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 P CONNECTING

£D CIP_124_SKID

T= Asset Shape

4 ACIP_124_SKID

& ACID SUPPLY FLOW

& ACID SUPPLY TANK LEVEL CONTROL

& CIP Acid Tank Level

& CIP Caustic Tank Level

Pl Integrator for Business Analytics
Bn{al{sE A Pl Integrator for Business Analytics

B O% % % R R K
X X X X X XN X

B % % % N
X X X X 2

HERFRIREHRD, AILUANERTEZEREREYE, TILEAE PIAF BEREM T NMIBEE R, FIL R
f5lsh, L1 HUMAB. NorthStreetPllant ¥ Philadelphia TTRE RMNEE =Rk,

AMEE =R KRBT R
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Select Data > Modify View > Publish

"4 Source Events w " Search Shape
[
Server DFPIAF . & Event Shape
4 "4 CIP_SKID_EPRINSE:1-1
Drislise 03IPharmaCIP o v
4 D EPRINSE

I h ¢ | Enter Event name or string match pattern & CIF Flow Rate (to User)

Event Frames ~ Assets & CIF Flow Rate (to User) High

& CIP Flow Rate (to User) Low
4 [ Data Centers ( )

4 b CONMECTING
r EaAmericas

CIP_124_SKID
4 ) PharmaCo 2

4 ) North America

4 () Philadelphia

4 [ NorthstreetPllant

4 @ L1 HuMAB

&) CIP_000_SKID

» @ CIP_123_SKID

» ) CIP_124_SKID ‘ T Asset Shape

» ) CIP_422_SKID 4 [ Philadelphia
» € CIP_432_SKID 4 @) NorthstreetPllant

4 @ L1 HuMAB

» (D Environmental

&) no template 4 QcCIP_124_SKID

» D Syringe & ACID SUPPLY FLOW

» D T.STA 4P ACID SUPPLY TANK LEVEL CONTROL
@111 & CIP acid Tank Level

» @114 & CIP Caustic Tank Level

» @112

ﬂﬂ%iﬁﬁft AR e SR = 8 1, ‘R MINERREL, SER~ REEMEML:

nl:'b*ﬁ

Y

%,

% %
X X X X X X X

&
A N SR . T T T ¥

X OX X X X X X X

UAEIEIRE S

TR BRRSREAFRR ERNE-RERELENTRZRBEMAT PIAF EREMFZTHEZ L X

SEMAAARFRERMEE, BAIRRTRIKE EREE.

Bl R M E

;& Pl Integrator for Business Analytics = hrig 4t L I RE,

TERTZAECANERNEIES R, TR HHETHREATE,

1. EXRERAEARRK.,
2. BEUT#H#EZ - EEERATARMEN:
o ERAMXIXMHHFARER

o ERAMZEMEMERP T ARZEN
o [ERERRIZE

EXEMNESER SR TEN,
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3. REHRREE,

EXHEMARNESER, BSRX THEMAS,
4. (RIE) BEHHE,
5. (FIik)TEHIE,

FERMRF R REMR

M B AE T A BB 2R 4 b S ARMERIZRAG AT LMRTFRIZRMEM R FRA RN, TREFRRH 4, 19577
7 Avro ), BMRTERE, CHRRITSR BB R ENE I EMIMRBHEIHTHIAMLIR, Fit, EFIE
HHMEFEMRFIEMER ZBIH T,

FEERARLUBE R HFEERIMER ERIMRMIERIRIT SR BEPBIREMNMERE,
FELRRASD, ZHMRBEREFIEIMER. ENFREFIIXE.

1. AESXAE TES, 2HREMREIEMRE,
TR WAUEEREATY R R IR,

EFREMRFIVIMR 2T, AIURBFRREMRL. MREMS B~ RRATRS (AEREN BH
#30), R LB EH B R L ERRIRRF

Message Designer

Schema Options Message Trigger Backfill Data Message Filters
Free-form mode Trigger a new message when 1 key Do not backfill data 0 filters
values change

You are not syncing (free-form) your schema to the asset shape.

mport Schema Select Schema Structure

Fres-form - | Save Schema to Registry

Select Import Source - |

—=

“Timestamp™: "|(® TimeStamp v, P
“Zonel.Capacity”: "|4 Zonel.Capacity (Value) |, P
"Zonel.CapacityPercent”: "4 Zonel CapacityPercent (Value) v ", & x
“"Zonel.PWR": "4 Zonel PWR (Value) ", P
“Zonel.ReollingCost": "|4 Zone1 RollingCost (Value) |, & x
"ColoTemplate™: "|@)Colo1 (Name) v [ &S R

2. AREMKRFINEMR"EONRTIMR URL FERPEEFDEIMRMGE.
R FinAFRPRANS, AAREEMRIKRFTEREE.
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3. AEMETBFRPPMARMLHFELRE,
A URBEMREE R — LR, B, TEBEHBFIRBREMRNL.

You are using the schema "ZoneSchema” from the schema registry at http://10.4.200.128:8081.

mport Schema Select Schema Structure

{
“"Timestamp™: "|() TimeStamp v, & X
"Zonel.Capacity™: " 4 Zonei.Capacity (Value) ", #F X
"Zonel.CapacityPercent”: |4 Zonei CapacityPercent (Valug) v, F X
"Zonel.PWR": "|4 Zonel PWR (Value) ", #F X
"Zonel.RollingCost™: |4 Zonei RollingCost (Value) ", & x
"ColoTemplate™: "/ Colol (Name) v " & R

}

AR BRI LR GELEREMRBIRL RN ERZTMROERE, FITHERER, TUEHRITER
TR ZATREB TR E N,

X FiHRAAR 2R

HEMARATHRERAMBRAEEBMMEMES . MAFAMMRE, —METaIEER, 5H—%
ETFTRETL AEREFLARZ PIRCRAENE. TENFRERE R T XLRI,

@ Trigger a message in regular time intervals:

#) Trigger a new message when the key value(s) selected below have changed
@ ®) Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

o 1LETFEIEAHS AR
o 2EFHIRERLHESMERS

VLT &80 53 91 48 a0 el FRIX R T,
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LA 7E B i i) B A 5 R

RAILIRE 30 B3] 12 M A (& K) funtE A kR, 8 R et A EREA %, TIeHIEE2EXETE, &
LS H B Z BB A TR RARAE,

AR BIEEBNE A X/NHARE, BFRERISEER T B e geFEE R , 8 B8 3EIR (BNMEE5X PI System
BRI SEZ)5A B FR RS R0RT 18] 2 (8] B9 B Bm) mT RE K F M RGH Bl & B8] Fa .

PRIFGH B fih & R

A LR ERTAACHRMBTE, FRNRERMEFHAEN N REMRNRARIE, T TEME
REED, EETEAN 53X BT Pltag Zonel.PWR # Zonel.RollingCost BI5E,
Trigger a message in regular time intervals:
® Trigger a new message when the key value(s) selected below have changed

#® Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

Q‘. Message Content

I
L

"Timestamp™: "|(¥) TimeStamp v, SR
"Zonel.Capacity™: |4 Zonei.Capacity (Value) |, SR
"Zonel.CapacityPercent”: "|4 Zonel.CapacityPercent (Value) v ", "
C4 "Zonel.PWR": "|4 Zonel PWR (Value) v, SR
L "Zonel.RollingCost™: "| 4 Zonel RollingCost (Value) |, & x
"ColoTemplate™: | Colo1 (Name) v &S R

*-F-L/\ ‘tziﬁrﬁ, E”ﬂ-iﬁ 24 Emiﬁﬂk/ﬁ:u\m%#l:o
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Trigger a message in regular time in'tervals:l 1 w || minutes v|

® Trigger a new message when the key value(s) selected below have changed A _T_

#® Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed A \'/

Triggeron () Archive Data (@) Snapshot Data [++:] v
Q‘. Message Content
{
“Timestamp”: *|(®) TimeStamp v, & x
"Zonel.Capacity": “|4 Zonel.Capacity (Value) v |"‘1 S X
"Zonel.CapacityPercent”: "|OZune1.Capacit!.fF'ercent (Value) v|", S X
s "Zonel.PWR": | & Zone1l PWR (Value) v, SR
L4 "Zonel.RollingCost™: "|OZone1.RnI|inng}st[\.-’aIue] v|", P
"ColoTemplate™: | Colo1 (Name) v &S R
¥
TENET XL,

LEERETEAMEAER

E-—TRUNEEIEEEREERETLNMAER,

Trigger a message in regular time inter'.'als:l 1 il ” minutes™* |

#) Trigger a new message when the key value(s) selected below have changed

) Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

THRIEETNMEAELERR. EERTRIR:- BAMER, BHIFE— T RBRAETILN (AR Si5R) AN
fAGHE, SHETE t1. t2. t3. t4 ¥ t5 KX, HASHETR,
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t1 t2 t3 t4 t5

Key A Q\ —T

Key B Q\

(-] v v vv Vv

RUFEREHRETCNTMEER

BEZNRTEN LG AREMRKEZ LT ZEHR,

I Trigger a message in regular time intervals: | 1 W ” minutesw |

i») Trigger a new message when the key value(s) selected below have changed

I Trigger a message when any of the selected key values have changed

@ Trigger a message when all of the selected key values have changed

Trigger en () Archive Data (® Snapshot Data

TEXLHTTHEA, ZHRE 2.4 M7 KE, FRMESETERTHERCHE. 5 REEER
&%, RZEARRETR,
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Key B
yB | @
t1 t2 t3 t4 t5 t6 t7

v v v

orn | @ * L

i % BRI BER B

BRTHRIRXENRXBEIES, ERATLUEEREEERAFHEIRBRERMAER,

Trigger a message in regular time intervals: | 1 b ” minutess” |

# Trigger a new message when the key value(s) selected below have changed
Trigger a message when any of the selected key values have changed

®) Trigger a mezsage when all of the selected key values have changed

Trigger on Archive Data (@ Snapshot Data

RIEHBEREE

FSRXTHEMAREE, ERETEREFERMABHENER.
FEIREH B MR 2R AT, RO IEREN,

1. AEXAETEF, 2dHRMESR,

T fak
A LA TE B (8] (8] B fi % S 2 HERE TR ERAE, T
PRERESRETIE,
B LTEEREMBELRETIER |[BIEREMNTEREHER,
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LT i

R HHR

o ERTHETZ— MNRIERFE A NRENITEI D,
o IMFIEFE B NAZRKITELD,
2. (PR A) B EHFIF, EEMEHR Z B BETE B R,
A AR RE 30 #EI 12 4~ A #et R [E f.
PSRN

® Trigger a message in regular time intervals: | 1 W || minutesw

Trigger a new message when the key value(d 1 seconds
2 minutes
3 hours
4 days
3 months
6
v,
8
-

3. ((RBRB)TERLUTLIR:
a. ERERMAHERHRE,
b. EHETIEIz—:

&M ik
HEMERMBERETEMAER REFEE-ITRERETLAMAHER
LABEERMBERETEHMAER EREHRRETILRTMAER

. EFRHERHRBEZEEZHTERMFHERTLAR,
BHXXLRTUNMETR WA X BIENESER, BEAX THEMAS

[A] B AR A A 4 B4 2
HERENSORENAZE, BELPLLL MR, NFE R, G7UMELTFIR TS
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&,

AR NTFETRAOER, fiAHEMNEIERE (FHIRE) S 5XRAEE BARMNEUE S BRI, i, &
AL ERAMIREBHIETLSMAER, B2, BRI LUIEER BAr A28 GEREBEE) WEME. £ TEMN
REEHE D, 1A Zonel.Capacity BI4IZE T Value ({H) .

ng Message Content
{

"Timestamp”: "|(® TimeStamp ",

v "Zonel.Capacity”: "'0 Zone1.Capacity (Value) L "',

' Template -]
"Zonel.CapacityPerc Category lue) v [",
Fath
Description

Guid
o "fonel.RollingCost™ 1 uc|“ v |,

v "Zonel.PWR": |4 Zon

"ColoTemplate™: Efﬂ IT_S?;FEEDMEU Value
} Average

Minimum

faximum

Range

Standard Deviation
Standard Deviation (Fopulation)
Count
FPercent Good
Snapshot
Time Oplions
TimeStamp
Year -

UTHRNE T HEMARES,

o = 1 RRHKE
o IR 2 FHBEMEMREIEYSMEER
o 3 REBHIEMNEFARETEHSMAHER

EEMERT, dLETEEFARNEREXLERESE. XLEFHENE T FEA Value () . Last Recorded
Value (£ 18 FAI1E) #1 Snapshot (1RER) AL & B IERIK R,

s 1:8REHEE

BRI SIRIEE BRAE, LT RGP, t1 50 t4 Ricet B RIFRMFF IR LR, SHENRIBE t4 B8t
(8], A% RO EHREUR TN % B R B ER T :

o BB} Snapshot Value (IREB{H) BRE Z/E 1, M t3 HRIBESRKE t4 IR BZ—&AE, (1)
o MR Last Recorded Value (L RIZFHE) BLE ZE M, WA ZEL TR RIZ 2 AIH L XRiERNE
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(FEARFIR R 12 BIFENE) M v B E BB —E L. (2)
o MR Value (B) BBEZE M, NI{E AT E B @ A B F R FIREBE T E t4 B E A3EE, (3)

time interval

tl t2 t3 t4

2/
o 9

message time stampJ

Key

e

REBE

fhfE

TR 2: FHEBIENEFAREEHSMEHER

LIRBET 13 2K, ESMA 2 HEMRBERITEE (FE 2 /ED . 2 (MFEEMEAHER, NEZR 2,
TEETRTRIEFMEMERTUR XS B IR R

o BIIEJ Last Recorded Value (£ RiEFAE) IRELE A, N & E t2 BITFREME (1),
o HNERA Value (B) BUEEE A, M &1 t2 BUFEE (1),

KLy, NEM B KEMBIERATZEEMEESAR
e Last Recorded Value (_ERiI2ZAI{E) 2 Pl Data Archive FI7E ;8 BT B8 2 BIsiZET B2 (t2) E—1

B, 7EABId, 08 A Last Recorded Value (ERIEFKME)BLE B, &KX t2 ZRIMNE —NMEMNERE
(2)o
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o INEN value (E) $iEECE B, MI{EFA t1 MTFASETD 3 FITREBETE 2 /ASUE (3).

message time stamp

—

t1 t2 t3

v Key A

Key B

Key

FiuE

RERE

f&{E

=3 REHFENEMRETEHSMAHER

FRMBMRBETLESMAER, EAGD, HERE AL, 8 A MRBHIEE S MAHR, EHAR
BZH 3, N ARME t3 FIREBE (1),

BBRENMAR, E- T RB(BBMNERAERERRE:

o HNEJ Last recorded value (L RIZFKHIE) BLE & B, N AKX t1 MEFERELE 3 BHRNBEZ, (2)
e HNERA Snapshot value (REE{E) BECE#E B, M| & 1% t2 AUIRIBE LK t3 B9H BRTEIEL, (3)
o HIRN value () ECE R B, MK t3 MIIRELIK t3 BIBTEBL, (4)
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message time stamp

—

t1 t2 t3
o
v Key A
2] © 4)
Key B
Key
FHEE
REBE
fafE

NBEBETLAAEERMRERETERMAER, NWATFTARMREZLN Y R ER FHAR
FRFHEERREREE, &RE—TRERBEMRRRZRHESNEZ,

HEF R IR ERFHEE, B, MRHEMRRENSRZHRBEELET B, WHREHESS
HIAETE , EFERFHEE,

ot
T

BiE
BARORARARETNNABEFRE— M EHNNABNE ML,
[B]15 254

LERMBIER, BRHSFESRES B, B LB EERIERGERME,
FE: TNMRERUEXFREREFERAB I RIEEN . REMENRE RN FILEE.

1. AESAE"TEH, £HEERHE.
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S HEEHEFIET.
BHXAEFHBHERTHFBER,
R BHFEEFRBER.

W

TE LT AE B A1 B RO AZ AR

MEFRESTRFEPAS R, BSRUEE~UE., MRFEREMHERSITHRIE, BSA0ES
HaE,

1. BEREERF E FEHAERARAE,
2. WANBER,
AR ETHAERFRMEMBERNGRZATE. EXEZER, BHSHEWE L P E R L,
3. INRIEHIAF K9 B4 2 1N B A Pl iIntegrator for Business Analytics 77 [R] X R4 PI AF 424517, i
B AN BRHIERERTRE BRI S HIRR,
IR E—1 Pl AF B3 +R1R$%F 1518 Pl Integrator for Business Analytics IR, LB RSBz
HELRIZUE,
BROBEUEN, EREER— PIAF AR IRIRFIHENR, EHERLIMES PIAF FRRIRET
HRNR, EXEZER, BSRAERFUE,
4. BHOIEUE,
5. WRAFERT, RHMBEHBK,
AR EBAUETME—TABESAER, LERIAEREMTK,
6. {FARRS 3R FNERE BE = B S 0 SE B R S5 4 PI AF Server FI3RIEEE
FECMEFETREL, WHEF—1ZRA, AFALAEXRER ZUERERNEIEER FMFIR,
7. AITE5ER PIAF LB EIF LD IR,
FIERE| R RAKEE
HRFIERE R ERE

%
-
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Select Data > Modify View » Publish

@ Source Assets T Search Shape + Matches

Server CAST-INT-CL v AR SEsE
Database Datacenter Demo oo
Q) Assets
G—\_lto drop and place
4 @ Data Centers &) Colot

4 [ Americas

4 [ Atianta
| » @ Colot —_— |

» D Colo2

» D Colo3

» D Chicago

Attributes | % |

0O select Al

4 ColoNumber

4 Zonel.Capacity

& Zonel.CapacityPercent
& ZonelDCIE

& ZonelPUE

& ZonelPWR

e oo oeCcc0C

& Zonel.RollingCost

4

B ERINE R RAR B,
BERFZE, ‘B ERFTH EPETEETRIEL,
9. EREVETEMIKNPHEL,

TR BEUNESRTHR. A XN ESERTHERELREZEE RIEN, XFAT LIRS Ei
FIFrFHEMA.

ERBIREDRERMEE
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Select Data > Modify View > Publish

Ea Source Assets T Search Shape + Matches
Server CASTANT-CL - T_Asset Shape Found 5 Matches
Database Datacenter Demo ooy & Colot s X & colot
@ Colot
Assets
CD ) @ Colot
A fa Data Centers Q‘ t | @ colof
L utoc drop and place
4 America -
Ea § & Zonel.Capacity @ Colol
4 (@ Atlanta
| » @ Colot
» @ Colo2
» @ Colo3
» @ Chicago
P+ S
Attributes ‘
O Select All
4 ColoNumber

‘ & Zonel.Capacity

& ZonelCapacityPercent
& ZonelDCIE
& ZonelPUE
& ZonelPWR

eocoo

# ZonelRollingCost

-

FE: MER/EINEHERI AR M4 2ETLEEIREXEAWNIERT. ZHR2ED
AMEB BB EME., ZREAE AT MPRIFEE PAFHPEEMX R MRFEFEEENX
HIGIE, AB% HEMUIFIRIEL

<cs id="557">F & : </cs>RB T LUFZN RME SRR B, N2 ER—1TERIETR, 518%
FHZE= RN RR . FREBRRME IEET LB EFNRIEREE PIAF RREM TG
Eo

TR BE SR 7R R o
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Select Data » Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTANT-CL v ToAsset Shape Found 5 Matches
Database Datacenter Demo oo 4 anitz;—ga\ert 7 % @ coo
b i Canacih P » @ Colot
[ Assets ;x » & coor
A @ Data Centers ;% . @ ot
A 8 Americas ; x . @ ot
| 4 e Atlanta .
» @ Colot
» @ Colo2
» [ Colo3
» D Chicago
» Ef) Houston
> @ MNew York

3 @ San Leandro

10. JHERMEAME=FEMAER B E TR ER,
“PLEC B R BRI R 5 E XKL E R TTR,
11. EEFHAZHERE PIAF ERAFAE R HKE, FHATUTIRE:

2. BERFEHMER ¢ LTFRETEE SO,
b. ERRER LT E AE,

C. BIERFTHR S I S R,

L B B RS T 2 B ASAR RO R RO

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 123



'AV EVA\TM Pl Integrator for Business Analytics

Bn{al{sE A Pl Integrator for Business Analytics

@ Source Assets T Search Shape ' Matches
GarEr CASTINTCL . T Asset Shape Found 16 Matches
Database Datacenter Demo [ 4 4 @ ColoTemplate s x> Qcoot
& Zonel Capacity /x> ©cool
@ Assets
& Zonel.CapacityPercent PR . » @ Colot
4 @ Data Centers @ Zonel PUR * % @ Colof
4 © Americas & Zonel RollingCost % @ Cobot
4 [ Atlanta » @ Colo2
» ) Colot » @ Colo2
» [ Colo2 » @ Colo2
» &) Colo3 » & Colo2
4 [ Chicago » & Colo2
» ) Colol » @ Colo3
» ) Colo2 » @ Colo3
» [ Colo3 » @ Colo3
» B Houston » @ Colo3
» B New York » @ Colo2
» @ san Leandro » @ Colod

12. EEREATRBEESEMBLAS LR, FHRITUTRME:

2 BEFBEMEMSZLN ¢ .
b. FERENIEEE W EIED, P AEE £ AIE, RSB EE.

B, BE-—THARRE T —#IRE, [BRREFNFRREHELBEARTR, Bo G A
ALE R PR

Edit Filters

# Attribute Name

Zonel.RollingCost

Attribute Category

Cost v

(+) Add Filter

¥ Opticnal Attribute e

13. BiHFTF—%,
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RERMELABRAE, TSR ELIE TH, BETHRETEXABNFRITHES.
14. SERUTERZ—, NIEHBIEEEREEN:

o ERARBIZEM

o ERAMXIMHFFAREN

o ERMZEMEMERP T ARZEN

AR AXEMETMESER B5H X TEA,

ERBEFIEMAS

ALEMRETEEHFEN B KTRIBEEHITHAE Hl20, 2ABEHEM BTV ESEE—HEX, EHREER—
MR ERERTENEERE 55, ETHIF, H= Zonel B4 :Zonel.Capacity. Zonel.PWR
(Power) #1 Zonel.RollingCost, X £EJ& 14 (Capacity. PWR F RollingCost) #18 Zone2. Zone3 #1 Zone4 £ Z (&
. (5180, Zone2 [EM R Zone2.Capacity. Zone2.PWR 0 Zone2.RollingCost, ) R F 2R B X g K L RIX LEF
%, TEMREREEEZIXM PIAF S0 2 0E,
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[ Source Assets

Server CAST-INT-CL v

Database Datacenter Demo

0
-

@ Assets
4 [P Data Centers
4 [ Americas

4 [ Atlanta

» ) Colot

» ) Colo2 -
L —

Attributes | Firer x|l

0O select All

3

& ColoNumber
 Zonel.Capacity
 Zonel.CapacityPercent
4 Zonel.DCIE
 ZonelPUE

& ZonelPWR

4 ZonelRollingCost
 ZonelStatus

& Zone2 Capacity

4 Zone2 CapacityPercent
 Zone2 DCIE

4 Zone2 PUE

 Zone2 PWR

& Zone2 RollingCost
 Zone2 Status

 Zone3 Capacity

Q0 Q0 QCQQOQCQQOCQCQOCQCOC0OCOC0COoOOCOCC

& Zone3 CapacityPercent

4
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i), BEREMASES T FRRE, FEMTEER.

Select Data > Modify View > Publish

@ Source Assets T Search Shape
Server CASTINT-CL v T Asset Shape
Database Datacenter Demo ooy 4 [ Atlanta

4 @ Colol
@ Assets

4 Zone*.Capacity

pacity

4 [ Data Centers ) s T
one* PW

4 [ Americas

4 () Atlanta

‘ » § Colot

» ) Colo2

& Zone" RollingCost

» 6 Colo2
» @ Chicago
3 8 Housten

» 67 New York
Attributes | x‘

0O select All

& ColoNumber

& Zonel.Capacity

# Zonel CapacityPercent
& Zone!DCIE

& ZonelPUE

& Zonel PWR

& ZonelRollingCost

' 0 000 Qe

4

Pl Integrator for Business Analytics
Bn{al{sE A Pl Integrator for Business Analytics

LEEREZEMM (B0, Zones BIEHK A

+' Matches
Found 64 Matches
P 4 4 @ Atlanta
S xR 4 © colot
£ R # Zone4 Capacity
S x & Zoned PWR
T 4 4 Zone4RollingCost
4 @ atlanta
4 @ colot

# Zone3 Capacity
# ZonedPWR
4 Zone4 RollingCost
4 @ Atlanta
4 @ Colot
4 Zone2 Capacity
# Zone4 PWR
L 4 Zaone4 RollingCost
4 (D Atlanta
4 @ Colot
L 4 Zaonel.Capacity
4 Zoned PWR

# Zone4RollingCost

[N RV

ARG, EHRELER—THIES HRETRESE— 5' ﬁ‘ﬁ’r,—e 12 3 (EPREETRE=5) &

A LA B R R PR R nB R A A A X KIRGHF

ﬁ%ll_.\l’/l&ﬁﬁlfo
1. tE— R EPaas@GRMXBMNAF—ARM%,

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.

SR, UTURMRAIMFRRETREFSEN

Page 127



AV=VA"

Select Data > Modify View > Publish

@ Source Assets

Server CASTNT-CL

Database Datacenter Demo

[ 4]

@ Assets
4 [ Data Centers
4 @ Americas

4 @ Atlanta

‘ » &) Colol

» ) Colo2

» @ Coloz
» fa Chicago
> @ Houston
» @ New York

» fa San Leandro

Attributes | x

0O Select All

4P ColoNumber

4 Zonel.Capacity

& Zonel.CapacityPercent
4 ZonelDCIE

& Zonel.PUE

& ZonelPWR

4 Zonel RollingCost

LI - - T - I - -]

T Search Shape
T, Asset Shape
4 (@ Atlanta
4 @ colol
& ZonelCapacity

& ZonelPWR

& Zone1RollingCost

2

2. BEHE—INEM (Zonel.Capacity) LAY 48
ATFXNERERITHENFEFTRERE—TES,
TELEBIR, 4% Zone 1 B E S (%),

3. ERBEIEREES, FE
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W, N,
X X %X x %

+ Matches
Found 1 Match
4 [ Atlanta
4 @ Colot
4 Zonel.Capacity
# Zonel PWR

& Zone!RollingCost
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Edit Filters

Show Wildcard Groups &
# Attribute Name

* Capacity

Attribute Category

Capacity r

(#) Add Filter

Optional Attribute o

4. BERRF

X—BERERUATRERNR, — N EETATNERRE (Zonel) MEMERITHE, RIRMO=1TE
TATNF RS R EETSE.
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Select Data > Modify View > Publish
(@ Source Assets T Search Shape ' Matches
izt Jp——— . T Asset Shape Found 4 Matches
Database Datacenter Demo oo 9 B ke
4 @ colot £ % 4 @ Colot
@ Assets & * Capacity P & Zone4 Capacity
4 () Data Centers & Zonel PUR Fx # Zone1PWR
4 @ Americas # Zone1RolingCost Fox # ZonelRollingCost
4 [ Atlanta 4 @ Atlanta
| » @ Colot 4 @ Colot
» @ colo2 & Zone3 Capacity
» @ Colo3 # ZonelPWR
» &) Chicago & Zone1RollingCost
» (D Houston 4 @ Atlanta
» B New York 4 @ colol
» (@ San Leandro # Zone2 Capacity
# ZonelPWR
4 Zone1RollingCost
4 @ Atlanta
Attributes ‘ *| ‘@ oo
4 ZonelCapacity
0O Select All # Zone1PWR
# ColoNumber [ = # Zone1RollingCost
4 Zonel Capacity L]
4 Zonel.CapacityPercent (i ]
# Zonel.DCIE i ]
& Zonel PUE o
& Zonel PWR (i}
& Zonel.RollingCost e

5. BHEZABEM (Zonel.PWR) B2y 7

6. TEURIENIRE TEES, FAERNTFRE (Zonel) BRHE— T 28,
“RETEE N EESE RTINS
Edit Filters

Hide Wildcard Groups €
¥ Attribute Name

‘ | ‘ You've added a wildcard symbol (*) to multiple nodes in the
|PWR

Shape Tree:
Attribute Category L 4 ’:-gijRaCity
L e

| Power r

Group Together Keep Wildcards

(®) Add Filter

Optiol'\alAnribthe 6 natching gra 0 on these Shape ltems are — different

Don't show this message again

7. BHAR—-4A,

ERBETIRRIEES, 2E5ERN Group 1, AEM B P FHEREETE Group 1(Groupl.Capacity
Groupl.PWR) IR T4,
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Edit Filters

Hide Wildcard Groups €

¥ Attribute Name Group Name Group Usage

| - ‘ Group 1 & | Group 1 .Capacity
Group 1 x PWR
& Group 1 .PWR
Attribute Category
‘ Power ¥
() Add Filter
Optional Attribute € (#) Create New Wildcard Group

8. BHRR#E.
BRERKBHIR B Group 1 BELFFER.

Select Data > Modify View > Publish

€ Source Assets
Server CAST-INT-CL M
Database Datacenter Demo oo

@ Assets
4 8 Data Centers
4 [ Americas

4 [ Atlanta

‘ » @ Colol

» @ Colo2
» @ Colo3
» @ Chicago
» [ Houston
» ) New York

» e San Leandro

Attributes ‘

®

0O Select All

4 ColoNumber

4 Zonel.Capacity

P Zonel CapacityPercent
4 ZonelDCIE

4 Zonel PUE

& Zonel PWR

# ZonelRollingCost

eoeoQCoOoQCOQ

T, Search Shape
T Asset Shape
4 [ Atlanta
4 @ colot
& [Group 1 Capacity
& Group 1 PWR

4P ZonelRollingCost

,
X X X %X x

LN

+ Matches
Found 4 Matches
- ED Atlanta
4 @ Colot
# Zonea Capacity
# Zone4PWR
# ZonelRollingCost
- ED Atlanta
4 @ Colot
# Zone3 Capacity
# Zone2PWR
# Zone1RollingCost
- ED Atlanta
4 @ Colot
# Zone2 Capacity
# Zone2 PWR
# ZonelRollingCost
- ED Atlanta
4 @ Colol
# Zonel.Capacity
# Zone1PWR

# Zone1RollingCost

9. BHE=1IEM (Zonel.RollingCost) 58 # s
10. MIBRHEZFFFE (Zonel),
11. B HAMEBEE P Group 1, FHIEKIIBH L HRFERT,

o
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Edit Filters

Hide Wildcard Groups €

me Group Usage

Group 1 \ & Group 1 .Capacity
& Group 1 .PWR

| Attribute Name

|RallinaCost
E\\s Group 1 I
] Attribute Category

‘ Cost v

) Add Filter

() Optional Attribute (5] (¥ Create New Wildcard Group (= Delete Wildcard Group

Insert Wildcard Group 1 at cursor position

TEHHNREHERERT Group 1 BEFH=1E.

Edit Filters

Hide Wildcard Groups €

I Attribute Name Group Name Group Usage

‘ Group 1 & Group 1 .Capacity
& Group 1 .PWR

& | Group 1 .RollingCost

| Group 1 % .RollingCost

I Attribute Category

‘ Cost v

) Add Filter

[ Optional Attribute @ (# Create New Wildcard Group

12. BEHRE,
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Select Data > Modify View > Publish

@ Source Assets T Search Shape + Matches

Server CASTINT-CL . T Asset Shape Found 4 Matches

4 [ Atlanta
4 @ cCalot

4 Group 1 Capacity

» @ Atlanta
» @ Atlanta

» (@ Atlanta

Database Datacenter Demo

[ 4]
“

@ Assets

4 e Data Centers

& Group1 PWR » @ Atlanta

N N N NN
X X X x X

4 @ Americas
4 [ Atlanta

| » @ Colot

» ) Colo2

4 Group 1 RollingCost

» ) Colo3
r e Chicago
r e Houston

» () New York h

Attributes |

O select All

4 ColoNumber

4 Zonel.Capacity

4 Zonel.CapacityPercent
# ZonelDCIE

& ZonelPUE

# Zonel PWR

eocccCcoQQ@

4 Zonel.RollingCost

FRANEBEEREFZE, IPNEEILE R Zonel, Zone2. Zone3 ¥ Zoned FIEMIA A —4A,
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v Matches

Found 4 Matches
4 @ Atlanta
4 @ Colo
& Zoned Capacity
& Zoned PWR
& Zone4 Rol ngCost
4 @ Atlanta
4 @ Colo
L 4 Zone3.Capacity
# Zone3a PWR
& Zone3 Rol ngCost
4 @ Atlanta
4 @ Colo
L 4 Zone2 Capacity
& Zone2 PWR
4 Zone2 RollingCost
4 @ Atlanta
4 [ colat
L 4 Zonel.Capacity
& ZonelPWR

& ZonelRollingCost

SRR R E

FEIESME" TES, HERTREEBHEMFETE RS ARERE, el L REEF MR R aad
HEEHKE, TEMNRSEERE TS MER UL X BUEEMRHLE
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T Shapes o’ Message Designer @,
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Preview

o Asset Shape | Schema Options ” Message Trigger ” Backfill Data

Preview Start Time
” Message Filters |

©)

4 @ colo S % “-Bh
& ColoNu.. & x You@cingyoursch@theasset she@aﬂaﬂeneds@. Praview End Time
OZone‘l.... &S x Import Schema Select Schema Structure ) EI‘
® Zonel.. & x | Select Import Source v| | Sync to Asset Shape (Flattened) v| {
"Colol": "Colol",
& zonel.. & x "ColoMumber™: "1.664574"
"Zonel.Capacity”: "162"
"Zonel.CapacityPercent™: 171.21975703007812,
"Zonel.DCiE": "38.5215"
{ @ "Tzzzs‘tam;" '28:5 18-29T@1:51:56.86083267-87: 0¢
"Colol": "[& Colo1 (Name) v, p ‘}[-,
“ColoNumber™: "[4 ColoNumber (Valug) v, & "Colol": "Colol”,
"ColoMNumber™: "1. =
"Zonel.Capacity”: "|O Zone1.Capacity (Value) '|"J rd "Zonel.Capacity”: "182"
"Zonel.CapacityPercent™: 172.82561950683594,
"Zonel,.CapacityPercent”: "|0Zone1.CapacityF'ercent{Value] A\ "Zonel.DCiE™: "37.82698",
"Timestamp”: “2018-18-29T@1:52:56.8603267-87:0¢
“Zonel.DCiE": |4 ZonelDCIE (Value) v, Vi 1
"Timestamp”: "|® TimeStamp v 4 ¢ "Colol": "Colol”,
"ColoNumber™: "1.6-‘3»%5
3 "Zonel.Capacity™: "162"
"Zonel.CapacityPercent” 1?3.2198944091?91
"Zonel.DCiE™: "3?.55?36",
"Timestamp”: “2018-18-29T91:53:56.8603267-87:8¢
j[’
"Colol": "Colol",
"ColoMumber™: "1.67812",
@ Add Prope Schema "Zonel.Capacity™: "162",
"FTrnael FanarituPercent™: 177 TA?IRIAARACARRR
A ik
1 BRERRK - BRI LR TRIFEMBRIERZER
RITHRERPHEGRELEL,
2 HEIRITE - ELLER D, BAILUAREN, B
;iél B R 2R IEREMEM. BiEHE,
3 R - LU R RITHRERPETHEARXET
100 *I% r%\o
4 u*’-.l J-LTFH:.Fﬁ’ : :L.\E"]glg*t.lo
> *’]ﬁlji li?*m:]:klzlﬁ:h\m *,-.lo :L.\_J-I’Jsﬁm
EFRAFBRERMEMNHEMNIGSHEMERSPS
AZEH,
6 IER MR B EAR AR M BRI R
4, FIEFTA LTI TR IR EHER,
7 HEALR R - IREH R AE TR B ARRISIER R
.
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#r sk
8 EIEHIE - 5 KX 2R BARH R EE,
9 HEIER - R EHRIBIEER.

BEXRNEAEEIAR TETRXLEESHER, BSRUTRAR:

o ERAMXIXMHHSTAREN
ERAMEMREMERD S ARMER

- {ERIE IR
- REHBNER,
. EHIE

X TR

3¥E 1Pl Integrator for Business Analytics = R hRIZ L tEThEE,

o RNERT, #ERMKATRREHEBEREN, GRILERX N ERBIEM, HATLIS AR,
KEBIRER S ERS1ZEN.

S AR
AT LLM B MR R S A 284

o M-S ARIZEN - UTHAMEM I MRS A JavaScript R K RiE (JSON)., iE S5 fR{E (CSV)
#0 Apache Avro, S A TG, ERILIMEME A EELURRERES.

o MZEHIEMERS ARIZEH — tbhRA 2 $5{#E A Apache Avro ZB## Confluent ZB#¥IE MK,
o MZEMIEMETS AR Avro EMEEHISKHET RN, S AT, BHERFNBIERE 5 5ET Avro F
BAMMERBITRE, ENEEZER. MEHAUTE—ER, FTXHAE
o RMEBEMHEE
s EMAFERBRILEMERIFBEENM Avro FEEARZHF null KE
o MEFERBRICEMIER, B Avro FEZF null RE, NFRHAE, EFEIWZAE.

= 35A:0E )

ARHEMLURE. REXBARAEHRAT IR K, FHEERTERRPHE=EMLRFET
B, BEESRAMRKPEXEFREEHNHEEESR, ERTEXD, ZHLUFERREMET, ARERA
B, FREEMMEREN, RTEFNREEMAVTETRELLN. SEEAXMELURBERE, &AL
RARESRFEMFIFFERRN BmRXEN, A B REXEME, EREMMRIFERK. FRT &

BRIATERARTFRRERMA A LSRR ERAESN, EER LLEN RN, BRFMEFFFRIEREHRR
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%o

ERAMXI S ARIZEH
WEE T 4210 T B RN ENEA A,

1. AOHERBRIUTSR B, REHEMIRE,
2. BEEREMIEREXH.
3. E4TH"EOS, EREMXEFH LTI,
FTHERLUTHAAIZEH 1 JSON, CSV #0 Apache Avro, X WAJELE json, .csv B .avsc T BB FTRETEHE
Rt FE TR,
4. FERATII—FAEREMBEESECE:
o HRFMARPH—IATHEHEENZIER L,
o BEMERMN ITHRERM EO. MEEKPER—ITEFHFE AREMEERIEARSIERG
EE—NME, REEHEM.
5. HEMEMEN SEBIHINEHMEE,
6. B x MBEREEM.
7. BRHETAMNFBRHERMAIARE, AMERESE.
a. MABRMEZMFRTHIA

b, MEAFEKEHHN— ks ¢ BB RE.
8. BT TR AN EE,

EFAMEVLEMER P F ARIZEN

BRI TEMNTHBRRMERERGE,

1. ECHRRITSREE D, L EEMIED,
2. BEERS AEMIERERTIME,
3. MZBHIEMFRN SEER IR R EMI L G ERPMEEM,
4. FERATII—MAERAERESESERE:
o FHRFMKFH—DEFRBEEIESBIZEE L,
o BHEMERKTHRERM B0, MEKFER— MR~ EFE, RAEMEBHIIEREIRTiE
m—ME, £ EEHEME.
EREIZEF A HAUNBRZH], BN ERDHIFTERHRBEBRME, MEEMERS AR Avro 2
IR FISKE AN, FReER B MHIMEBIERE, MEEMEFENEZBFERIERE T
BI1EM, Pl Integrator for Business Analytics 9= R R EIER T INE T ERREHIERE, NRZEHE
ERNul B, RETR"ERFEEE Null B, B RMAREERME, MEFERTERN
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B AERFFEM. RIEEMAVFER Nl B, XFHERT, ToEREIERERTEMFE, BFIA
G
5. MERITT—HRBIEHENEE,

{5 P A BB 2R 44
WX T2 T RRROENEASE,

1L EOHRRITSRERT, RHEMREDR,

RAERT, HREMER=RIREL HURTEMETR.

2. BHERIEMESHFFIRE—TIED,

o ERFHIKRAL (RT) - BHLUFRREMETR,

o ERFHIRRL (BRE)- REEMEREN.

- BN - EARAEATEANERMEMEREMHERRT).
EMERENEUR SRR A LR EIRE, BRILM PIAF TRSFEHF AT AR MSIR S
EETREME.

3. EMEMBEMSEREME FEEFXFMINRPIEFE-—TEML,

4. ENEMBEMHRITER, BROHERS T RFEREN EO,

FE: B, EE U EMESAFERESMRIABIRRERTENR,

5. (XEREBEHREXMZEM) EREARLE, REBITIEMAALE,
RR:TRNBEREMPR—RAMBIERITETHF. — T BHEREBII RN EMRX T FIH,
LEXTHRAFREHAEAHE— 2, MEBRUAN, NSELER,

6. (XPREBEXLEM) B x BFREMREX.

7. ((XREHEBXAEN) RTETAHMNGRERNEIAE, HmELRELE,

8. MEPITT—HBAEHEHEBHEE,

FERATIEHRMEIEMERIR

HEABRHERE, EEELAFRENETREMER RN R, R, TUEATRSFZRRT &
DA REMIER, B ¢ EFTITRSEDEENEE, U T REAEE— A AR R
YR IT E AR XA AE

TR ATHHRAIHE T A A BRI RETIER . SHERTEREFTBIRRLMEY, MAXL
TEFHITA SR NELREHER

RERE R AR R 4R X R
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Edit Filters

¢ Asset Mame @J

e Tat 1T

MS301:Anne Morth:T1

@ —_— ¥ Asset Template @J

M5 Transformer r

Asset Category @J

S Transformer r

(¥ Add Filter

REHERATIERREASENES

#r ek

1 77 B R R 5
2 RS

3 BrEERSH

4 TR B &M

R URTFHP— PR EINEHHRH TR FEMEEERERTRFSEERSEE, flin, EREER S,
Asset Name (%82 7= 4 #F) #01 Asset Template (8 7= #54R) 1940 Fik KA, DIUH BIXF N FEF B EHKITE
I, 1R & ¥R MS301:Anne North:T1 BLETF MS Transformer iR R =2 B RELREER S,
NFEHAE, TEEEHEN AN EHATR. BHERF Event Category (BHEF) , (BR, XL IRZRH
TRERFUERIIEFMERE,

SR LB AN IR, T RERUGSSEZAEEMITERD, £HNE (+) AIAMNB — AL IR,

AR FRRIEUM TR FEETMEMBITL IR

BIIYRBFEE—ARATRM., BFER, BERBEHS, E1EN AND £ A S TRFPHENIE
TESMHIUED, o REER ™ RN LA,

MRFERTHZITRR WHEEFSEE T TIESRMFEH T REER ™ BN LR,
[E] Z I 1kt R 451, EEF';?WJDT%— iR, BT RWEEIRENRN DrilBit*,
RERERE NI IER
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Edit Filters

¥ Asset Name -

DrillEit*

Asset Template

ElementTemplate r

Asset Category

(=) Remove Filter

(+) Add Filter

Pl Integrator Framework ARZ5#8 3 Pl AF Server:

o FAHAE—ITIIESE BFHKBFN MS301:Anne North:T1 BEF MS Transformer ¥R BI{ERIE =,
o FREZ-ANTIEIR EIF KB DrilBit FFKHERE=,

RFEE S S EE— PMEHOEAAT, Bk, $TERBEN—1 OR LB,
B A= FE 4N E PR

AR BRI UERERMHAE, AXNAEREATHARNESER, FERIEDIE
ARHNEZAH, AIUMIEBFELSR, afF:

\

o HHHEMRRANX

R LR B AR E R RN E P ERAXRIIRAR KR, BS R LFERRET THRERETERN
FRIA AR PLE T UL RIS FHIBIERTA L. EXNAEAEPEERRELRAENES
ER, WEREZEMNKRRA,

o AMEREMERHKIES
BEXELZER BERAMEIE,
o RATRMEGHINE KA R 2 E 88 E 51
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EXELZER, BERAMEE,
o &5

BXEZER FEREHRI,
o WRAE eI BIRE

EXELER FSATEHE.

R TR

FER RS AR EEFHENRPRREENAR, E-HE2RENEFER, FTHMEETEIXRIN
BEHRKIE,

o HEHEFUET, RAUTARXZ—RREE:
o ETFHIRRAETE (hFF2 N EHE)
o ETSERMMNE (M2 HNESR)
o FEAZIM5IARMEFRIE RIFEERMGER, A EMNSBEE RNENREZMRABZX
B A EN R Nl B,
o HEEHAEP, BIERBEMHERSINAERATI—MER:
s BNEH—PLERER, X+2ERTHERE,
o HRARBDERBEENLR, BEMERHE—THEERT SKMUBBEELTEREMN. ERE
TTHR&ERRT

5.40

5.40 100%

ofl Duration
»/ Cumulative Percent

370 68.4%
€
@
L
&
g
- =
S 199 368% =
o E
3 3
. .
0.00 0%
Pump Failure Power Unavailable Corrosion Rods Parted  Wax Deposition
5.40 210 1.40 070 0.60

Downtime Cause
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o HIRRIETREHERAMNESFHIRY XN TERERRSTRER,
x\

(AN

200

Temperature

100 \
50 ﬁ
D\_
0
5 10 15 Minutes 25 30 35 40
Duration

HEEMNRERAR

1L EEHOAE TEYS, 2REERHNAE, ARETERUE. AFEGT TS LUTHERAE"RT
18

IR MRELL T BB TE, BRET—F,
2. BomBEEXFERREMNREAR:
o (NEHHAER ENEHABEENRARREERA, CEEFNETEHESRRE 1T, HAL
BIAE RS RAI AR REEPE R, REGERSEHAEN T ERCEERT,
JLEE

Edit Value Mode

* Summarized Values

Sampled Values

Save Changes

JLEERIRTE Pl System Explorer FEFIMEHIERE, BABERT, XREHIELRKREM PIFRIER
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=
AR BHIEZRERTE Pl System Explorer LB MR 5 TEEER . S0 T AFRAI“PI FRic mEIES
Z W EEDMIRBRBESEESHATEREEENRRZ AR,

Pl Point Data Reference “
Data server: css-bi_pisys W
'ZEZ' Tag name: |E=255_TE|"'"|F' | y
() Atiribute: v

Lnit of Measure

Source Units: =Mone > W

Value retrieval methods

By Time: Automatic W
Relative time:

By Time Range: End Time W
Calculation basis: Time Weighted
Min percent good: 20

Read only

Pl Integrator for Business Analytics A X HFfHENBMERRAEREN T XF. AXEZER B
2[R OSlsoft £N1REE X E Integrator Event Frames summary calculation values are blank (Integrator Z=44
EZRLCETEERE),

o BEAEMRAT E R E R, XBET LU E R [ B R TEE, flineE 15 28—,
¥ NI
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Edit Value Mode X

Summarized Values

* Sampled Values

® Sample values every | 1= || minutes =
® |nterpolate @
Exact @

Use Key Column|cdi158

Save Changes

B A AN ME ) B I 1R & A I [ B -

o FEEDEEFAARBIETENNEERERREE RIBEEHTEE.

o FEHAREIEEEEERREE(NREFE) . MBERHEE, MIREIZEE,
. FAXBIFEAETBHERALHIENFBEAR.

FERAXE5

Edit Value Mode x

Summarized Values

® Sampled Values

Sample values every | 1+ || minutes =

® Use Key Column | cdt158 +
® |nterpolate @
Exact @

Save Changes

EE-TEN REEERTINETZ—:
o FEFEHRXEIMERLICRKANTEZ, Ei5IMERRAL X 8588 A28 B i e iE 2

HATHRE.
o RHFEHXEIIMNERELICRAMRIE, INRE 457X 10K 2 EARFEZE B
R EIZEE,
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3. BEHREES,

anfT it B SR

AERAE TES, FTUNAEPHERKFIRN—NES L EEENS, TERETUBENITE
FHEERG:

o Rit-—EmEERARMEEMELT

o TE - —ERRRIARAAEEMESE

o &/IME - —EXBTRIAIFRN S /ME

o RKE-—ENRARBRERMRKE

o SEE - — Bt R FE P A ER K 1B R 2 1% B[R] 1B R P A B /ME

BeF 1] 1) o8 5 400 R0 T ) B R A O

o FrUARTIE 2 E—1TRIR A
o S5IRATIE R LRTITHIR BB

UTHESERMETEEATREZESITESHMEZBMXR, AFld, #H0T FE5 Volume 1 - Minimum
#0 Volume 1 - Average, iIXF 5|19 & F Volume 1 51|, ZRT{THIET B ZEHR1CHT B (B PRAI 45 3R . £ — 1T e B 2
FRic A (8] (Bl R B FF 35 . Volume 1 - Minimum ZREUX # 4 Bt (8] 2 [E] BORT B #UEE, ERm/NMEFEFT LF11T
(ENZE 3R A8 1T) #4 Volume 1 - Minimum 31|, S5 {Blith, © @33 B IF 35 B (8] 5 45 3R AT (8] 22 [8] B9 Volume 1 {E#IF
{EE 1t & Volume 1 - Average §|B91E, F1EFE LRT1THI Volume 1 - Average 5,

— Asset View 1

Select Data > Modify View > Publish

? Edit Row Filters

0 Row Filters

3= Edit Value Mode
Interpolated Values
Every 1 minute

o Add Column

& columns

TimeStamp Volume1 Volume - Minimum Volume - Average

2072017 6:12:04.514 AM
2/10/2017 6:14:04.514 AM
210/2017 6:15:04.514 AM

45.5642967224121
45.1628189086914
44.7613410949707

2M10/2017 6:16:04.514 AM @ 44 35986328125
2M0/2017 6:17:04.514 AM @J 43.9583892822266

2072017 6:18:04.514 AM
2M0/2017 6:19:04.514 AM
2M10/2017 6:20:04.514 AM

43.5569114685059
43.1554336547852
42 7539596557617

45.5642949855283
45.1628183669969

44 7613417484654

44 359865129934
43.9583885114025 @
43.556911892871
43.1554352743396

42 7539586558081
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45.7650332947941
45.3635566762626
44.9620800577311
44 5606034391897
44.1591268206682
43.7576502021368
43.3561735836053
42.9546969650738

Q «—6
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#r ik

1 et i1 [ R A4 FF 5 Bt [

2 BT 0 [B) B A 45 SR Y )

3 Fr i B 8 5 45 SR BT 180 2z [ A i 10 ) s PR ) e /I MEL
4 Fr o B ) 5 45 SR BT 1) 2z [0 e Y 1D ) B PR ) S 4 4B
5 HET

BRINEFIUCEBIRENNER, BSRAMNEIES,

NINEES|
Al LURINT B M1 B RIEES
1. g"iﬂzﬂq?m"ﬁiﬁtlﬂ, EREEHNNE AEEGEIUE, ARREET T —SLITH BRI
AR NMRELATEHUR TE, ERET—F,

2. BEFHEmA,
3. BEHBIENGETRFERENBIERHEL.

Add Column

ata Column Time Column

Select Column Data Source

4 [ Floo®
© Column Name
A Any
|Unic:|L.eC0|umr*N.:'|r‘1e |
4 @ vav

Use Default Name

& Terminal Load

& Cold Deck Damper Position Column Data Content @
Health Status |Va|ue v |
& Hot Deck Damper Pasition
Data Type
Latitude
»  [Double v |
F=1 1 mnratinm

Add Column

4, mﬁ%glj_ﬁ\uﬁ_%iﬂ‘o
5. EIHIERBRFER NEMRETHE (WEHE),
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7EE : Last Recorded ValueZhBE i F A MR IGEERIEIRE, BIAN{E RN FHE XHIKSEH ., Last Recorded
Value[Fl BT [E1 AT [E], sREDKASE M &REERE,

6. (FIE) ERIFERBFRPERBIERE,
7. B&HFmMA,

A Inet | 51

{36 FA Bt i) 5 =T 7E 4L B o B AR B AR B [ELME 2

IR BECRUBASUREREHIAE RELSRSFER. WETRE, PROIHERFHRMHER
A,

1L EENAE TEYS, SREERNAE, RAEETEHIE. AREG TS LUTH ERAE"RT
[

FE: MRELLT BRI TE BRET—5.
2. BEFHEmMA,
3. (AFUE) £ ENEIERF,
E AR R ZIE RS, LA E A KR RAT B2,

Add Column

Data Column Time Column

Select Time Column Options for

ocal
LGMT |

Year (2016

Month

Maonth Name
Week of the Year
Day

TimeStamp

+ 1

Day of the Week
Hour

Minute

Second
Milliseconds

UTC Seconds

UTC Milliseconds (14
Ticks

Time Zone Offset

Display 1time column

a. MGEFREE 5IIET - 51| 3k Ao ik 5 A i ) 2 B AR MRBUA AR AE BT [B] (GMT),
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a0, INRER/DMEF GMT, o SEMEFRM—51, KL GMT B ELE R Pl ARIE RIS,
b. FEZEFIEREE R LA FHETRATL,
c. ERZEERGEREBEIRE,
4. (BHUE) R2EHRBIFLED+,
BRI FNED : JIRFHIAATESHRE S E RGN EEXMNTRHE SIESHEEMIT IR E
ML AT E , BB LLR FETT Pl Integrator Framework ARSS B TT B AL A A th B 8] 2 48 MR B A PR AL A )

(GMT) E & Rt At
Add Column

Data Column

8

Time Column

Select Time Column Options for| Local v
Year il(_ior\jil rStamp
Month tStamp
Event Frame Local Start Time A
Month Name tStamp

Week of the Year
Day

Day of the Week
Hour

Minute

Second
Milliseconds
UTC Seconds

UTC Milliseconds

Ticks

Time Zone Offset

Event Frame Local End Time
Event Frame GMT Start Time

Event Frame GMT End Time

Event Frame Duration

Event Frame Relative Time

2. MEERREEBIAT : 5l Frhik S Ea N E b LR 0EIR.
TR T AR E b L RMR R,

Display 4 time columns

Bl 3R 1T

EE:pul

Local

S FSRAFERT, Jy s iE) p SR e R B, 5 AL

EERT, A E N B R LR A4S R A i,

GMT

{FERARMER, 7 GMT B E A BRI 2, &8
SCEERT, AT BN BHIEZR GMT LRATiE,

FHEZR K IFIRETE

VIR B (8] £ R B E SR AT IR B E .
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HI| FRIET it

EHERER LR E VLA B (B B R AR SR RO S5 SR AT IHD
EHHEZE GMT FFi5 A (8] LL GMT B (8] R S IE SR I FF IR (8],
BEHIES GMT LRET A LL GMT B i) (B 7R 5 44 HE 2R B9 45 SR B ]

B ER R E EHERLERIE -CAE) BHERFBE,
FEHEZREX AR 1T8iE - OB =) FHER FFIRRTE

FEEFIEFRR ARG FETRARK,

a0, INRIERFHERARMIFIRN BT/, BLFRN—5], ARAXRMNEEXEREHIERF
SR B B A /N AT

TR 2 EEE T ERAESIEE,

EEI L Ean RS, XA P HERETTE (WFHE)  BEBiRRE BREE R MRMBIRS,

1.

B HZHILHTH I AERER,

Pl Integrator Framework R B AR 5 K/NERIFEFFE ID. PlintTSTicks ¥ PlintShapeld YE R 5L F5, 8] LUE
RAXLFHFENRFNEHAEFMIGSE, (B, MREXLM, BRBESR/IHAFRRESMMN—
TR (), BN ip_ B8 1d_,

IR MRS SER T LLT B#5: Amazon Kinesis ##Ei . Amazon S3. Apache Kafka. Azure B0,
Azure loT Bl Google Cloud Storage. Google Pub/Sub. Hadoop %3 %1 =X 344 7 R0 ST X

S ZFMBIEEN BERFHRNRHIZEFIRER K, B0, Oracle FIBAFFRIERN 30 NF4F, KEBHT 30
N F RGBS HEER

Oracle HIEFEEREARENFTHH  MBXEFHFREHNEINLIAF, WEEFFEMEEMM—
TR ()

5| BRI ME—

IR B FEF #Last Recorded ValueTNEEE AT A NG EREIE, i, BN FHXHRSEMSE.
Last Recorded Value 5 [B1 38 [B] 3R B KA B M R T B B,

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 149



'AVEVA\TM Pl Integrator for Business Analytics

BN{al{sE A Pl Integrator for Business Analytics

@ Column Details

MName

Forecasted Chance of Rain |

Reset Name to Default

Data Content 0

VEINE v |

Data Type

Double v |

Remove

Apply Changes

1. NHIRATERER,
2. ERZERTNAER,

R #iE

A LFEARAEFHSHET IR E R AEE, fln, B UXHEE  NMEINBEEEEMEENHESES
EMFHEEALE, BomaaixXesT,

R EES 2T, PlIntegrator for Business Analytics £IRER SR B = 2R BCECRO SRR &£, ISR 5 LAY
RBNBIEESH, ERBRERAITEENHIEFE.

1. ARMAETEH SRZERNAE AREHERAE, AEEET—S U HFERAR THE,
FE: MRELLTERAE TE BRET—5.

2. BEmBITHRFFERFEMTIERFRE,
IR RERANTESFERFIRSNFHETLIRS,
FHERIERREATRSUARE, Bt MRECEZHEFHAR, BL/EFIXNTRHFKE,
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Row Filters x

Add New Row Filter

Include rows based on whether the contents of a column match a

String _
string pattern
Diqit Include rows based on whether the contents of a column contain
- certain digital values
NuUmeric Include rows based on whether the contents of a column contain
certain numeric values
Null Values Include rows where the contents of a column contain a value
L ¥ L
Include rows where certain Event Frames are active
Event Frame '

Close

AXNASBUEETERNEZER, BSRAESHEZETIE,
3. ERIEBNENZE, BRGRFRY,
4, TR EES R T XA,

REHERTR

UTEZBRNE T @ a7~ 0B N A B HERITIIRS.

AR REAEEEMNEERERRFUE,

%iﬂ%ﬁ\ﬁfzﬁéi{ﬁﬁ, MUET —NARHEREHNTERES, BEMILE RS HELE TR,
CIRENLT —NEEWIK, ATUN—AEHIEZEBIRETA LS, Pl Integrator for Business Analytics [ 18

?ELFEEIFA# XFMIEE, MMREEXHERLTEMBIEFE.

BN, RIREA—LEHE ENHE—ETESRE, BIEREHERXERXERBIKENRIE. &
N EHEREBETRNIFRME RN E, EAREMNHE, BRI UMEREHERTIIESS LXaEZH
B BT HRZHEM R~ RE IR,

1. FEHMIMNE THE, EREERMNE, ARETHERRE, ARET TP LITHF1ERUER"TTH,
AR MREBLATEXUR E, BRET—F,
2. {FEFAFFRET RIFNL AT A FER SRR ESERE, FHEaES RSB EERBIC TN E,
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TR MR R RS RN EAEEHERMNEEE 25, B FHRFIERIEHIESE,
3. BiimBITHIERS FEREHERENTREHERE,

Pl Integrator for Business Analytics BRTESF7E PI AF BUEFE R RN B NEHERH RIS RN
?;O

Create New Event Frame Row Filter

Event Frames _ Shape Tree

4 [ Catalytic Cracking
4 @ Boiler-210
& Feed Rate
& Fuel Gas Flow
 Fuel Gas Volume

» " Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» ' Casing Temperature Excursion Roc
» " Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» ¥4 Casing Temperature Excursion Rog

» "4 Casing Temperature Excursion Roc ¥

Event Frame Related Asset Start Time El

4 BEEEE T LHTHESE AEP— P TIRRIPRTERES (>) ITFHFHEXER.
Y

AELRFERP, HESHUBRS/ NEHERMTEMMKIFTENAS, fl, EEHLHFRIPAA
AEEMEXN T BHEEFHRIRPERE — DR,
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Event Frames

ki

Event Name

Event Template

Clear All Filters Apply Filters

5. BHNATIESS.

6. MIXZIMEHERDEIENTBHERD D OER,
HRHFNAE D E LB HERL FERRSHIT,

7. BE, EALT KTERBHERES, GEREEEFHRRIREESMAMASHER, BEEMEX—
TR, FEATHREFERFGENEHRBEINEHERIEZHERS,

Create New Event Frame Row Filter

Event Frames l ? | ‘ Include rows with this Event Frame Active

X

» "8 EventFrameAnalysis 20150612 01:46:32
» "H EventFrameAnalysis 20150612 01:46:32
» "H EventFrameAnalysis 20150612 01:46:32
» H§ EventFrameAnalysis 20150612 01:46:32

w Hd FuantFramafnahcic 2MR0R17 N14AR27

5. mEEpgnzan Y BF.

Pl Integrator for Business Analytics RIRERPLE M EHER HEE O EBHTR ER P ERHEEK,

9. EREHERSEHMETERY, EMERBTEE~REMHERBITIRIBEE D,
X—TRENTEXFAMHHEE (EHERMUEENE~EEMHHIEEL) 2HNX R, XEXRRXXEKH
MFAELY, F—1MR(FEBEE) PHETEHRETE IR (EEES) dMEN B, Xitfid,
BAFRE EHERMEETREBKRRBES,

Pl Integrator RTETN P BH L ERMEHIEEMETHAS,
10. SEROTIEBMEN 2B, BETRESHIERTIIES.
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XFRHARUE

BE 100 M HREZAHAETRHEENRNE R TEEBE| Web Sockets 1& #i MY KBIBRF, ZHMUEH
&% 64K EUR B RK/IEH, EEE A EMARNE 2RI, AlREFEREAREE TR RSB[RLEEG"T
BEENE KMEIEE ., R A A Microsoft Edge web I WA F EEIXHF,

TS T 1 [T ——
X FEEZRZHHIAE

B LRI RELE R F, BREBLURE—M M KR TMANEREEXAENNE, Flin, &a LU
UERENERER 12 REE X,

AR ELEUEIRIETEEIT Pl Integrator Framework RS BT E AL LA AT EE 1T, ALt, &FARRENX
AP ELRERESITRONE REIX — &,

BRETNEN, FHHEEMMINERIEZE. B, SREERGZAEN, BERRAXGEIFLET
K. BRiITHAFAEE, BanREEEHIENIETL, ALt, EHAFHRRABEZTENEHIE.

I F/ EEATHA R ESEE . iR BOHREN 2 /IR, 7T LS E B AE R A E (8 FR 38 N £ RR K
BT

£ Publish (&%) W E ERERIT A HAE, BEXELZER, TSR ARIE,
AHMAER, ERRAHABRERELBTRA,

Pl Integrator for Business Analytics X N A& 80 B AR H 3 B #H K 0B Pl System $iE . HXILTHEEMEZE
B, BSRE AR e =5,

W 2 # A0 B Ar L i

% Pl Integrator for Business Analytics X il B8, ZM B AFMEH AT AEBRFIE RNE T, 1 BARER
FEECHGLATEMMAN, ATRGATEZMNELT, MENELFTTIE B ARTFHFR, PI
Integrator for Business Analytics R IZFARFEBZ RN TILFH (o

BFirEEHZMEEAN , NRLiGE FREBHIX LRSI, N Pl Integrator for Business Analytics & R Z & 5 55
i%;ﬁl%\o

WEBERRE BRI, TRERNSS QB KERS,
Eh—ROHE

BT —ROAEAI LR f, REEAILUEERRERAEN.
EXEHRRAAEMER, BSRZITUARUE, AXAMTRERABMER, FSRAAMREENE,

1. 7E Publish(&#1) W@, MB#rERESIRFPIERE B IR,
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4.
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BHBIT X

(AIi%) 5 A LB & 1 B EAFN e E,

AR THRIPIERE AT Pl Integrator Framework ARSS BT EHL A AR BT BT 1T, a0 R ELF AR AOAT
X, ATEETR BT A T KB (B #5342 59 Pl Integrator Framework RS B R ¥ BEIR1GAT R ML R,
BEHRM,

Bt &l

R LR LA R R LB . 7E Publish (R ) WE, ERILUEEMEMARMINE, BRBITHIINSGRE
SMMBETHERZE AXEZATHAEMNESER, BSRAX TEEZ X MHUE,

1.

ook W

IS B TmE, WA RMESNE L R FF IR T4 /AT E .,

gfé: Pl Integrator for Business Analytics X 7E B R3E 1T B I [5] FF 35 B 8] F0 45 2R 6 (R 45 5 A B+t 18] S BBl ALY
BET—%,

£ Publish (X)) WE, M B#RECE SR BIEFE B Fr.

BEHEBITRET,

BB XEITHY B EAFNATE

AR T XIPEIRIBIT Pl Integrator Framework RS AUt EHLRIAR AT B 3517, S0 R &L F AR AAT
X, ATRETE G A 1T RI BT R F23RA Pl Integrator Framework RS BT ¥ REIRBRTRHIE R,
EEELTITHIME,

FE: BAUBEERE—SH. KK 12 TANEE,

BHRM,

B 740 B A A i

BT R M AEFMEE, Plintegrator for Business Analytics i Fi LA T3 3 H 1 R BRI B BB R SEE -

FFE5 AT IE]
L FE AT E
BT
BHRiEIT

Pl Integrator for Business Analytics {X 7€ B X35 1THT K i Start Time ¥ End Time S #4358 % RO B (B SE B A RO %K
&, S FFLETIT, Plintegrator for Business Analytics i UL F AKX I GEIER EE D

Start Time = £ R&X %7 End Time + Sample Frequency
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e End Time = ECE# End Time, TE551TH¥4h

RFESHNEREEARX, RENBIEAGREEZER. EXEZER AFEATHHTREEXN AR RHTE
RIS B R, B S B How does view scheduling work for Pl Integrator Asset Views? (AI{B] &% Pl Integrator &
FOERMITRITE?)

L g RS

BE 100 M HEZHETRIBE M AN E R AT EEEE] Web Sockets /&R HLFTH K HIRE], ZHILER
&% 64K IBUIRE K/ RS, EERAEMAAE A, FHEAREEAN RSB REEH TRENE
K,

AEHAER TES, BhHA LAMNEEER n FREARETRNBSHREEY

TR RAwBERREERA R 25000 MERMKLED KRR H G, FX bR TRE M, 3
BB BSEXHHEEA—FHRHER,

1. EKfFTE, M BREE"SIFRFIERE R,
2. ({XPR Apache Kafka) & B KX BN E,
HNBERT, HRREESEMNER 2 E-,
R AT ORI E R A BIT A T/,
a. BERMEBOEFREEBMPERHATATIEIR,
b. BEEIXEREBINEK,
3. BEERKAAEMFFIAHE,
4. BHEERM,

BERSIT8E

SIHERETM R ERX TR R MIEMNER XX FAERM Pl System PIRIBIEURFHIESAZIB
A EESMRIFREE T, SIHEREREB LR MASEITHRE XN TR T AR R a M B R
RiREIE A B,

INBEREARNE R EERMSEITER, WA Pl Integrator ATEEE MBATFE#E EAIRY sQL Server FFR T X
Lei R UBSIEEES SR TR, AXAINPRXLIERMBEZER, BSREEICEERE SRR, FH
UTHERAERSGITHER EW R LMER,

1. A RMAETES, ERERXBHAE,
2. MENEFAESERKRITH, BREOTEATANRERETH . AREGSITHERET R,
It ER R B RATIA R B BSITHER.
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Qverview Log Security View Configuration Statistics

Run History Duration (seconds)
“ o
26
1/22/20 7:18 AM 22.327 0 0 0 - Zi
1/22/207:28 AM 2323 0 0 0 fz:
000 18-
1/22/20 7:38 AM 24019 0 0 [ ol
12
1/22/20 7:48 AM 22.291 0 0 [ o
o o]
| Total 96 2,121.159 0 0 0 | 7
4
2
| Download All Reports Enable Full Reporting

T T T T T T T T T T T T T T T n
10PM 11PM Wed 22 01AM DZAM 0DZAM 04AM 05 AM 05AM OTAM 03AM 09AM 10AM 1AM 12PM 01FM

3. ARMEREGTHFER-NRITERUEFEEHKIE,

Qverview Log Security View Configuration Statistics

Run History Duration (seconds)

All Runs
26
1/22/20 7:18 AM 22.327 0 0 0 - 2::
ton, 20+
1/22/207:28 AM 23.23 0 0 0 ol
16
1/22/207:38 AM 24.019 0 0 0 1o
12+
1/22/20 7:48 AM 22.291 0 0 0 o]
> o
| Total 96 2,121.159 0 0 0 | 5
o
2

Download All Reports Enable Full Reporting

T T T T T T T T T T T T T T T n
10PM 11PM Wed 22 01AM DZAM 0DZAM 04AM 05 AM 05AM OTAM 03AM 09AM 10AM 1AM 12PM 01FM

4. BHRHH—T, AENERPERMESITHEMSEITER.
5. BRHERAAEETUREEEAENE,

Querview Log Security View Configuration Statistics
Run History Duration (seconds)
m  —
20+
1/22/20 7:18 AM 22.327 0 0 0 -
1/22/207:28 AM 23.23 0 0 0 15
1/22/207:38 AM 24.019 0 0 0
10
1/22/20 7:48 AM 22.291 0 0 [:}
| Total 96 2,121.159 0 0 0 1
| View Logs for Run Download Selected Report Enable Full Reporting o

T T
Reading from PI Fittering & Calculating Wiriting to MSSQL

6. EFEHBREM— NI HITRK,
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Duration (seconds)
All Runs

26- [23.7 01/22/20 05:48:47 AM|

24 g P -l S R——
22

ur

T T T T T T T T T T T T T T T 1
10PM 11PM 'Wad 22 01 AM C2A4M 03AM 048N 05 AM O5HAM OF AM OB AN CBAM 10AM 118M 12PM 01PM

P i BRI K LUEFE B8 X o

Duration (seconds)

All Runs
26 -
24 Q
2z
20
18
16
14
12
10
2
5_
4
5
o

T T T T T T
05 AM 08:15 0630 0G:45 07 AM o718 o730 07:45 08 AM

7. BEBMKREHRITED,
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Duration (seconds)
All Runs

26
22
20+
12
15
14
12
10

E_

5

4

£

|:.

06 AM 06:15 08:30 06:45 07 AM o718 07:30 07-45 08 AM
8. BHBEMEPH—ITRUEBFBZSITHRAER.

Duration (seconds)

All Runs

26—
24
el
204
12
15
14
12
10

o

5

4

122.2 01/22/20 063847 AM

T T T T |
08:15 08:30 0G:45 07 AM 0715 0730 0745 05 AM 08:15 08:30

9. RHEFIZITAE EFZTTHMHZEIER,
Pl Integrator & {HEEEFTEETHI A EET K,

i

BRZERE

TR BAXFARAGTRAERATERES RKE ZHURITER, BBERRAUEATEERNEZ, BR3E
EBEARZFAANES EUWEREITHIILDIGE. EATEREE, B8° AEEZ R TR HEEER,
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MAEBTIMERE R R RE,

HIEMEMSITERET R, AFEhERATERER.

EFHZABET—REITRIT RS,

AESIHERRT R, RIEEEATERERKEMEITRH,

BHBEITRA, RRERTREERSE, MEXFIHRBEAZLSE —TFBERE, RREZGTE
BIEAREA T EBRE,

6. RLERTERGHED.

B & R Rz a0 el BB 2

Pl Integrator Sync N &= E ., 1T XI#54% 9 BB E LR A TAE B B Pl System B, ER
T TFHA K ERAOBIERER:

i koW

e Plintegrator Sync R G ZEIRMA BB F RS M B P L E DR PIAF 1L, Fltn, BREF—1TR
UEFBFE 10 NEEI, —PNHRAME PIAF, SEEMUBRIRESR 11 1B, Pl Integrator
Sync MATAF 11 MEEIMNHE, N FRFAEMITHOREANE, BFEEHROEIE.

e PlIntegrator Sync & ¥4 Data Archive F R L F B HERI R MAILUE, A0, 2 Data Archive RS
BB EEH NIFER, Plintegrator Sync RIFEHE X M EI BFR,

FE-ETHRIFRXEMRERABNENL, BSHX T HEMES,

Pl Integrator Sync RS E L FMEIEMEIE, FHE 30 nHEH—REAREMOEEE, Bk, 7£ PIAF B
Data Archive X £ B G, LtERAIEEE Ex % 30 2 AU B F BE7E IR AOEUIE b I B HE 3R, In REUERK
Pl Data Archive BUBS[B) KB, 3FE Pl Integrator for Business Analytics B2 & i T iX MR EI X ROz B (Bl SE E
NEIEIE, NRIANBFERFAEERERTEHIEF. A THRATERIE BEUENERNESH
q’?ﬂﬁﬁi&(ﬂﬂﬂ, *-1h) B E £ HIE 5K Pl Data Archive [E FaIEHIEHIE, MFFHMER, BSHEFIEH
iR

ZEF|F Pl Integrator Sync [E25 ThEE, & %1{% A Data Archive 2017 L E S iR A

TRETTENBFRMXFHRIDRE,

xR B #5 %5 PIAF Fl% X ##5 Data Archive Al

XRBUEE Azure SQL #iEFE

Microsoft SQL Server

Oracle ${#EFE

SAP HANA

AN NEN
ANANENE N
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i) B#r 5 pIAF ES % # 5 Data Archive Al
MIEOE Amazon Redshift
Apache Hive

Azure TFH saQL it

Google Big Query

ANANANENR

T XA

*

Data Lake Amazon S3

*

Azure Data Lake Storage
Gen 2

AN

Google Cloud Storage

*

Hadoop HDFS

*

HEHID Amazon Kinesis #(3E 7%

*
*

Apache Kafka

*
*

Azure B

Azure loT H»

*
*

Google Cloud Pub/Sub

ANENENENANENENENENENANANENAN

ANANENE NEN

JEE X F Data Lake #1344 B #7, Pl Integrator Sync RIS E =M B MAZIRE L, FEAAFRFELEIEIE.
{BE 2 AT LLE K Pl Data Archive, B, Pl Integrator Sync A& [EEX L BFrMISIES EH XA HIEME
1. B4V E R = Azure Data Lake Storage Gen 2, EX A=W AR FIEIEE R,

AR RERBESURENIT MR ERMRS X REMAMREAARTIERT,
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B X meEEE M5 Pl AF G5

TENMETERMHEIRENAIS PIAF RREMMNERRS

o JTERIANIE PIAF
AR IBHAIRTE PI System Explorer / AF Server TR A BERE XA, AEEAELIXLEEHR N B
HE, t/ZR ERERRKAREM TR (BEESHTEIUSHERIKBLE) AL 83K MmENE
WA, ks, NRUNERKREERENEEEPFIEADLEMENE, BLERRTHRN, XEBEHED
MEZTRLEFE, UEZTHRINENOESERILGAMEINEAE G,
o BWEMEMITIMREHAE - NEEPAFPHANENTREATRERHENAES, SBENUR
hEEHEN, BoHTRNBIESMEIAS, SIEEES| R E F 1583 E,
o RBEMEMBEHMAE-NERPIAFPANMENTRATRSEHENES, SHEMNERESH
PLERTR, MR AR TROEIE. TRIBLRIR AR,
o MPIAF FiBRITSER — ANRM PIAF ififR TR, SBURGTHLEIHERETL, WFAKXAFEA
ZITRNEE. BRB LR AR,
e PIAFFMTHRBEEGL - MR PIAFFHNTZRHEGSL, WiZxRENEFLSEIETR. HEMET
ERBIRMIEIED, BERIRTHEERBEERETERA .

3EE :Pl Integrator Sync AR IRERI A TR AF BAPRIZIR B, 410, IR AF RENRFME|HR
LAIRETNTR WZTRMBESEAIEEI LS, WA SEREREH, MEMENTHR
PR AF AR, ENER RS, BERMMIFEES FRIZTHREIE. I T REBIMEB TR LM AF
BARIRANREN, SEEHAHTSI AZTHZHNIE, XBELNEFCUNBZTRAE, HX P
Integrator Sync {£ A AF FAPRIRMIEFME R, BSHEUELZ 24,

THHXSMAENA T WG E R M EE S5 X FHE1EA) Data Archive iER S

o BR=ULE - & Pl Data Archive BB X £ LAY, BIREIES B3I EH, Pl Integrator Sync KB E B R
IR,

o HHIMFARMUE - NREIEERETE, NFESEZME B BERASBMBREFAMNE, TERE
ML B T m H A9 B 15 20 Rk T o BB IS Atk Dhde,

o BEMAMBEAZAUE -NTREMAMRERIE, A XFHUEEH.

o EHNE-FHUEASENHIEEREUENMTFEUE, Aol LUEREHRHNIFEIEE GRH) Fah A fmitt
KHURE, CEFHHIEEFHPIE MR ESEE SRS RN EAEZCE NN E S HIESE,

FHEH

TR REY Pl Data Archive hRZA804A], EBa] LAF ) B HHIE,

B2, R %&FEARE Pl Data Archive 2016 R2 B R ARA, Pl Integrator for Business Analytics A~ B 3
BHHE, Bk, FHEHFERALUEREFHAIHIE M — ] AREDL,
ERENZFVEGRFIEFHFR~UE. SHEAEMITRIMFRE RN E P rIEIE. TREEHNEHA— R
FHERAENXH HOFS BRI E R METEEHEEMRLMRERUNE,
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REYFEE LEREGMINENRRFEFRERZERE TR, FEEFHEHRE. EITRRHZATREN
FAIHEZLBLERARFESAZIRETFERE,

THRARES BHE R ET M —EiE)

s AAMUBNBEEFEEOTA,

o MBS EHITEHIE. PI AF Analytics tag £ K £ X Fh{F 5,

o REAEBEFIHMAKE.

FREHHE

1. M ERAETEERE - NETEURS N EER T RMRHIE,
2. BEHEMAE TEA T AMER ST EAERER,

L OSNasato £F

+ Create Asset View

+ Create Event View

& Modify View

¥ remove View

E,Ectalr;‘aa_:e w starting with your B_I |§:s data view starting with time Modify existing data view Remove selected view
& Name Run Status Type Run Mode Start Time

Pump A19375X1 Not Yet Published Asset Continuous *8h

‘Pump C97534X2 Not Yet Published Asset ‘Once *-8h

‘Pump G27834V3 Not Yet Published Asset ‘Once *-8 hours

‘Pump B90853V1 Not Yet Published Asset ‘Once *-8h

-Pump G78359X2 Not Yet Published Asset ‘Once *-8h

-Pump U57328X2 Not Yet Published Event ‘Once

-Pump X75132X3 Not Yet Published Asset ‘Once *-8h

——*
—ml
3. BEghRIET+,
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My Views

+ Create Asset View
Build a data view startin

ing with yoL

+ Create Event View
Build 2 data view starting with tim

ild

& Modify View
Mod: fy existing d

X Remove View
Remove selected vie

1 OSNasato £

i a Name Run Status Type Run Mode Start Time EI v=
Pump A19375X1 Scheduled Asset Continuous *-8h
‘Pump C97534X2 Not Yet Published ‘Asset ‘Once ~8h
\Pump G27834V3 Not Yet Published Assel ‘Once 1“8 hours
-Pump B90853V1 Not Yet Published Asset ‘Once 8h
‘Pump G78359X2 Not Yet Published Asset ‘Once -8h
{Pump U57328X2 Not Yet Published {Event ‘Once
{Pump X75132X3 Not Yet Published Asset ‘Once ~8h
i 13
| —ml
Qverview Log Security
Run Status Scheduled Publish Actions Search Shape
View Name Pump A19375X1 Asset Shape
Pl AF Database Datacenter Demo 4 @ Atanta
. 4 [ colol
Publish Target SQL Server ..
View Type Asset colohumbe
) & Zonel Capacity
Run Mode Continuous
& Zonel CapacityPercent
Last Run Time Never

o HRMBEERPELTEHRE.

L 7 i

FE MR EHREREEER EREALAEFRXBHFIER. EXPLARTUEFRNER, &
SRE X MEBIRINEIEL,

4. {EEEEFIBIEANEE,

TR EREEHNERLTIEMEREE.

5. BEHHIA,

3EE Pl Integrator By ol BRZ AT BISEE RIE BRI A IR, AR XMEHHIE.

e

EMEEESR, RESERXFINAMLEIARTENRTR.

o ERHEHFRMAMAMWATREHNEG, FRRIAEGRIE. TRE AR MR, ERHE™
HFEHARFERATERR AT IR EERN EFiaetE. KA ETFXGHRMEFHABEEZEHR RS
B, SRRAFHERTREX G, S TFEFRURMER, ENAAREXEZFUAHNERK, EE
—HMELT, BFREEMRAIEE. BRWEFREHABERERR AT REA LI

saEt I,

o FEHMFTRRE BRI R - REMERHKE. CRFERTHX REABNESENEREN
HIERHEAER KBIERT, GRURSNMRIAAHNEF#KTE AEBRAEHNAE,
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FE, AIUARMBEEIAFFEZEX, LAESEANHAE,

1. MBEMAETES, ZREEHHAE, REEHERAE.

2. FEELAEXEER, HITUTERE:
- RRBEAHE-FEORELAE,
s ERBUAEAIA - FEARRBLABEMEIER NAERA-—TH—HNE2T REEEHEEAE,
AR EFE REERIE WE S, BRSNS BIERIRETER., ERABMRAHIE.
EXMAEBAEMNESER BSACERESIE, tlZE=HUEReZiREamiE,

FEMEFETNARFEAZTEMRE, Bl & RN E G E ARSI § HER T 20
HIRF 8 AF SAPRIREL R EE, MARES LERRGABMAFHEXERN AF SRR AXESE
B, BBRUEZ S

R RS
BN R AN E TE LS R UL 3 SIS, TR BN EMEIA,

EXGEZRIMS

ERTLAME B T EmEan 2 A,

1 EEMOE TE fTREA FTANEP - IEBLUTFERERER.
ERFTH, ERikdh T HRIET R,

) BEMBELHEbg 7 .

7¥E: Amazon Kinesis 2/ . Amazon S3. Apache Kafka. Azure A0y, Azure loT By, Azure Data
Lake Storage Gen 1., Google BigQuery. Google Cloud Pub/Sub. Google Cloud Storage. Hadoop %3 %7 =X XX {4

REMXAX 4 ERFXENAEER S,
3. WEAREMIETERS.

R AE

X FERERAEENRBUE, ErRILEG AN XERERTR, EXELER, BSHAUE T RNE

11

1. iﬁ?%‘*&iﬁ‘E, REBRTEHUAE,

2. HHEAUE TIES, MIRPERE—ITTE,
ZUEHFAERRERERAEREOFHIERTA,

3. Bk security I,
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+ Create Asset View + Create Event View + Create Streaming View H [# wodif
Iy

Name Run Status Start Time Run Mode Creatiod
Bailer Wiew Fublished “-Bh Once Q822 §
Compressor View Pubdished *.8h Once QIR T
Pump View Fublished “8h Once 0112122
Owerview Log Security View Configuration Statistics
Identities
View Access @ Data Access @

Lr Integrator Sarvice B

AL Administrators L World
& ergnees )

(+} Add (= Remove

AR BEBRSMINARENAEFELR S REF SN AT HRIREEN AF FHRR, 255
PRAREFEZRER E R,

4. LB AR TR ATS BN T L FIRAE,
. BHRMERER
. EMB SRR TN BAUR
. BRNE AR
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LH K Pl Integrator for Business Analytics IR M4, E=ZNENAEAZTEER:

o NARFREM - F LR Pl Integrator for Business Analytics IR T £ M EMCE, HIaNE X4 RS
(DoS) KT BIBHENHE 1E o

o HIEZREM — HAEWLLERFHIZT PIAF PEGEMNF RN B U INAEEZLZ M,
AR EEERMTEEEMNERGHIENZ2H., EXGHIENZTEMAE XM BN TAENE
B, AxEEBRBIENHRINRMEZESR, iS5 secure views for an identity,

o AFHEZREM — T XBLE R F A LLIGIA Pl Integrator for Business Analytics Web B A2 FF . H iR #X
BRI (BER) LRI EFHLER R, LLEE Pl Integrator for Business Analytics FA S (UI) 15 R F0ES
B ENEFAME R,

NAREFREHE

El5E1E4E RS K ik (DoS) HIBhTEIE e

AT EmARIEEIRS Pl Integrator for Business Analytics IR £, BWERNBKMARE P RE PI
Integrator, LAMEZE|ME L EHETERIERT

MERFZEZEAET Internet BIBFR(INEFE), WAIHF Pl Integrator BRE @ HTTP REBAAEIXLE
. BXEZER, BSH: IN{a[iE#E Pl Integrator LLEE HTTP (L & /1 B iR,

HiEzEH

Pl Integrator for Business Analytics PI AF F P S F #4 PI AF $03E 177 [R] X BR LL & Pl Integrator AR S5 BT LL& % B
LE MR EUR F4RA4 Pl Integrator for Business Analytics FIREIIZE . IR [FE R ol LLE T Active
Directory Tk F° 8 AF ZZ 2 X FE M Pl Integrator FAF° RE 519 PI AF &R,

RANERT, MAEFEMRELTXANRS:

e BEMEN, BEFIHITEN LR @ PIAF Pl Integrator Framework iRS [\ PI AF & Hi5R, AP 4
A BI%F Pl Integrator for Business Analytics AR S5 ik /= #4 PI AF 0 Pl Data Archive B[R,

* PlIntegrator Sync RS HIFT A Tt X K A E FHEE IR F Pl Integrator for Business Analytics AR S5 1k = #4
R,

o IEPIEX RS, Plintegrator 8 Pl Integrator ARSS K 7 AF R MR A ] PI AF &,
NMARFELRESMHRELTHFERA:

e BEEXMIMMERT, FAF @ Pl Integrator Framework ARZ5[A] Pl AF Server 1§ 3R E4E ., Pl Integrator
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Framework fRZ5{X M1 7E PI AF Server 1 #1% F 1R BN SR 15 R X R A=K A F R B EUE

o FEELE, HEALYIESSHLBRIEMNEZHAFHN AF ZE2HENR, UIIRELEX 5B e EH
LETES SRR EFZAF I AF ZEENBETS B PI AF &R, Pl Integrator Sync IRFZBIFT A TR A
MEHEAERZTUINES SRR EFZAF MR,

o M Pl Integrator for Business Analytics 2020 R2 SP2 FFi&, {HEHEN B BE R Z MG EINE G2 E
B AF BIAFRRSIR KB ENREEREEL M T LR AHIETE. B4, AP X RE AR PIAF
Server B AF XY (805t . BIHEFIER) M5 R R AF REMNRRTE, ZIXFR A Active Directory A
Pk RS E AP ISR AF BIMRIRE N . RAUERE, M EI XA ZUENAF N AF BARRE
EA B B E — R

TEEEEHR

o 1% Plintegrator ARS5 1K /= B PI AF B ERBRTE A a1 REB ER TR MM X e BB HRIEFRFHRIE
R EXESER, BSRLEZFEHES,

3 Pl Integrator AR5 1K F= A4 PI Data Archive PR PR X 29 7E Pl Integrator for Business Analytics 1 & fi #{{&
FTEMRENR, EXEZER, BSATEZENES,

FA P 173 8] £ R

L AP ERET R AF BRI I “PI Integrator for Business Analytics B2 A7 R E L&, %A EIEA
8] Pl Integrator for Business Analytics Fi S (U1), & ¥ S TR F A 58075 R BR & : Pl Integrator & I
BLF0 Pl Integrator AP,

o EEA-MHIEDTEIERA"SIRIEN AF BAFRIRA A A LLET Pl Integrator for Business
Analytics P RENITATA EEEREE, MAMBEHAE S G IR, WEMRKAERF, URNHEMAF
RIFNEENR, tMIERTLIEENEXRENE, MER AF SRR IREEERTERESMEEN
R
AP - RMSRESR T EER” §EIEN AF BRRRNAPFIEGR“EE TTHE, @i Web REXT
ETUEMFRNERRATFANZAEMAFRSENRENR (REMEE. IRIRRE) . EEANE
fAIAFCIEMNUENEEZELTHRNE, MELCHENERMH 2. EXEZER, BSRUE T FEME
o MUANIFELE Bt iRhRrR, Al LIE“E B TUEMN A7k SR B P i RR,

L& 175 8] IR

RIEUNEE, FRAIEZNEMEF TS R PIAF SRR SEEN R EENE, MRRAIEAEMA
F 9B T 21 EE Plintegrator for Business Analytics 75 [RI X [RAY PI AF B 4R1R, A 1F I LIM“REBRTE
B TR ERPEREPF PSR IREANRBERMAESE . REefERA#IRF Pl Integrator for Business Analytics
A E AR PIAF BMRIR, iNRAIEMEMA P R ERIENNEREE AF BRRIR, ERINERT, &
R TIRRE 572 BS PI AF B3 FRIR:
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o MMRAFNBLGEI— PIAF FAHRIR, MIERA L &54RR,

o MERAFHBHNIZSNHFMNINA, NOREFRVBRFHSHRA. BRINRAFENFERF SHBRIRA
INA BRI, MR E 2R IREFEERRKEMBRE, N5 ERFBINFHEF &3R8 4 it
E"J%_/I\o

BIEMAG, ERILUSE S PIAF SRR BRATZNE, AXFAER, BSHEFIE,
AILLA PIAF B4 FRRIZT M BRI LL TR :

s MAEFRFUAREENEANR, EFSAPRRAERS Bl B ARUR LA K %P X 9 B &7 B AR,
o BEIMERTFUEEERRIRNR,

BREYE B LME L FO1R £ AL

BRERE AT LU A BT R IR B IT R SR
REVE AT LLE HIHLE

SRHR 25 T A M BRI

RINE L EREALE

FE AMFAEE SO IARRR, AILUEEE REN A, R R P ERAEXRER.

EENR

HAPTmE, R UEEMRA R REFMERIE A 1 B Rp 15 RIAR . EATZ Pl Integrator EHE 5

BET
FHEUTRILL NE,
User Access Permissions @ Users ar bG'uJDbo
L Bescripticn i Aministratos
L Woeld World security
ir
& o L et 9
A Opent
L administrtees Adm
T=ES —
Tiption ASminisior secUrt
(5]

TRNMBTEALHITHES . FESFREERTHNESEAXNN, AFHRRERE LB MMIETRE

%o
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wE ZEMES

1 BIE PI AF B 1245717

2 R RFRIR S ECH P A4

3 & TE ik B2 PRIR A] LU R L B A5 & f 301

4 Y8 7E ATk B2 AR IR A A 177 (] B k00 B e L 75 (8] A PR
& 5l

5 7£ Pl Integrator for Business Analytics FA F 5@ H [[]
ik SRR IRIE T EE AR

BEXRNMATERXEESHELER, BSRFNFHFEES AR,

How to secure views

WMRAESEMAFTREAAFAEFRAMNEEANR, IXNSEBEENRFBEME +7EE.

o MERAFHREINIRT A ERIIERFHLIZHE Pl integrator for Business Analytics I R 5 [ AR # AF &
AHRIR, BERBRIRAEIR A RR,

o FENXHNIEEIZT PlIntegrator HIE AR AF FSIRIREF“EER " §IEIE,
ARHIOERF A

o IEAILEHMNE" N EEEX AT EI BB A BN RS AR IR AE A0 E 85 RAR
o HNREZ PlIntegrator for Business Analytics B A, AJ LR G AR IRSIREE N E LM REE R
R :

o NMEBERE—NESMHF AN BN EEHIHENIR, HSHSecure views for an identity,
o NMBEBERNENNEREFHIAD, FSHEEENWERHREIAE,
o NMBBE—RAZNINMBEEREFHIND, BSRESEZ N WEHRNE,

BEXFRER FERAFUE,

TIHEET AF SORRNRIER £

HA N PlIntegrator for Business Analytics FF/2 N AR &Il Z 241X E F B IR AR F AR F Pl Integrator for

Business Analytics 2020 R2 SP2 i}, F ZETIBER T AF B IRNEIRER 2, MR EMBFFRIE (30

Pl AF Server) i FENMEB MM MEF R FE D, 4 iTFEEEETE Pl Integrator for Business Analytics &4
BEFRNNEHARLED, UHTRERXMBRAR, KEBARFZTERITRERF LN ERIDSERED
A EREET AF SR IRMEIE R &,
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AN ER & Pl Integrator for Business Analytics EE £ RIMEFEHIAES, ENUELEENEFALTAF,
g4, T Pl Integrator for Business Analytics AR S5 P 1% IR (80 PI AF) i F IR R R B, XN EEAE
SITRERFZAEDFNNE R, FAFSRNMITEN L2 HESTEMHRRTIRIE, LUERIEUNE
KEFAET AF BARIRMHBEREEE,

BAPRIRTR T B AR 1R Pl Integrator for Business Analytics #l B S {#E FAFTAE T AF S RFRIRAIEIE
TERE,
o AVEVA BUAEETMBEXTETZIE HERMPERRSE MABTUETRERKAETER,
o AR, BEMREHMINB EAFIETE, UKIFRFHSTAREZIBSTHSER, Hiin
SetupPlintegratorSetup_IdentityMigration_Report_Preview 2022-08-02_07-34-44-188.html,
AEMBERXT, FHRATIRIESR:

1. X4&1% E|iZ T B InstancePath 1§ E M B R B THENIT XML 15,
2. {&TQ PI_INTEGRATOR VIEW JT&#EHR,

EHIEIEER] InstancePath MBS M) AF EEEHTEEPHIA R, LARFAREERET AF FOF
R R EEE,

w

NELEITH AR FRRERITE
EITEMRATERIE 2
o WMWAIEEITEMIRRAIR T EMITTEN LR Pl Asset Framework (AF) & F i (23& PI System

Explorer) .

o WAIRTE Pl System Explorer B A EE Pl Integrator for Business Analytics B2 i& B AF iR 25 RN E #NAR S 28
FHMEE ., GESEYT PIAF Server i INEIEEFIFE, ) B, B4 Pl Integrator for Business Analytics 35
BIRFARHRERFENENEAF REHFBEEE 1B, BOTEEBERSTEMIRTIRIAEN
TTE#HL, @ Pl System Explorer IEZE R B MRS 25,

o FE$E%E Plintegrator for Business Analytics EZiE I AF IRF 35 LAIZE R R AF S2FRIRBOBE ST,

e XIF Pl Integrator for Business Analytics X5l F X BRI AR AF IR 2, SBITEHRRTER
TEMAFPSEEAFRFHBLNLEGMIFR. ZEMST. HIEEM AF REXN R EHRIGRXE,
A& World AF B3R IR BB AR BRI 15 RIAXR .

s BITEMMRTIRIEMAFRZEZEERUEXEFHFHE A %PIHOME%\dat X4 RN R, AithE R
RINEEBFRERTE RIR,

BRI I EKERI S PlIntegrator — 23T H,

T ERY zip 334 & HIFIE Pl Integrator for Business Analytics F PP 52 F B — Mg 1T E L,

15 8 Hll8Y zip XHBEREI AR E F,

FATIED 2 —STHMHRIREIRIRE UXEARX ST EOMAER TESEAGSITSHET
BRRiRTBIA,

N
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URBEAXGITHGMATIRIE

UREARNEITERIER, UAZITEGTRNBITER, NMREEE, IUEAGTITSHETEIE,

1.
2.
3.

ERERSHRRIBIEMITENL, ITHAGSRRIFSMIIRBERHREME F,
BERITZIE, EH A IdentityMigrationTool , A% Enter #,
FEUERRE, IEEREIBUE, SEIE PILINTEGRATOR_VIEW #EiRFIM E Tk,
o & (N), BA N BIR Enter BUAETUTENX TE1T; XHEAREXT PI_INTEGRATOR_VIEW #2 4R X £ {a] 1
BraxR#tiTEEd. kEELs D,
o Z(Y), WAYLIREFEEHABTHRIER,

TEH I “Do you want this tool to attempt to take an XML backup of your InstancePath element?” (@B H £
ZIEZRX InstancePath FTTHRINIT XML B2 2 ) 1B7RAY, 15 ERF RN :

o A (N), WA N, BT ERNITEMMEE, ERAFHLEZN, MREEERGFAZIEBRT
NE, BT ETEERE AF BIEEMEICRS, G LEET ESAMES I XN EFNEE LS
FFERTBIERT, M PISystem Explorer FHITEIN R, (BSHE XML S HIEIN),

o Z(Y), WA YZIREnter B, LIFEZTEZHHAIT XML B FHERZ D X RBRINOIERLL,
TEHIL“If a view's AF Identity list (IDList attribute) value is not blank, do you want the tool to overwrite the
existing value ? 7 (AN R B AF FAFRIAFIZE (IDList BH) ETXNE, REFREZIEEEZNEE?)
RRE, EEEFED:

o & (N), BiA N K% Enter 8, LB IDList BHEER N ZHERAE,

o Z(Y) WAYLUEZIE IDLst B,

i A %PIHOME64% \Integrators\BA\CAST.Ul.WindowsService.exe.config & #4 InstancePath &, {540,
\\MyAFServer\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel,

MEFMBAE, ERETBHUE, TICEFEWAIED, % T EERFRAERBIBRAE (IsDeleted
BB R false BIE)

o (A), #IA A ZBIZ Enter BLUTRRAAEME,

e (B), A BLUIEEMEGIEEME, NiZUECIEEMARITIR,

e (C), WA CUBMA“MAME D XHBREF EIH—ABTEHUAE,
TITIER, E£ 813 SetupPlintegratorSetup_ldentityMigration_FailedViews_TimeStamp.txt X {4, &
haERMEMER D,
TEHIL“If any AF identities on the view's source AF server and database cannot be found for the view
creator, do you want the tool to use the service account's AF identities instead if valid?” (A1 R 7E M R AR
AF RS SJ|AMBUEFE P IUNEQRZEN AF SRR, REREZITEFERRSKS M AF AR
(MMBEEFH) ?) 1 RE, IBEEFEANIED:

o B (N), MREHEZIT AT HOIEE T A EIXWEIR AF $EEEF/ RIEETF RN RRY

AF SAPRIRRERIE, M A N B3R Enter .
o ZE(Y), WAY, AXLWEFEHARSIKSTH AF HAFRIR,
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9. AHIRETA, EEREMETH:

& (N), BA N,
£ (v). WA Y LEFZIA,

10. SEITEMRRTER T ER, %/PIHOME%\dat SR G HE LI T XX i

ERwT

SetupPlintegratorSetup_ldentityMigration_FailedViews_.txt: 5% 70 AF S FRREIME 1D 51K,
ZX R AEEE ST ZTEMR A,
SetupPlintegratorSetup_ldentityMigration_Report_.csv:CSV 1 & L R

SetupPlintegratorSetup_ldentityMigration_Report_.html: HTML 8 X AILE R, BI1E Web X B35 &
Z=p

SetupPlintegratorSetup_ldentityMigration_Logs.txt: {1 BT B &,

*SetupPlintegratorSetup_ldentityMigration_InstancePathBackup_.xml: InstancePath B AF STt . B4
FERMZD MR TEEMEER T5B1T, WREFEEEZXH.

TERETEOIRAEIRIE

1. EREREGIRIBRIEMNITEN L, LEBEASMITHAGSRTHSMBIREER XEFFENR
#h B %,
2. EEFZIEMGSITSHEBRIXAK, iEH A : IdentityMigrationTool /?

3. BERITEMPMATRRIE, % A IdentityMigrationTool /I:InstancePath [/D:ServiceAccountSAM] [/M
[/N1] [/O] [/S:SAMDomain /U:UPNDomain] [/V:pathTolnputViewlDsFile],

Hoh:

/l:InstancePath - %PIHOMEG64 \Integrators\BA\CAST.Ul.WindowsService.exe.config 3 {4 Y
InstancePath 1B,

/D:ServiceAccountSAM - (R[1%) IR EE, ZTEFHEKIAN RS Ik UPN 89 AF B2HFR1R, A E
BMRR, BE TEMEEIEN B AR AF 3R E £ B A EREEEE T R X R A AF B3 FR12, 20
BRIETE, ZTEHFBIXLEME, LL SAM X (domain\user) $§7E ServiceAccountSAM,

/M -(F)&) INR55E, % T EISEER PI_INTEGRATOR VIEW TTRIERFN/FZME TR, MBRIETE,
ZIBERAENTMEER TiEiT, FHTEMER,

IN-(R[E) IR 5 /M BARE /M —#2IEE, ZTEFAEEX /instancePath {E R EFI 5 H K
TTERHITXMLES . MERIETE, BIEET /M, ZTERZHRITIZEZD, WREEHRIAZH NS
=ECEMDL, NFLIERD,

JO-(FIIE) INRIETE, ZTEFAENE, METILH IDList BEHEERENE. MEXRIEE, ZIEF
Bkid IDList BHEER N ZERRE,

/S:SAMDomain /U:UPNDomain - (RJ3%&, 3NR$EE T /v, NEEETE) MEHETE, ZTEHFN-EE
EER SAM itk i 515 E 89 SAM ISARICEC RO B, AN R$EE T /U:UPNDomain JEIT, MY 7E 793X L&
TE B2 E 8132 Windows HAFRIRET, iZTE & A UPNDomain EE N AP E K& (UPN) 15 ;
&, MR /U:UPNDomain F~7F7E, iZTE£J5% UPNDomain BIEIRE N % F SAMDomain BB,

/V:PathTolnputViewIDsFile - (R[3%&, BNRIEE T /S, MFEEIETE) MEIETE, ZTESMIBEERI XY
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HREDIRIMAME D, #FERRGEXHFEERE 1D WTE,
4. BITESGMATIRIER, BERSTZIEME—XHRPHILIT XH:
 SetupPlintegratorSetup_ldentityMigration_FailedViews_.txt: =% &0 AF B3R R E 1D 51K,
ZXHAAERESTNZTEMRE A,
 SetupPlintegratorSetup_ldentityMigration_Report_.csv:CSV & B4

 SetupPlintegratorSetup_ldentityMigration_Report_.html: HTML 8 X AULE R, B[1E Web XM 2FhE
&,

 SetupPlintegratorSetup_ldentityMigration_Logs_.txt: M BT B &,

 SetupPlintegratorSetup_ldentityMigration_InstancePathBackup_.xml:InstancePath B AF JT3%. B4
MERHZG MR T EETRER TET, WREFE.

IdentityMigrationTool B9%i A S #R15

LITFRENEBB T RN B RIRT R T EFERBASE, Hod:
e Pl Integrator #l & & 776& 7E LL T Jt & 5 : \\PIAF\Configuration\OSIsoft\P! Integrator for Business
Analytics\Instancel,

e PlIntegrator fRZZF7EARSS M prod\piintegratorservice T551T,
o TNEEIEE R (F1A0 prod\user01) 7 prod, 2RI FH 15X Le 1 & 0 2 & 6918 5 4% (5130

user01@prod.opsmain.com) I prod.opsmain.com,

o HALE ID XL F SUE-ERTE C:\Users\user01\Downloads\IdentityMigrationTool\
SetupPlintegratorSetup_ldentityMigration__FailedViews.txt &1,

ARSI, Tel2FHFEHIE

IdentityMigrationTool.exe /I:"\\PIAF\Configuration\OSlIsoft\PI Integrator for Business Analytics\Instancel"
/D:"prod\piintegratorservice" /M /N

A, ZTERITLUTRE:

o (/M) IBIEEZE(EH PI_INTEGRATOR_VIEW EiRFIM B TH,
o (/N) FEIAFTHEFE B InstancePath 1T XML Z15
o B3I IDList BHEER N EHERAE,

* (/D:ServiceAccountSAM) Xf F & ZI 91 B 01 2 & s T H M ST BN YL BR AF 203E FF B A SR E R
R RAE R B AR, 1Z T B2 N 18 E AR SS 1K 7 B prod\piintegratorservice & {2¥FR1R,

O A ZEEEE., BB U REFRIEER IDList BIEE

IdentityMigrationTool.exe /I:" \\PIAF\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel"
/M /O /S:"prod" /U:"prod.opsmain.com"
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B, ZTERITUTERE:

o (/M) IBIFEEE(E] PI_INTEGRATOR_VIEW #EIRFITM A TE,

iR X35 E M InstancePath #1117 XML 15 o

(/O) BE XA IDList B, BMEZEMER N ZE,

BT AERITE AR B 61 R EF 2B T A ST RN R E AR AF 2017 B £ B A 5 EREUE 17 (8] £X BR B9 faT
AF SAFRIREIMEA,

(/S:SamDomain) B3 ¥ B €132 & FE T8 €1 prod BHEAME, X FHRE GIEEFE T L8 FI3
H, EHBREAELIEENAF XAL TR (UPN) FE& prod.opsmain.com,

el EFizsm AL B 5 RTE

A, ZTEHRITUTIRE:
IdentityMigrationTool.exe /I:"\\PIAF\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel" /M

/V:"C:\Users\user01\Downloads\IdentityMigrationTool\
SetupPlintegratorSetup_ldentityMigration_FailedViews.txt"

o (/M) IRIFFEE(ETR PI_INTEGRATOR_VIEW iR AWM B TR,

o ZIAXIHEER InstancePath 1T XML B 17,

o Bk IDList BHEET N ZHEMAE,

o B EAITTEIREIUE 012 E 2 E A ST BITE WL B B0R AF $04E BE £ B SR ER SR U7 B A R A4 AT
AF B PRIRRIILE

o (/V)BEEATERMANE D FIRFHERAE,

Secure views for an identity
Pl Integrator Framework fRS5 & I8 5 Bl LIM“E 12" TUE A FT A S0 PR o2 B2 90 B B 17 R 4R .

1. iﬁﬁéﬁiﬁE, REBRTEHE,
2. A EE I, FHEAFERTFR,
AP BRI RS ER—R PIAF BAHRIE,
3. EREALERENRMFHIRR, S EUE TR,
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View Permissions
JoyceTest

EventFrameRowiFilter

Pl Integrator for Business Analytics
Pl Integrator Framework &£ 14

]

Test2

Test
Add View Permissions Remove View Permissions

Iﬁeacler l—‘v
nner

ME RS RFE TIEE S PRRHAAELURXLENEH LR EXELZER, BSRUET A

R &5
4. REEREMNAE,
5. MIIRERRAESRIMENR.
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PI Integrator for Business Analytics FAE{K % 4544

Pl Integrator for Business Analytics FLAE{K
R

TERETT Plintegrator for SAP HANA AR 444,
B2 —1 Pl Integrator T{E4 217 55 i Pl Integrator for Business Analytics

[ Represents separate processes

Destination Targets ) =
B Represents required services

Pl Integrator Framework. Pl Integrator T{E£ 27 /2 #0 Pl Integrator Sync #H 22 &G F R — Mt EH L,
£ Pl Integrator for Business Analytics SKfflfx/ D EH — N THELRET S#HE, ATEERENENAH, 22
TR, SRR RAE L FTIT— REGVEL , AT LURINE b TELIET S LURE R it gE, X ] LATE PI
Integrator for Business Analytics IR T FE R SERL . RESTRG, AT LUER Microsoft Windows 122 i i #k &
BRI/ FBRIEF ETURIME 2T &,

BHEE, ST IELET SEA I RAM F1 CPU 3K, aNFE1# 41
;%M Pl Integrator for Business Analytics Web N AR x0T M.

Pl Integrator TAELRIET MR K M EITE B 5, HETERBNERRM AT AT mo B /e, Hla0, BRi%

B BERRAER, BRI

ITHELETR FEMELESEEFE N ITHELET S, LEH, — P ITELET R AME#EE G
Bt, AT Pl Integrator for Business Analytics RESER, HEEERSESCEHR AT SEAMRAETRT
R A X LR,
FEMFULAESBRFBINFABRET R, MR—INTVRELET #ETERSEIEAZT R EM1E
WEHIEAERI/ELIZET &, PlIntegrator Framework REES B ERHRIW ITELEET A, EE/G,

N REEREEENIELETRENMFAET R LEFRFENEELMNAE. B2, HELESEREIE
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SEVREFEIER, MRXS B S EERFE, AIUFHEH SRR,

AL TR T Rt TR

FRELUTHESENAETELET SaiEEE:

o E/NHFEFA Plintegrator TELIET M, MAREEB WV ER RAM 1 CPU KX FFNW TELIET
B XHE, MBR—AMTWAEIAME B— T RSB EEsiED b aEl, FEMBEIEMEEE X
i,

« BEEGMABESINER FHEBLABMEAMIRERTRRAE, LEFEIT T8, 58
RIBEAE SRR S/ PNAE, IRABDHAREE, BERFIMA TR,

 REGHMABEENEEHEN. RATHEMSER PIAF 2R, EFZZREE AL RAIFIK, RAKLEC T
ESEEFMEIMELE. Bt NRFTEE, FEENRM EREE TERITEMERIIK, UREEE
TBEEMNTRFRRTLENTR. (ENRERITIRS ZATHRATLIEE,)

o IFHEHUE, FEMNTRRNEEAA, MEDFEMNERM,

MREERECAERMASZTERSHE BRABEIMN—TITELETR ETHRAGFNEGEX, 5
R RS ER, BRZTA LA R Plintegrator TEERET M. FTATELET AL TRET PI
Integrator for Business Analytics BIEl—& it & H L.

B2 Z 1 Pl Integrator TYELFET7 1Y Pl Integrator for Business Analytics

Cluster Manager

1 Representsseparate processes

Destination Targets ‘ ) .
N Represents required services

EIE Pl Integrator T{ELIETT =

Pl Integrator for Business Analytics IRt — PN EEE B, A LIERAEEEHEMNKESNERIELED
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Pl Integrator for Business Analytics AR {K R &4

e RFAH - THELETRIRFSMELT, AT ELIET S di & Pl Integrator Worker Node 1, BN 42
TAELIET S H— 1 #FEFrR, IR0 Pl Integrator Worker Node 2. Pl Integrator Worker Node 3, LLILE3E
i: 38

AR RE Plintegrator THELRET m RS “E3EEIRE N “FI”, Pl Integrator Framework IRE &
RIESEExERRS At, AR XTEEERS.

o RA-ETRTAMRLEXZMRA T, Plintegrator Framework [RZIFE—DHNER THELED SRS,

o Mol - NEREFARIME—FRIRFF, ATHERIEM TCP ME, THRLETRRSERI—R, HARRFFH
SREZIE,

AT TR EBTHRELEERUTER:

o {EAl ID- 3 ERLA1ZAE LB GUID

o RAAFF-MEHETR

o MRARTS - ERMEAAPRE, HIINEITK]. X5, Rk
o FRTITATE — £ A B a At a2

BRI URITU T EBES:

o BAILMBEFEZELTETEHETR EE T IELETRZAEYIGHMEHRH RIEL,
o BH—AMELRIEHAETE ATUEEXTURNESHE 2FATHEBMETRIMER,
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REBFFH

—
an
uu

REFH

Oracle B#5

Pl Integrator for Business Analytics R B T R X7 K/INEWIFFF £ ID. PlintTSTicks 0 PlintShapelD, SR B E
IS AXERBOFRAEGREL, BLFHEREEMMTRIL (), Hla0/io_sk1d_,
Oracle BiEFEEGRE T —LHMTF , MEXEFHINAMNEMIIR TS, HREFRMMTRIZL (). Fi40,
ACCESS 1538 B ACCESS_., B % Oracle REFHIELIER, FS M Oracle X4,
Oracle BIEFEMBRBF M TATR:

ACCESS

ADD

ALL

ALTER

AND

ANY

AS

ASC

AUDIT

BETWEEN

BY

CHAR

CHECK

CLUSTER

COLUMN

COMMENT

COMPRESS

CONNECT

CREATE

CURRENT

DATE

DECIMAL

DEFAULT

DELETE

DESC

DISTINCT

DROP

ELSE
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EXCLUSIVE
EXISTS

FILE

FLOAT

FOR

FROM
GRANT
GROUP
HAVING
IDENTIFIED
IMMEDIATE
IN
INCREMENT
INDEX
INITIAL
INSERT
INTEGER
INTERSECT
INTO

IS

LEVEL

LIKE

LOCK

LONG
MAXEXTENTS
MINUS
MLSLABEL
MODE
MODIFY
NOAUDIT
NOCOMPRESS
NOT
NOWAIT
NULL
NUMBER
OF

OFFLINE
ON
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ONLINE
OPTION
OR

ORDER
PCTFREE
PRIOR
PRIVILEGES
PUBLIC
RAW
RENAME
RESOURCE
REVOKE
ROW
ROWID
ROWNUM
ROWS
SELECT
SESSION
SET
SHARE
SIZE
SMALLINT
START
SUCCESSFUL
SYNONYM
SYSDATE
TABLE
THEN

TO
TRIGGER
uID
UNION
UNIQUE
UPDATE
USER
VALIDATE
VALUES
VARCHAR
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VARCHAR2
VIEW
WHENEVER
WHERE
WITH
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4

BRI R EAh BT R

BOR TR A E A 3R R

EIRBARER, FEIT LT AR OSIsoft FiRZ 5 B +1 510-297-5828 B I [8] OSIsoft Customer
Portal Contact Us page (OSIsoft 2 7 [ 17 [k _E #9“Bx R F A1 71 ) Contact Us (B R EATD) U H EEHES MY
BRI T BB RIED,

Bx% OSIsoft AR Fht, BIRHMLUTER:

=% AT E R A S
BAEXEHITENTFEEMFAER (CPU RE EERENMRAS)
(] 23 H EL A B

RAWPER B EXH

£ R B ATH X E R REFHFAER

FIBHHE, SERBHIMEX BEXH

ERWHMER osIsoft BEHIA, FIIA OSlsoft FAF#1 X Pl Square, #t RHIR R AT LLFER W, FE#

Z X F Pl System BIM 52, PI Square HAY Pl Developers Club Z2 [B] IR &R, N FIR{EL OSIsoft 7= RIS
MER A EIIEEE,
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RATU A

RAT UL

LRk
Pl Integrator for Business Analytics 2020 R2 SP2 (hfi & 2.7.0.112) 2 — 1 THEEMR K, ERIEA TERREME. T
2B EEREN, TEZRTHE:
o ERVRS K/ XZiF
o BEEHE Ul
o HUhBIRIEE, BIEHS AWS REIERE, UK S RFTHAR Oracle #1#EEFN Oracle #41E 77 B 4H 4
(ODAC) B FT A
LRAFRAT PR, FiRE T 2T A & D FFMERESUH,
BXFREENUENEFEAER, SRBREERMARERA, FSHRFEZRFFHL Pl integrator for
Business Analytics,
o
BT LT ohgEE:
T{Em T
106816 AN EERS KX, @R eHNTER
A
95689 HEHRATEEMEE IS CEMHTAFRRE, 5
Al A%,
104079 FAPI B, HRFERERAE,
108693 & S BLE AWS BFRETRIERE, AWS RIZFIFRIEM
RS im S ASME, FEERFESTIE,
103656 BHREME, IHERIIRAM Oracle $IEREF
Oracle (#2148 4H {4 (ODAC),
53833 U AER A EIE R, EF 2GR,
3]

LEER S5 T A AR AR R AT R -
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KATULER
T M s

107139 NEEXNER, 2R Redshift 1T 1D L E [\,

73695 & & LI R : AdIGen2Writer £ RIS A% 3k IE 7 3 A
X, LIFAREIRTT R,

54501 1E Getlastld R iRPANER AT, IBBEEER, A
EEHERR

113283 1£ NLog H#L4T Async Target Wrapper, I#F BEIL
TR EMEIRMERE,

112268 ZHENRET B TH RS SIHOMINEE,
LABHIE BB & R,

112329 fRRLIT BB £ HOFS REB X HEME, T—H1
BRI R i rl e E Sk 2 BTHERA S5 RO5UE .

117900 fRBIE . EXEH S AME B TR AR &R,

48813 EBERENBERFEERREFXMEMGIRT
“SRAEI AR #EEIR,

108733 2RI R BN T A mE R E R,

48893 EELUTRE: inRFHEAIESKINIHD (3E 443), FEED
HEMBERBRENIRO,

48906 2R LU A& : AFListener EEFEE, BERER
HBRELE & EHE,

48805 1& & £ /5 3% SQL Server EE R E RSB E~RIE

A EE LR TR bug,

48850 HIFLTREREFEES: INE gMsA RStk iR
1M, N AF RSB[R ELMK,

113281 RILFELEEE, HRFEBEDRT TIELE
TRADEHNEHFE.

113475 f2RE § 0 AfListener EERER, BEREH
UREIEEEHEE,

48626 REHEREIRER, EHEEEHTHE XM ED
;258
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RITURER

48731 EEREBERE, LEIEEMREE filterMinimum/
MaximumFrequency i 5%,

48880 fiE R LU B B4 & O SH R R ILBNARE E Azure
B,

95089 & & LLF bug: K ¥ El S3 B Parquet i HH ST BT RE
RA—1T8R.

69017 B IELLTE & : SqlWriter RIREIRE T EHMSRITHE
B, LERENRAERENHE,

107603 1% Pl Integrator for Business Analytics M .NET
Framework 4.6.2 Ft %] 4.8, LI RE ML TR
FFIEBBERANBRELERE,

2 X0 (8] &

AUEZEF MR EENE FEMERER, AXNAEREMRBAIIRMER, FSRAMREXE
16600: ARl EF 5 H A~ MAEXHIRA NS, BHR . EAFEENMIRXE?, FEREHE2- EALERE

Eo

ZEERMESER

HAVRE R ML EH . A EHERMEAXMZTEMEXER, BEEH
HESBITMARERNT 2 RAMNKEN™ EME XML

FrrA T oA = EX.

ook

BRI

B RREK, TMNEDD
TRERTERRULERABRHEE

P E %S cvss EA L & & HiRFE
xi -10 !
=) -8.9 4
=P -6.9 21
& -3.9 5
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RATU A

SERIEAXH

) B A

AVEVA.PlintegratorBA_ADV_1000_2.7.0.112_.exe |2.7.0.112

AVEVA.PlintegratorBA_ADV_5000_2.7.0.112_.exe |2.7.0.112

AVEVA.PlintegratorBA_ADV_20000_2.7.0.112_.ex |2.7.0.112
e

AVEVA.PlintegratorBA_ADV_100000_2.7.0.112_.e |2.7.0.112
xe

AVEVA.PlintegratorBA_STD_1000_2.7.0.112_.exe |2.7.0.112

AVEVA.PlintegratorBA_STD_5000_2.7.0.112_.exe |2.7.0.112

AVEVA.PlintegratorBA_STD_20000_2.7.0.112_.ex |2.7.0.112
e

AVEVA PlintegratorBA STD 100000 2.7.0.112 .e |2.7.0.112
xe
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High Cross

Madingley Road Www.aveva.com
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UK To find your local AVEVA office, visit www.aveva.com/offices

AVEVA believes the information in this publication is correct as of its publication date. As part of continued product development, such information is subject to
change without prior notice and is related to the current software release. AVEVA is not responsible for any inadvertent errors. All product names mentioned are
the trademarks of their respective holders.
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